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General
No part of this document may be reproduced, distributed, performed, displayed, or used to prepare a
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software described in this document is furnished under a license agreement andmay be used only in
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Other trademarks, such asQuickBooks, are not being used as a trademark herein and are the property of the
respective owners.

Legal Counsel
This program, printed documentation, and documents should not be used as a substitute for professional
advice in specific situations. The procedures, images, and examples in this document are for illustrative
purposes only andmay not be applicable in your setting due to differences in preference, settings, and/or
state and local regulations.
The following notice is required by law:
AcuSport products and services are not a substitute for the advice of an Attorney.
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General Operating Procedures
Login, Logout, and Lock Procedures
Login, Logout, and Lock Procedures control access to theData Center application, specific functions, and
workstations.

l Log In to the Data Center Application (see page 16)
l Log In with the Database Connection SettingsWindow (see page 18)
l Lock the Data Center Terminal (see page 19)
l Unlock the Data Center Terminal (see page 20)
l Close the Data Center Application (see page 21)
l Respond to a Close/ContinueWindow (see page 22)
l LogOut of the Data Center Application (see page 23)

Standard Procedures
Standard Procedures are routine actions that are performed and referenced as directed stepswithin larger,
feature-specific procedures.

l Select a Date (see page 24)
l Select a Single Product (see page 27)
l Select One or More Products (see page 28)
l Select or Add a FirearmCustomer (see page 29)
l Select a FirearmVendor (see page 32)
l Select a Transfer Agent (see page 34)
l Select a Firearm from the Firearm InventoryWindow (see page 36)
l Describe a Firearm (see page 37)
l Describe a Serialized Nonfirearm Item (see page 39)
l Sort and Filter Onscreen Data (see page 40)
l Sort and Filter Reporting Screen Data (see page 44)
l Save and Print a Document (see page 48)
l Export a Report to Excel (see page 49)
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Log In to the Data Center Application
1. Locate theAXIS Data Center icon on the desktop.

2. Click theAXIS Data Center icon to display theData Center Initializationwindow.
Note: Some computersmay be configured to require a double-click to open an application.

3. When initialization finishes, the window closes and the system displays theData Center Login
window.

4. Enter the employee number in theEmployee # field.
5. Enter the password in thePassword field.
6. Click the Login button to display theData Center Main Menu screen.
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Log In with the Database Connection Settings
Window
Complete the following procedure to configure the AXIS RMS to communicate with the database server.
Note: This procedure is applicable only for new AXIS RMS installations andmust be completed the first time
any AXIS RMS application is opened.

1. Click the appropriate AXIS application (Register,Data Center, or Form 4473) icon on the desktop to
display theDatabase Connection Settingswindow.
Note: Some computersmay be configured to require a double-click to open an application.

2. Enter the appropriate values in theServer Name,Database Name,User Name, andPassword
fields.

3. Click theSubmit button to encrypt the data and save the connection string in the configuration file.
4. When the application's login window appears, complete the login procedure.
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Lock the Data Center Terminal
This procedure allows a user to lock the present instance of theData Center application until he/she returns
and unlocks it.
Note: A lock does not prevent another employee from opening another instance of theData Center
application.

1. Click theAXIS tab to display theAccess Controlmenu.

2. Click the Lock button to display theData Center Unlockwindow.

3. When ready to return, Unlock the Data Center Terminal (see page 20).
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Unlock the Data Center Terminal
This procedure allows the user that locked an instance of theData Center application to unlock it.
Note: If another employee needs to use theData Center application on this terminal, he/shemay open
another instance of it.

1. Locate the terminal displaying theData Center Unlockwindow.

2. Note the employee number in theEmployee # field.
3. Enter the employee's password in thePassword field.
4. Click theUnlock button to remove the window and reactivate theData Center screen.
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Close the Data Center Application
1. Locate the application's close button in the upper right corner of the window.

2. Click the window'sClose (whiteX on red) button to display the Log Out or Lock?window.

3. Click the Log Out button to close the application.
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Respond to a Close/Continue Window
If the system displays amessage window displayingClose andContinue buttons:

l Click theContinue button to close themessage window and continue working in the system.
l Click theClose button to close the Data Center application.
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Log Out of the Data Center Application
1. Click theAXIS tab to display theAccess Controlmenu.

2. Click the Log Out button to display the Log Out or Lock?window.

3. Click the Log Out button to display the Login window.

4. Complete either of the following procedures as appropriate:
l Click theCancel button to close the window and clear this instance of the application.
l Allow an employee to Log In to the Data Center Application (see page 16) from this window.
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Select a Date
Complete the following procedure to select a date from an onscreen calendar.

1. Navigate to the onscreen calendar.
Note: An onscreen calendar may be located directly on a screen or contained within a date entry field.

2. If the calendar is contained within a date entry field, click the calendar button to display the calendar
feature.

3. Complete the following procedures as needed to display and select the desired date:
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Select a Year 1. Click the calendar'smonth/year title (e.g., February, 2014) to
displaymonths for the currently-selected year.

2. Click the calendar's year title (e.g., 2014) to display a range of
years surrounding the currently-selected year.

3. If needed, click the arrow (t u) buttons on either side of the
title to navigate to an earlier or later range of years.

4. Click the desired year to select it and displaymonths for the
selected year.

5. Select the desiredmonth and day.
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Select a Month 1. Complete either of these procedures to display a different
month.

l Click the arrow (t u) buttons on either side of the title
as needed to navigate to and select a previous or later
month.

l Select the desiredmonth from a year's range:
1. Click the calendar'smonth/year title (e.g.,

February, 2014) to displaymonths for the
currently-selected year.

2. Click the desiredmonth to select it.
2. Select the desired day.

Select a Day Click the desired day/date in the displayedmonth to select it.
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Select a Single Product
1. Navigate to theProduct Searchwindow.

1. Access one of the following locations in theData Center application as appropriate:
l Case Quantity screen (either Search button)
l Product Kits screen (Add Kit Item button in a kit'sProduct Kit Items record)
l Purchase Orders screen (Add Product button in a purchase order’sEdit Purchase
Order window)

l Receiving Details screen (Product Search button)
l Open Work Orders (gunsmithing) screen (a work order’sProduct button)
l Open Work Orders (non-firearm) screen (a work order’sProduct button)

2. Click the indicated button to display theProduct Searchwindow.

2. Complete any of these procedures to limit the number of products shown:
l Enter all or part of a product’s description in theDescription field.
l Enter all or part of a product’s UPC code number in theUPC field.
l Click anAttribute button and one of its associatedDescriptor buttons. (Repeat as needed to
further restrict products with additional attributes and descriptors.)

l Click theClear button to remove all Attribute/Descriptor filters.
3. Check a product’s checkbox to select the product.
4. Click theSelect button to close theProduct Searchwindow.
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Select One or More Products
1. Navigate to theProduct Searchwindow.

1. Access one of the following locations in theData Center application as appropriate:
l Special Orders Report screen (Product Search button in the order'sSpecial Order
Requestwindow )

l Quick Pick Setup screen (Add button in the contents section)
l Memberships screen (Add Products button in amembership incentive's details record)
l Markup Categories screen (Add Products button in a category'sMarkup Category
Items record)

l Receiving Details screen (Product Search button)
2. Click the indicated button to display theProduct Searchwindow.

2. Complete any of these procedures to limit the number of products shown:
l Enter all or part of a product’s description in theDescription field.
l Enter all or part of a product’s UPC code number in theUPC field.
l Click anAttribute button and one of its associatedDescriptor buttons. (Repeat as needed to
further restrict products with additional attributes and descriptors.)

l Click theClear button to remove all Attribute/Descriptor filters.
3. Complete any of these procedures to select the desired product(s):

l Check a product’s checkbox to select it.
l Uncheck a product's checkbox to deselect it.
l Click theSelect All button to select all products.
l Click theUnselect All button to deselect all products.

4. Click theSelect button to close theProduct Searchwindow.
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Select or Add a Firearm Customer
1. Navigate to theCustomer Look-upwindow.

1. Access one of the following locations in theData Center application as appropriate:
l Firearm Sale screen (Select Buyer button)
l Firearm Purchase screen (Select Seller button)
l Firearm Trade screen (Select Buyer button)
l Inbound Consignment screen (Select Party button)
l Inbound Consignment Return screen (Select Party button)
l Transfer In screen (Select Customer button)
l Transfer Out screen (Select Customer button)
l Start Customer 4473 screen (Select button)
l New Gunsmithing Work Order Screen screen (Select Customer button)
l NewWork Order Screen screen (Select Customer button)

2. Click the indicated button to display theCustomer Look-upwindow.

2. Complete the following procedures as appropriate to identify the customer:

Add a New
Customer

1. Click theAdd New Customer button to display a blank
Customer Informationwindow.

2. Continue with the procedure below.
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Select an Existing
Customer

1. Complete either of these procedures to display all matching
results:

l Enter the customer's phone number in thePhone field.
l Enter all or part of the customer’s last name in the Last
Name field and press theEnter key.

2. Double-click a customer name to display the customer's
Customer Informationwindow.

3. Continue with the procedure below.

3. Enter/edit Customer information in the window as needed.
Note: Required fields and settings are displayed with red borders.

Note: If the customer has a government-issued ID, click theScan button to scan it and automatically fill
certain fields.

First Name Enter the customer's first name.
Middle Name Enter the customer'smiddle name.
Last Name Enter the customer's last name.
Country Select the country from the drop-downmenu.
Address Enter the street address.
City Enter the city.
State Select the state from the drop-down field.
Postal Code Enter the postal (ZIP) code.
Phone Number Enter the entire (xxx-xxx-xxxx) phone number.
Date of Birth Enter the customer's birth date (mm/dd/yyyy) or Select a Date (see page 24)

with the calendar button.
Email Address Enter the entire email address.
FFL Number Enter the customer's FFL number.
ID #1 Number Enter the ID number.
ID #1 Source Select the ID source from the drop-downmenu.
ID #1 Expiration Enter the ID expiration date (mm/dd/yyyy) or Select a Date (see page 24)

with the calendar button.
ID #2 Number Enter the ID number.
ID #2 Source Select the ID source from the drop-downmenu.
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ID #2 Expiration Enter the ID expiration date (mm/dd/yyyy) or Select a Date (see page 24)
with the calendar button.

ID #3 Number Enter the ID number.
ID #3 Source Select the ID source from the drop-downmenu.
ID #3 Expiration Enter the ID expiration date (mm/dd/yyyy) or Select a Date (see page 24)

with the calendar button.

4. Click theSubmit button.
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Select a Firearm Vendor
1. Navigate to theVendor Look-upwindow.

1. Access one of the following locations in theData Center application as appropriate:
l Transfer In screen (Select Dealer button)
l Transfer Out screen (Select Dealer button)
l Open Work Orders (gunsmithing) screen (OK button in the vendor selection notice
window)

2. Click the indicated button to display theVendor Look-upwindow.

2. Complete the following procedures as appropriate to identify the transfer agent:

Add a New Vendor 1. Click theNew button to display a blankVendor Information
window.

2. Continue with the procedure below.

Select an Existing
Vendor

1. If needed, enter all or part of the transfer agent's name in the
Name field to display all matching results.

2. Double-click a transfer agent name to display the agent's
Vendor Informationwindow.

3. Continue with the procedure below.

3. Enter/edit Vendor information in the window as needed.

Vendor Name Enter the vendor's name.
Address Enter the first line of the street address.
City Enter the city.
State Enter the two-letter abbreviation for the state.

32 - General Operating Procedures AXIS™ Retail Management System



Zip Enter the ZIP code.
Phone Number Enter the entire (xxx-xxx-xxxx) phone number.
Email Address Enter the entire email address.
FFL Number Enter the vendor's FFL number.

4. Click theSubmit button.
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Select a Transfer Agent
Note: A transfer agent is a firearm vendor that has been identified with a checkmark in the vendor's Is A
Transfer Agent checkbox prior to the current transaction.

1. Navigate to the Transfer Agent Look-upwindow.
1. Access one of the following locations in theData Center application as appropriate:

l Firearm Sale screen (Transfer Agent button)
l Firearm Trade screen (Transfer Agent button)
l Inbound Consignment Return screen (Transfer Agent button)

2. Click the indicated button to display the Transfer Agent Look-upwindow.

2. Complete the following procedures as appropriate to identify the transfer agent:

Add a New Transfer
Agent

1. Click theNew button to display a blankVendor Information
window.

2. Continue with the procedure below.

Select an Existing
Transfer Agent

1. If needed, enter all or part of the transfer agent's name in the
Name field to display all matching results.

2. Double-click a transfer agent name to display the agent's
Vendor Informationwindow.

3. Continue with the procedure below.

3. Enter/edit Vendor information in the window as needed.

Vendor Name Enter the vendor's name.
Address Enter the first line of the street address.
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City Enter the city.
State Enter the two-letter abbreviation for the state.
Zip Enter the ZIP code.
Phone Number Enter the entire (xxx-xxx-xxxx) phone number.
Email Address Enter the entire email address.
FFL Number Enter the vendor's FFL number.

4. Click theSubmit button.
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Select a Firearm from the Firearm Inventory Window
1. Navigate to the Firearm Inventorywindow.

1. Access one of the following locations in theData Center application as appropriate:
l Firearm Sale screen (Add Outgoing button or a firearm'sEdit button)
l Firearm Trade screen (Add Outgoing button or an incoming firearm'sEdit button)
l Transfer Out screen (Add Outgoing button or a firearm'sEdit button)
l Stolen Firearm screen (Add Firearms button)

2. Click the indicated button to display the Firearm Inventorywindow.

2. Complete one of the following procedures to select a firearm:
l Scan the firearm’s log number in theScan Log # here field and press theEnter key.
l Enter the firearm’s log number in theScan Log # here field and press theEnter key.
l Locate the firearm in the list and check itsSelect checkbox.

3. Repeat steps as needed to reattempt a failed selection and/or select additional firearms.
4. Click theSubmit button.
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Describe a Firearm
1. Navigate to the Firearm Descriptionwindow.

1. Access one of the following locations in theData Center application as appropriate:
l Firearm Purchase screen (Add Incoming button or a firearm'sEdit button)
l Firearm Trade screen (Add Incoming button or an incoming firearm'sEdit button)
l Transfer In screen (Add Transfer button or a firearm'sEdit button)
l Inbound Consignment screen (Add Incoming button or a firearm'sEdit button)
l Firearm Inventory Aging screen (a firearm'sEdit button)
l Firearm Inventory With Costs screen (a firearm'sEdit button)
l New Gunsmithing Work Order Screen screen (Add Gun button)
l Receiving Details screen (receive a firearm or a firearm'sEdit button)

2. Click the indicated button to display the Firearm Descriptionwindow.

2. Enter/edit Firearm information in the window as needed.
Note: Required fields and settings are displayed with red borders. Depending on the situation, some
fieldsmay not be present.

UPC Select the firearm's UPC code from the drop-downmenu.
Manufacturer Select amanufacturer from the drop-down.

If themanufacturer is not listed in the drop-down, enter the
manufacturer's name in the field to record it for this firearm and add it to
the drop-down for selection in the future.

Manufacturer # Enter themanufacturer's stock order number for the firearm.
Importer Select an importer (or "NONE" if applicable) from the drop-down.

If the importer is not listed in the drop-down, enter the importer's name
in the field to record it for this firearm and add it to the drop-down for
selection in the future.
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Model Note: Be sure to complete theManufacturer field before selecting or
entering amodel: The drop-down only displaysmodels associated with
the selectedmanufacturer, and amanually enteredmodel will be
associated with the selectedmanufacturer in the future.

Select amodel from the drop-down.
If themodel is not listed in the drop-down, enter themodel in the field to
record it for this firearm and add it to the drop-down for selection in the
future.

Serial Number(s) Enter (or scan) the firearm's serial number.
To recordmultiples of the same firearm, press theEnter key between
entries/scans of individual serial numbers.

Consignment Fee Select Fixed or Percentage to determine how the consignment fee is
calculated.

Amount If the selectedConsignment Fee isFixed, enter a fixed amount with
no dollar sign and two decimal places (0.00) in theAmount field.
If the selectedConsignment Fee isPercentage, enter the
percentage amount in the form of a decimal (.2 instead of 20%) in the
Percentage field.

Barrel Length Enter a numeric value (e.g., 4.48, 18.5) for the barrel length.
Gauge/Caliber Enter an alpha-numeric expression (e.g., 9mm, 12GA) for the

gauge/caliber.
Type of Firearm Select the firearm type from the drop-down.

Note: This selection determineswhich Bound Book (NFA or Non-
NFA) will contain the firearm's record.

Description Enter a description that summarizes the firearm's recorded
specifications or provides additional information about the firearm.

New/Used Select an option ("New" or "Used") from the drop-down.
Note: SelectUsed for all consignments.

Condition Enter a description of the firearm's condition.
Minimum Amount Enter theminimumamount for which the firearmmay be sold.
Inventory Number The system automatically populates this field.
Cost Enter the firearm's cost.

Note: If needed, the cost can be edited in the Bound Book later.

Sales Price Enter the price for the firearm.
Note: If no price is entered, a price will have to be entered at the time of
sale.

Location Enter the firearm's physical location in the store/warehouse.
3310-12 Firearm Check the box if the firearm should be included in 3310-12 calculations

and reports.
3. Click theSubmit button.
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Describe a Serialized Nonfirearm Item
1. Use onscreen controls to display theSerialized Nonfirearm Descriptionwindow.

2. Enter Item information in the window as needed.
Note: Required fields and settings are displayed with red borders. Depending on the situation, some
fieldsmay not be present.

UPC Enter the product's UPC code.
Description Enter the item description to be displayed on information screens.
Serial Number(s) Enter (or scan) the item's serial number.

To recordmultiples of the same item, press theEnter key between
entries/scans of individual serial numbers.

3. Click theSubmit button.

User Guide General Operating Procedures - 39



Sort and Filter Onscreen Data
Complete the following procedures as needed to adjust the arrangement and selection of data shown on a
screen.

Sort a Simple Data Screen

If a screen displays data in a simple table format, click a column's heading to sort the rows according to its
contents:

l Click the column heading once to sort the rows in ascending (A-Z; 1-2-3; Chronological; etc.) order .
l Click the column heading again to sort the rows in descending (Z-A; 3-2-1; Reverse-Chronological;
etc.) order .

Sort and Filter a Report Screen

If a screen displays data in a report format, complete any of the following procedures as appropriate to sort or
filter the report data:

Sort Rows According to a
Column's Contents

l Click the column heading once to sort the rows in ascending (A-Z;
1-2-3; Chronological; etc.) order .

l Click the column heading again to sort the rows in descending (Z-
A; 3-2-1; Reverse-Chronological; etc.) order.
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Group Rows According to a
Column's Contents

1. Drag a column heading onto the gray bar at the top of the table to
collect rows in groups.

2. Click a group'sExpand (+) button to display the rows inside it.

3. Click a group'sContract (-) button to hide the rows inside it.
Remove a Column from the
Screen

Drag a column heading above the gray bar at the top of the table to
remove it from the table.

Filter Data According to a
Column's Contents

1. Click the Filter (funnel shape) button in the column heading to
display a filter selectionmenu.

2. Complete any of these procedures to enter desired filter criteria:
l Check the checkbox(es) for contents to be retained.
(Uncheck the boxes for items to filter out.)

l Enter one or more characters in theSearch field to select
matching checkboxes.

3. Click theOK button to show filtered results.
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Custom Filter Data
According to a Column's
Contents

1. Click the Filter (funnel shape) button in the column heading to
display a filter selectionmenu.

2. Click the Text Filters (orNumber Filters) option to display a
menu of filter controls.

3. Click the desired filter control to display theCustom Filter
Selectionwindow.

4. AddConditions,Operators, andOperands as desired.
5. Click theOK button to display the filtered list.
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Create a Custom Report
View

1. Sort and filter the report as desired.
2. Right-click on the screen to display amenu of options.

Note: On some screens, thismenumay contain additional
options.

3. Click theReport Customization option to display theCustom
Grid Settingswindow.

4. Enter a name for the custom report settings in the field.
5. Click theSave button to save the custom view.

Display a Custom Report
View

1. Right-click on the screen to display amenu of options.

Note: On some screens, thismenumay contain additional
options.

2. Click theReport Customization option to display theCustom
Grid Settingswindow.

3. Select the desired custom view from the drop-down field.
4. Click theSelect button to display the report in the selected custom

view.
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Sort and Filter Reporting Screen Data
Complete the following procedures as needed to adjust the arrangement and selection of data shown on a
reporting screen.

Sort Rows According to a
Column's Contents

l Click the column heading once to sort the rows in ascending (A-Z;
1-2-3; Chronological; etc.) order .

l Click the column heading again to sort the rows in descending (Z-
A; 3-2-1; Reverse-Chronological; etc.) order.

Group Rows According to a
Column's Contents

1. Drag a column heading onto the gray bar at the top of the table to
collect rows in groups.

2. Click a group'sExpand (down arrow) button to display the rows
inside it.

3. Click a group'sContract (up arrow) button to hide the rows inside
it.

4. If desired, drag the column heading back to its original position to
undo the grouping.

Filter Data with a Search
Term

1. Enter the desired character string in theSearch field.
2. If desired, click theClear Search (X)button to undo the search.
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Filter Data According to a
Column's Contents

1. Click the Filter (funnel shape) button in the column heading to
display a filter selectionmenu.

2. Complete any of these procedures to select the value(s) to be
retained:
Note: If no checkboxes are checked, all values are retained in the
list.

l Check a value’s checkbox to select it for retention.
l Uncheck a value's checkbox to deselect it for retention. (It
will be filtered out of the list.)

l Check theSelect All checkbox to select all values for
retention.

3. Click theClose button in themenu's top right corner to close it.
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Custom Filter Data
According to a Column's
Contents

1. Click the Filter (funnel shape) button in the column heading to
display a filter selectionmenu.

2. Complete the following procedure to define a filter criterion:
1. Select a condition (Is equal to, Starts with, etc.) from the

Contains drop-down.
2. Enter the desired character string in the field below it.
3. If needed, click the aA button to toggle the casematch

control for the entered text.
3. If desired, complete the following procedure to define a secondary

filter criterion:
1. Select a connector (And,Or) from theAnd drop-down
2. Select a condition (Is equal to, Starts with, etc.) from the

Startw with drop-down.
3. Enter the desired character string in the field below it.
4. If needed, click the aA button to toggle the casematch

control for the entered text.
4. Click the Filter button to display the filtered list.
5. If desired, click theClear Filter button to undo the filtering.

Toggle Column Filter
Controls

Click the Toggle Filters button to display filter controls at the tops of the
columns. (Click again to hide the controls.)
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Clear all Filters

Click theClear All button to undo the search.
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Save and Print a Document
1. Navigate to theSave Aswindow.

2. Browse to the desired location.
3. If needed, edit the document name in the File name field.
4. Click theSave button to save the document as an electronic file and open it for viewing.
5. Select File > Print from themenu bar to display print controls.
6. Modify print options (e.g., select a different printer, adjust settings, etc.) as needed.
7. Click thePrint button to print the document.
8. Select File > Close from themenu bar to close the document.
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Export a Report to Excel
Complete the following procedure to export an onscreen report to an Excel file.

1. Navigate to a screen displaying data in a report format,

2. Right-click on the screen to display amenu of options.

Note: On some screens, thismenumay contain additional options.

3. Click theExport to Excel option to open the Excel program and display the report as a spreadsheet.

4. Select File > Save As from themenu bar to display theSave Aswindow.
5. Save and Print a Document (see page 48) to create electronic and hardcopy versions of the

spreadsheet as needed.
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System Setup and Management
This section contains procedures to set up, use, andmaintain company and store-specific information,
settings, hardware, facilities, and email templates.

Company Information
Company Information includes the company's name, addresses, websites, email addresses, and contacts.

l Manage Company Information (see page 54)
l Manage CompanyContacts (see page 56)

Store Information
Store Information includes the store's name, addresses, phone numbers, websites, email addresses, and
store-specific settings for features such as SMTP and email communications, business days, specific time
periods, fees for special services, and behaviors for theRegister application.

l Manage Store Information (see page 59)

Miscellaneous Store Information
Miscellaneous Store Information includes settings for expiration and payment due dates, online features and
listings, specialized/departmental email addresses, and the appearance of theRegister application.

l ManageMiscellaneous Store Information (see page 63)

Credit Card Processing Information
Credit card processing information includes the internet settings and locations utilized to allow secure
communication between the system and the credit card processing service.

l Manage Credit Card Processor Credentials (see page 65)

Email Templates
Whether communicating with a single vendor or an entire database of customers, email templates help create
a consistent message.

l Manage Email Templates (see page 67)

Federal Firearm License (FFL)
A Federal Firearm License (FFL) is required to acquire and dispose of firearms, track firearm transactions,
pull related reports, and generate reporting forms.

l Manage FFL Information (see page 70)

Firearm Waiting Periods
FirearmWaiting Periods define the amount of time (expressed in business days or hours) that must pass
between the purchase of a firearm and its disposition to the customer. Different waiting periodsmay be
established for different types of firearms.

l Set Up and Update a FirearmWaiting Period (see page 74)
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Firearm UPCs
FirearmUPCs allow firearms to bemore efficiently categorized and tracked within the system.

l Manage FirearmUPCs (see page 72)

Gun Show Information
Gun Show Information includes the show's name, abbreviation, location, andmailing address. A gun show
that has been set up in the systemmay be selected from a drop-downmenuwhen recording a firearm
transaction that occurred at the show. (If the appropriate gun show has not been set up, it will not be available
during this process.)

l ManageGun Show Information (see page 76)

Weighted Suggestions
Weighted Suggestions determine how the system utilizes past sales data to calculate suggestedmin/max
values.

l ManageWeighted Suggestions (see page 78)

Vendor Product Detail Windows
The Vendor Product Detail windows appear during the receiving process as amethod for establishing an
item's vendor product number.

l Manage the Vendor Product Detail Windows (see page 81)

Hardware
System hardware components (computers, POSmachines, tablets, printers, etc.) must be set up to
communicate with one another and configured to operate as desired.

l Manage Physical Machines (see page 83)
l Manage Label Printers (see page 85)

ID Types
ID Types include the variety of credentials (drivers licenses, military IDs, carry permits, etc.) with which a
customer's identitymay be verified.

l Manage Identification Types (see page 87)

Loss/Gain Reasons
Loss/Gain Reasons provide standard, selectable options for categorizing discrepancies discovered during a
physical inventory count.

l Manage Loss/Gain (StockDiscrepancy) Reasons (see page 89)

Mandatory Attributes and Descriptors
An Attribute is a broad category bywhich productsmay be identified and sorted. A Mandatory Attribute is a
required attribute that must be defined for a given product. A Descriptor is a specific value within an Attribute
category that can be assigned to similar products to distinguish them from others.

l ManageMandatory Attributes (see page 91)

Point of Sale Options
POS options include the definition of unique tender types, the automation of transaction payment processes,
the requirement of customer selection to start a transaction, and the inclusion of the customer's phone
number on receipts.
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l Manage POS Options (see page 93)
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Manage Company Information
1. Navigate to theCompany Information for screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectSetup > Company Info from themainmenu to display theCompany Information for
screen.

2. Enter/edit Company information on the screen.
Note: Required fields and settings are displayed with red borders.

Company Name Enter the name of the company.
Addresses If an address record is not needed, click itsClose (redX) button to close it.

If an additional address record is needed, click theAdd (green +) button to
open it.
Preferred If this address record is the preferredmethod of

contact, check the checkbox.
Type Select the appropriate value from the drop-down

menu.
Address 1 Enter the first line of the street address.
Address 2 Enter the second line of the street address (if

applicable).
City Enter the city.
State Enter the two-letter abbreviation for the state.
Zip Enter the ZIP code.

Emails If an email record is not needed, click itsClose (redX) button to close it.
If an additional email record is needed, click theAdd (green +) button to
open it.
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Preferred If this email record is the preferredmethod of
contact, check the checkbox.

Type Select the appropriate value from the drop-down
menu.

Email Address Enter the entire email address.
Web Sites If a website record is not needed, click itsClose (redX) button to close it.

If an additional website record is needed, click theAdd (green +) button to
open it.
Preferred If this website record is the preferredmethod of

contact, check the checkbox.
Type Select the appropriate value from the drop-down

menu.
URL Address Enter the website's URL address.

Contacts If a contact record is not needed, click itsClose (redX) button to delete it.
If an additional contact record is needed, click theAdd (green +) button to
open a blankContact Informationwindow.
To view or edit an existing contact record, click the record'sView button to
display the contact'sContact Informationwindow.
Note: Refer to Manage CompanyContacts (see page 56) for more
information.

3. Click theSubmit Changes button to display a “Record saved” confirmationmessage below the
button.

4. Click the tab'sClose button to close the screen.
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Manage Company Contacts
1. Navigate to theCompany Information for screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectSetup > Company Info from themainmenu to display theCompany Information for
screen.

2. Complete the following procedures as needed tomanage company contacts:

Add a Contact

1. Click theAdd (green +) button beside theContacts heading
to display theContact Informationwindow.

2. Continue with the procedure below.
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Edit a Contact

1. Click a contact’sView button to display the contact’sContact
Informationwindow.

2. Continue with the procedure below.

Delete a Contact

1. Click a contact’sClose (redX) button to delete it.
2. Click theSubmit Changes button to display a “Record

saved” confirmationmessage below the button.

3. Enter/edit CompanyContact information in the window.
Note: Required fields and settings are displayed with red borders.

First Enter the contact's first name.
Last Enter the contact's last name.
Title Enter the contact's title.
Addresses If an address record is not needed, click itsClose (redX) button to close it.

If an additional address record is needed, click theAdd (green +) button to
open it.
Preferred If this address record is the preferredmethod of

contact, check the checkbox.
Type Select the appropriate value from the drop-down

menu.
Address 1 Enter the first line of the street address.
Address 2 Enter the second line of the street address (if

applicable).
City Enter the city.
State Enter the two-letter abbreviation for the state.
Zip Enter the ZIP code.
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Phones If a phone record is not needed, click itsClose (redX) button to close it.
If an additional phone record is needed, click theAdd (green +) button to
open it.
Preferred If this phone record is the preferredmethod of

contact, check the checkbox.
Type Select the appropriate value from the drop-down

menu.
Voice If this phone number can receive voice calls, check

the checkbox.
Text If this phone number can receive text messages,

check the checkbox.
Phone Number Enter the entire (xxx-xxx-xxxx) phone number.

Emails If an email record is not needed, click itsClose (redX) button to close it.
If an additional email record is needed, click theAdd (green +) button to
open it.
Preferred If this email record is the preferredmethod of

contact, check the checkbox.
Type Select the appropriate value from the drop-down

menu.
Email Address Enter the entire email address.

4. Click theSave button to close the window and display the contact on theCompany Information for
screen.

5. Click theSubmit Changes button to display a “Record saved” confirmationmessage below the
button.

6. Click the tab'sClose button to close the screen.
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Manage Store Information
1. Navigate to a store'sStore Information for screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectSetup > Store Info from themainmenu to display theStore Look-upwindow.

3. Double-click a store’s name to display itsStore Information for screen.
Note: If needed, enter all or part of a store’s name in theStore Name field to restrict the stores
shown in the list.

2. Enter/edit Store information on the screen.
Note: Required fields and settings are displayed with red borders.

Store Name Enter the store name.
Store Number Enter the store number. (Changing the store number is not

recommended.)
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First Day of Week Select the first day of the businessweek from the drop-down
menu.

Base Path
Outgoing SMTP If using the AXIS RMS to send emails, enter the outgoing

SMTP.
Outgoing SMTP Port If using the AXIS RMS to send emails, enter the outgoing

SMTP port.
Outgoing SMTP Enable SSL If using the AXIS RMS to send emails, check the checkbox.
Outgoing Email Username If using the AXIS RMS to send emails, enter the outgoing

email username.
Outgoing Email Password If using the AXIS RMS to send emails, enter the outgoing

email password.
Return Email Address If using the AXIS RMS to send emails, enter the return email

address.
Timeout Seconds Enter the number of seconds the Register can be idle before it

automatically logs out the user.
Log out after Register transaction If the Register should automatically log out the user after a

transaction and require the user to log in again before
proceeding, check the checkbox.

Layaway Down Payment % Enter the percentage of a layaway's price to be required as a
minimumdown payment at the Register.

Tax Full Layaway Amount on
Initial Down Payment

If the entire tax on a layaway should be collected with the
down payment at the Register, check the checkbox.

Special Order Down Payment % Enter the percentage of a special order's price to be required
as aminimumdown payment at the Register.

Layaway Restocking % If a restocking fee is charged for a canceled layaway, enter the
percentage of a layaway's price to be charged as a fee.

Special Order Restocking % If a restocking fee is charged for a canceled special order,
enter the percentage of a special order's price to be charged
as a fee.

Maximum Gift Card Amount Enter themaximumamount that can be stored on a gift card.
(This allows for store policy to prevent the purchase of large
gift cards.)

Discount Limit Enter themaximumpercentage (in decimal format) by which
an item's pricemay be reduced without storemanager
approval.

Auto Print Firearm Receipt If firearm receipts are to be printed automatically, check the
checkbox.

Require Customer's Gender If a customer's gender must be recorded at the Register,
check the checkbox.
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Logo Complete the following procedure to replace the logo on the
Register and Data Center main screenswith a new image:
Note: The new imagemust be a .png format file stored on the
server. The imagemust have a resolution of 96 dpi, a
maximumheight of 500 px, and amaximumwidth of 1000 px.

1. Click theUpload Image button to display anOpen
window.

2. Browse to the location where the image file is located.
3. Double-click the file to place it in the image field.

Addresses If an address record is not needed, click itsClose (redX)
button to close it.
If an additional address record is needed, click theAdd (green
+) button to open it.
Preferred If this address record is the preferred

method of contact, check the checkbox.
Type Select the appropriate value from the

drop-downmenu.
Address 1 Enter the first line of the street address.
Address 2 Enter the second line of the street

address (if applicable).
City Enter the city.
State Enter the two-letter abbreviation for the

state.
Zip Enter the ZIP code.

Phones If a phone record is not needed, click itsClose (redX) button
to close it.
If an additional phone record is needed, click theAdd (green
+) button to open it.
Preferred If this phone record is the preferred

method of contact, check the checkbox.
Type Select the appropriate value from the

drop-downmenu.
Voice If this phone number can receive voice

calls, check the checkbox.
Text If this phone number can receive text

messages, check the checkbox.
Phone Number Enter the entire (xxx-xxx-xxxx) phone

number.
Emails If an email record is not needed, click itsClose (redX) button

to close it.
If an additional email record is needed, click theAdd (green +)
button to open it.
Preferred If this email record is the preferred

method of contact, check the checkbox.
Type Select the appropriate value from the

drop-downmenu.
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Email Address Enter the entire email address.
Web Sites If a website record is not needed, click itsClose (redX) button

to close it.
If an additional website record is needed, click theAdd (green
+) button to open it.
Preferred If this website record is the preferred

method of contact, check the checkbox.
Type Select the appropriate value from the

drop-downmenu.
URL Address Enter the website's URL address.

3. Click theSubmit Changes button to display a “Record saved” confirmationmessage below the
button.

4. Click the tab'sClose button to close the screen.
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Manage Miscellaneous Store Information
1. Navigate to theMisc Local Store Information screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectSetup > Misc Store Info from themainmenu to display theMisc Local Store
Information screen.

2. Enter/edit Miscellaneous Store information on the screen.
Note: Required fields and settings are displayed with red borders. Some fields are placeholders for
future functions such as online/cloud options.

Membership Expiration Enter the number of days before amembership expires to send a
notice.

Layaway Pmt Due Enter the number of days before a layaway payment comes due to
send a notice.

Birthday Email Enter the number of days before a birthday to send an email.
Credit Card Expiration Enter the number of days before a credit card expires to send a notice.
House Account Pmt Due Enter the number of days before a house account payment comes due

to send a notice.
Class Registration If class registrations can be completed via the internet, check the

checkbox.
Gift Card Purchases If gift cards can be redeemed via the internet, check the checkbox.
List New Guns Online If new firearm inventory can be viewed via the internet, check the

checkbox.
List Used Guns Online If used firearm inventory can be viewed via the internet, check the

checkbox.
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Range Reservations If range reservations can bemade(/requested) via the internet, check
the checkbox.

Network Server Name Enter the complete name (including address) of the network server.
Password Requirements Select a password requirement option from the drop-downmenu.
Receiving Email Enter the email address for the receiving department.
Purchasing Email Enter the email address for the purchasing department.
Firearm Mgr Email Enter the email address for the firearm department manager.
Store Mgr Email Enter the email address for the storemanager.
BB Print Notice Email Enter the email address to which Bound Books are sent.
3310-4 Federal Email Enter the email address to which Federal 3310-4 forms are sent.
3310-4 Local Email Enter the email address to which Local 3310-4 forms are sent.
3310-12 Fax Number Enter the fax number to which 3310-12 forms are sent.
Background Select a background option from the drop-downmenu.

3. Click theSubmit button to display an update confirmation window.
4. Click theOK button to close the confirmation window.
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Manage Credit Card Processor Credentials
1. Navigate to theCredit Card Setup screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectSetup > CC Setup from themainmenu to display theCredit Card Setup screen.

2. Select the appropriate provider (Payware) from the drop-downmenu to display a list of data fields.

3. Enter/edit provider information in the window.
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Note: Required fields and settings are displayed with red borders. Default settings are provided below.

IPAddress
Port 9001
SSL False
SSLCertificate
Timeout 30
Comm Port COM9
Baud 115200
Parity None
Databits 8
Logging Level 2
Client ID
User ID
User Password
Merchant Key
Transaction URL https://IPCharge.net/IPCHAPI/RH.aspx
Alternate URL https://IPCharge2.net/IPCHAPI/RH.aspx
Recurring Setup URL https://IPCharge.net/IPCAdminAPI/RH.ipc
Alternate Recurring URL https://IPCharge2.net/IPCAdminAPI/RH.ipc

Note: TheRecurring Setup URL andAlternate Recurring URL are used to set up a customer, set
up a contract, and update a customer or contract.

4. Complete theClient ID,User ID,User Password, andMerchant Key fields.
5. Click theSubmit button.
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Manage Email Templates
1. Navigate to theEmail Templates screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectSetup > Email Templates from themainmenu to display theEmail Templates screen.

2. Complete the following procedures as needed tomanage email templates:

Set Up an Email
Template

1. Click theAdd button to display theDefine/Edit Email
section.

2. Continue with the procedure below.

User Guide SystemSetup andManagement - 67



Edit an Email
Template

1. Click an email template’s name in theEmail Name list to
display itsDefine/Edit Email section.

2. Continue with the procedure below.

Delete an Email
Template

1. Click an email template’s name in theEmail Name list to
display itsDefine/Edit Email section.

2. Click theDelete button to remove the email template from the
Email Name list.

3. Click the tab'sClose button to close the screen.

3. Enter/edit Email Template information on the screen.

Email Name Enter the name for this template.
Email Subject Enter the subject line for this email.
Email Body Enter the text (body) for this email.
From Address Enter the From address for this email.

(If the associatedUse Global Value checkbox is checked, this field
may be left blank.)
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Use Global Value Check this checkbox to use the default global value as the From
Address.
(The default value is the address recorded in theOutgoing Email
Username field on theStore Information for screen. Refer to
Manage Store Information (see page 59) for more information.)

Reply To Address Enter the Reply To address for this email.
(If the associatedUse Global Value checkbox is checked, this field
may be left blank.)

Use Global Value Check this checkbox to use the default global value as theReply To
Address.
(The default value is the address recorded in theReturn Email
Address field on theStore Information for screen. Refer to Manage
Store Information (see page 59) for more information.)

4. Click theSubmit button to add/update the email template on theEmail Name list.
5. Click the tab'sClose button to close the screen.
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Manage FFL Information
1. Navigate to the FFL Information screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectSetup > FFL Information from themainmenu to display the FFL Information screen.

2. Enter/edit FFL information on the screen.

Trade Name Enter the trade name shown on the FFL.
Address Enter the street address shown on the FFL.
City Enter the city shown on the FFL.
State Select the state shown on the FFL from the drop-down.
Zip Code Enter the ZIP code shown on the FFL.
FFL Number Enter the entire the FFL number.

Note: The number will be hidden where appropriate.

Class 3 (NFA) Dealer Check the checkbox if the store is licensed to deal in class 3 (NFA)
firearms.

Generate 3310-12 Forms Check the checkbox to activate 3310-12 form controls and procedures.
Agency Name Enter the name of the state/local agency to which completed 3310

formswill be sent.
Agency Address Enter the address of the state/local agency to which completed 3310

formswill be sent.
Print Full FFL Number on
Forms

Check the checkbox to print the entire FFL number on forms.
Note: If the box is not checked, an abbreviated version of the number
will be used.

3. Complete the following procedures to identify days and dates on which the store will be closed:
l Click a weekday button to add all corresponding dates to theDays Closed list.
l Select a Date (see page 24) on the calendar and click theAdd Date button to add the date to the
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Days Closed list.
l Click a closed date’sDelete (redX) button to remove the date from the list.
l Click theClear List button to remove all dates from theDays Closed list.

4. Click theSubmit button to display an update confirmation window.
Note: If theGenerate 3310-12 Forms checkbox is not checked and theState field indicatesCA,AZ,
TX, orNM, the systemwill display an error message window.

Complete either of the following as appropriate to close the window:

l Click theGenerate 3310-12 button to close the window and display the checkedGenerate
3310-12 Forms checkbox on the FFL Information screen.

l Click theDo Not Generate 3310-12 button to close the window and let the system operate
without the new 3310 functionality.

5. Click theOK button to close the confirmation window.
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Manage Firearm UPCs
Complete the following procedure to create andmaintain a FirearmUPC.
Note: A FirearmUPC can be used to identify a type of firearm (i.e., a used handgun) that does not have an
existing UPC. A FirearmUPC can be selected from theUPC drop-down in the following firearm-specific
locations:

l Firearm Descriptionwindow
l Bound Book screens
l Information For Log #window
l Excel Import screen
l Firearm Inventory With Costs screen
1. Navigate to the Firearm UPC screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectSetup > Firearms > Firearm UPCs from themainmenu to display the Firearm UPC
screen.

2. Sort and Filter Reporting Screen Data (see page 44) as needed.
3. Complete the following procedures as needed tomanage firearmUPCs:

Add a Firearm UPC 1. Click theNew Firearm UPC button to display a UPC entry
window.

2. Enter/scan an 18-character alphanumeric UPC in the field.
3. Click theSubmit button.
4. The system checks to see if the UPC already exists in the

database:
l If the UPC is in the database, the system adds it to the
list on the Firearm UPC screen.

l If the UPC is not in the database, the system displays
theProduct Editwindow.
Note: TheUPC field will be populated with the entered
UPC and the Is Firearm checkboxwill be checked.

Complete the window's sections to define the UPC.
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Edit a Firearm UPC 1. Click a UPC'sEdit button to display the UPC’sProduct Edit
window.

2. Complete the window's sections to define the UPC.

Deactivate
(/Reactivate) a
Firearm UPC

Complete the following procedures as needed tomanage the
FirearmUPC's active status:

l To deactivate the FirearmUPC: Uncheck the UPC'sActive
checkbox to remove it fromUPC drop-down fields.

l To reactivate the FirearmUPC: Check the UPC'sActive
checkbox to reinstate it inUPC drop-down fields.:

Delete a Firearm
UPC

Click a UPC'sDelete button to remove the UPC from the list on the
Firearm UPC screen.
Note: Deleting a UPC from this screen will not delete the UPC's
Product Maintenance record.
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Set Up and Update a Firearm Waiting Period
1. Navigate to theWaiting Period Setup screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectSetup > Firearms > Waiting Periods from themainmenu to display theWaiting
Period Setup screen.

2. Complete the following procedures as appropriate tomanage firearmwaiting periods:

Create a Firearm
Waiting Period

1. Select the firearm type from the Type drop-down field.
Note: If a waiting period has already been set up for the
selected firearm type, the new waiting period will take the
place of the existing period.

2. Continue with the procedure below.

Edit a Firearm
Waiting Period

1. Click a waiting period in the list to select it.
2. Click theEdit button to display the waiting period’s information

on theWaiting Period Setup screen.
3. Continue with the procedure below.

Delete a Firearm
Waiting Period

Click a waiting period'sDelete button to remove it from the list.

3. Enter/edit FirearmWaiting Period information on the screen.

Type Select the firearm type from the drop-down field.
Note: If a waiting period has already been set up for the selected
firearm type, the new waiting period will take the place of the existing
period.

Duration Enter the waiting period in hours in the field.
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Day Of Sale Excluded If the waiting period does not start until the day after a transaction,
check the checkbox.

Do Not Allow Exceptions If exceptions to the waiting period are not allowed, check the checkbox.
4. Click theSave button to add/update the waiting period on the list.
5. Complete the following procedures to identify days and dates that will not be included in waiting

periods:
l Click a weekday button to add all corresponding dates to theExempt Day from Waiting
Periods list.

l Select a Date (see page 24) on the calendar and click theAdd Date button to add the date to the
Exempt Day from Waiting Periods list.

l Click an exempt date’sDelete (redX) button to remove the date from the list.
l Click theClear List button to remove all dates from theExempt Day from Waiting Periods
list.

6. Click the tab'sClose button to close the screen.
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Manage Gun Show Information
1. Navigate to theGun Shows screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectSetup > Gun Shows from themainmenu to display theGun Shows screen.

2. Complete the following procedures as appropriate tomanageGun Show information:

Add a Gun Show

1.1. Click theNew Gun Show button to display theDefine/Edit
Gun Showwindow.

2. Continue with the procedure below.
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Edit a Gun Show

1. Click a gun show’sEdit button to display itsDefine/Edit Gun
Showwindow.

2. Continue with the procedure below.

Delete a Gun Show

Click a gun show’sDelete button to remove the gun show from the
list on theGun Shows screen.

3. Enter/edit Gun Show information in the window.
Note: Required fields and settings are displayed with red borders.

Gun Show Name Enter the gun show's name. (If the gun show is selected during a firearm
sale at a gun show, theGun Show Namewill appear in the Bound Book.)

Abbreviation Enter an abbreviated version of theGun Show Name to appear in lists and
drop-downmenus.

City Enter the gun show location's city.
State Select the gun show location's state from the drop-downmenu.
Mailing Address

Address Enter the gun show mailing address's street
address

City Enter the gun show mailing address's city.
State Select the gun show mailing address's state from

the drop-downmenu.
Zip Code Enter the gun show mailing address's ZIP code.

4. Click theSubmit button to add/update the gun show on the list on theGun Shows screen.
5. Click the tab'sClose button to close the screen.
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Manage Weighted Suggestions
Complete the following procedure to set up andmaintain weight percentages for departments.
Note: A user must be granted the InventoryManagement, StoreManager, or Purchasing permission to
view/use this feature.

1. Navigate to theWeighted Suggestion Setup screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectSetup > Inventory > Weighted Suggestions from themainmenu to display the
Weighted Suggestion Setup screen.

2. Sort and Filter Reporting Screen Data (see page 44) as needed.
3. Complete the following procedures as needed tomanage suggestion weights:
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Modify a Department's
Week Weight Values

1. Click a name in theDepartment column to activate that
department's row.
Note: If the desired department does not exist, complete the
Add a Department procedure to add it to the list.

2. Double-click the value in one of the department's week (Last
Week, 2 Weeks Ago, ... 8 Weeks Ago) cells to highlight it.

3. Enter/edit the desired weight percentage.
Note: This value represents the relative weight of this week's
sales versus sales in the other 7 weeks. The values in the
department's 8 week cellsmust add up to 100%. Negative
values are not allowed.

4. Modify other week cells in the row as needed tomaintain the
100% total.

5. Press theEnter key to deactivate the department's row.
Note: If the week cell values do not add up to 100%, the
department row is highlighted in red. Revise one or more cell
values as needed.

6. Click theSubmit button to save changes.
Note: The systemwill revise suggestedmin/max values for
items in the department accordingly and update actual
min/max values for department items that are set to
automatic.

Modify a Department's
Safety Stock Value

1. Click a name in theDepartment column to activate that
department's row.
Note: If the desired department does not exist, complete the
Add a Department procedure to add it to the list.

2. Double-click the value in the department'sSafety Stock cell
to highlight it.

3. Enter/edit the desired safety stock percentage.
Note: This value represents additional stock (a percentage
over and above the anticipated need) that ismaintained to
alleviate the risk of being out of stock during the lead time due
to uncertainties in supply and demand.

4. Press theEnter key to deactivate the department's row.
5. Click theSubmit button to save changes.

Note: The systemwill revise suggestedmin/max values for
items in the department accordingly and update actual
min/max values for items that are set to automatic.
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Add a Department 1. Click theAdd Department button to display theSelect
Departmentwindow.

2. Select a department from the drop-down.
3. Click theSelect button to close the window and display the

selected department on the list.
4. Click theSubmit button to save changes.

Note: The systemwill revise suggestedmin/max values for
items in the department accordingly and update actual
min/max values for items that are set to automatic.

Delete a Department 1. Click a department'sDelete button to remove it from the list.
2. Click theSubmit button to save changes.

Note: Items from the deleted department will revert to the
"Department Default" department.
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Manage the Vendor Product Detail Windows
Complete the following procedure tomanage the display of theVendor Product Detailwindow.

1. Navigate to theVendor Product Setup screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectSetup > Inventory > Vendor Product Details from themainmenu to display the
Vendor Product Setup screen.

2. Complete the following procedures as needed tomanage the display of Vendor Product Detail
windows:

Prevent All Vendor
Product Detail Windows
from Displaying

1. Check theDisable Vendor Product Details pop-up
screen checkbox.

2. Click the tab'sClose button to close the screen.
Allow Individual Vendor
Product Detail Windows to
Display

1. Uncheck theDisable Vendor Product Details pop-up
screen checkbox.
Note: This setting allows each UPC-specificVendor
Product Detailwindow to be individually configured to
display or not.

2. Click the tab'sClose button to close the screen.
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Configure an Individual
Vendor Product Detail
Window

1. Complete the procedure toAllow Individual Vendor
Product Detail Windows to Display.

2. Access a UPC'sProduct Editwindow.
Note: Refer to Manage Product Information (see page 149)
for information on accessing and using this window.

3. Click theVendor Product tab to display it.

4. Check /uncheck theDisable Vendor Product Details Pop-
up for this product checkbox to configure display settings
for this UPC'sVendor Product Detailwindow:

l Check the checkbox to prevent the window from
displaying in the future.

l Uncheck the checkbox to allow the window to display in
the future.

5. Click theSubmit button to close the window.
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Manage Physical Machines
1. Navigate to thePhysical Machines screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectSetup > Physical Machines from themainmenu to display thePhysical Machines
screen.

2. Complete the following procedures as needed tomanage physical machines:

Set Up a Physical
Machine

1. Click theNew Physical Machine button to display the
Define/Edit Physical Machine Mappingwindow.

2. Continue with the procedure below.
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Edit a Physical
Machine

1. Click amachine'sEdit button to display itsDefine/Edit
Physical Machine Mappingwindow.

2. Continue with the procedure below.

Delete a Physical
Machine

1. Click amachine'sDelete button to remove it from the
Physical Machines screen.

2. Click the tab'sClose button to close the screen.

3. Enter/edit Physical Machine information in the window.

Logical Name Enter the store's name for the component (e.g., Register 1).
Windows System Name Enter theWindows System Name for the component.

Note: The name assignedmay not be a duplicate of another machine's
name.

If needed, complete the following to find the name:
1. Right-click the component'sComputer icon to display amenu.
2. Click theProperties option to display system information.
3. Locate theComputer name.

Is POS Check the checkbox if the component is a Point Of Sale (place where
transactions occur).

Is Tablet Check the checkbox if the component is a tablet.

4. Click theSubmit button to close theDefine/Edit Physical Machine Mappingwindow and
add/update themachine in the list on thePhysical Machines screen.

5. Click the tab'sClose button to close the screen.
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Manage Label Printers
1. Navigate to the Label Printer Setup screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectSetup > Label Printer Setup from themainmenu to display the Label Printer Setup
screen.

2. Enter the name of firearm label printer in the Firearm Label field.
3. Select the firearm label format in the corresponding Label Format field.

Note: The following firearm label formats are available.

Each format includes barcodes for the firearm's UPC and log number. Format 2 includes a third
barcode for the firearm's cost.

4. Enter the name of product label printer in theProduct Label field.
5. Select the product label format in the corresponding Label Format field.
6. If desired, check theDefault to print labels during Receiving checkbox to automatically check the

print label checkboxes on the Label Printingwindow during the receiving process.
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Note: If this checkbox is not checked, the print label checkboxes on the Label Printingwindow will not
be automatically checked.

7. If desired, check theDefault to print labels during Invoicing checkbox to automatically check the
print label checkboxes on the Label Printingwindow during the invoicing process.
Note: If this checkbox is not checked, the print label checkboxes on the Label Printingwindow will not
be automatically checked.

8. Click theSubmit button to display an update confirmation window.

9. Click theOK button to close the window.
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Manage Identification Types
1. Navigate to the Identification Types screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectSetup > Identification Types from themainmenu to display the Identification Types
screen.

2. Complete the following procedures as needed tomanage identification types:

Set Up an
Identification Type

1. Click theNew Identification Type button to display the
Define/Edit Identification Typewindow.

2. Continue with the procedure below.
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Edit an Identification
Type

1. Click a identification type’sEdit button to display its
Define/Edit Identification Typewindow.

2. Continue with the procedure below.

Delete an
Identification Type

1. Click a identification type’sDelete button to remove it from the
list on the Identification Types screen.

2. Click the tab'sClose button to close the screen.

3. Enter/edit Identification Type information on the window.

Identification Name Enter a name for the ID Type (e.g.,StateDriver's License; Military ID;
Permit to Carry, etc.)

Sort Order Enter a number (i.e., 0, 1, 2, etc.) to indicate the placement of this ID
Type in a drop-downmenu.
The drop-downmenu displays ID Types by their sort order numbers
from lowest (at the top of the list) to highest (at the bottom).

Expiration Required Check the checkbox to require a valid expiration date for the ID Type to
be accepted.

4. Click theSubmit button to add/update the identification type in the list on the Identification Types
screen.

5. Click the tab'sClose button to close the screen.
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Manage Loss/Gain (Stock Discrepancy) Reasons
1. Navigate to the Loss/Gain Reasons screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectSetup > Loss/Gain Reasons from themainmenu to display the Loss/Gain Reasons
screen.

2. Complete the following procedures as needed tomanage loss/gain reasons:

Set Up a Loss/Gain
Reason

1. Click theNew Reason button to display theDefine/Edit
Stock Discrepancy Reasonwindow.

2. Continue with the procedure below.

Edit a Loss/Gain
Reason

1. Click a reason’sEdit button to display itsDefine/Edit Stock
Discrepancy Reasonwindow.

2. Continue with the procedure below.

Delete a Loss/Gain
Reason

1. Click a reason’sDelete button to remove it from the list on the
Loss/Gain Reasons screen.

2. Click the tab'sClose button to close the screen.

3. Enter/edit Loss/Gain Reason information on the window.
Note: Required fields and settings are displayed with red borders.

Reason Enter a descriptive reason for a loss or gain (e.g., Theft, In Store Use,
etc.)

For Product Check the checkbox if the reason applies to standard (non-firearm)
products.

For Firearm Check the checkbox if the reason applies to firearms.

4. Click theSubmit button to add/update the reason on the list on the Loss/Gain Reasons screen.
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5. Click the tab'sClose button to close the screen.
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Manage Mandatory Attributes
1. Navigate to theAttribute Control screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectSetup > Mandatory Attributes from themainmenu to display theAttribute Control
screen.

2. Complete the following procedures as needed tomanagemandatory attributes:

Set Up a Mandatory
Attribute

1. Select the appropriate ItemDescriptor from the drop-down
field near the top of the screen.
Note: If themandatory attribute will apply to all items, select
All Items from the drop-down field.

2. Complete either of these procedures to select the desired
mandatory attribute:

l Select the attribute from theAdd Mandatory
Attribute drop-down field.

l Enter the name of a new attribute in theAdd
Mandatory Attribute field.
Note: Be sure to spell and capitalize the attribute name
correctly as it cannot be edited after entry.

3. Click theAdd button to add the selected attribute to the
Attribute Name list.

4. Click theClose button to close the screen.
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Remove a Mandatory
Attribute for an Item
Descriptor

1. Select the appropriate ItemDescriptor from the drop-down
field near the top of the screen.

2. Click an attribute’sDelete button to remove it from the
Attribute Name list.

3. Click theClose button to close the screen.
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Manage POS Options
1. Navigate to thePOS Setup screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectSetup > POS Setup from themainmenu to display thePOS Setup screen.

2. Complete the following procedures as needed tomanage POS options:

Include the
Customer’s Phone
Number on Receipts

1. Check thePrint Customer Phone Number on Receipt
checkbox to include the customer’s phone number on printed
and electronic receipts.

2. Click theSubmit button to display a save confirmation
window.

3. Click theClose button to close the window.

Require Customer
Selection to Start a
Transaction

1. Check theRequire Customer for Every Transaction
checkbox to require a customer be selected (or added) for
every transaction in theRegister application.

2. Click theSubmit button to display a save confirmation
window.

3. Click theClose button to close the window.

Automate
Transaction
Payment Completion

1. Check theAutomatic Payment Completion checkbox to
complete transaction payments automatically (without clicking
theSubmit button) in theRegisterapplication simply by
entering sufficient tender to cover the total amount.

2. Click theSubmit button to display a save confirmation
window.

3. Click theClose button to close the window.
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Define a Unique
Tender Type

1. Enter a name for the tender type in a blankTender Name
field.

2. Check the correspondingActive checkbox tomake the
tender type available in theRegister application.

3. Click theSubmit button to display a save confirmation
window.

4. Click theClose button to close the window.
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MultiStore Administration
TheMultiStoreModule is currently under construction.
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Personnel Administration
This section contains procedures to set up, maintain, and review personnel data including personal
information, system credentials, work histories, and a list of all employees.

Personal Information
Personal Information includes the employee's name, title, Social Security Number, addresses, phone
numbers, email addresses, and important dates.

l Select an Employee (see page 98)
l Manage Employee Records (see page 100)

System Credentials
SystemCredentials include an employee's login ID, password, and roles.

l Manage an Employee’s SystemCredentials (see page 102)

Employee List
The Employee List displays all employees and approved system users.

l View the Employee List (see page 104)

Work Histories
WorkHistories provide records of an employee's transactions and services.

l View an Employee’s Transactions (see page 105)
l View an Employee’s Layaways (see page 106)
l View an Employee’s Product Holds (see page 107)
l View an Employee’s Special Orders (see page 108)
l View an Employee’s CompletedWorkOrders (see page 109)
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Select an Employee
Note: This procedure selects an existing employee from the personnel database for review and
maintenance of the employee's record. To add a new employee to the database, refer to Manage Employee
Records (see page 100).

1. Navigate to theEmployee Look-upwindow.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectPersonnel > Select Employee from themainmenu to display theEmployee Look-up
window.

2. Enter all or part of the employee’s last name in the Last Name field to display all matching results.
3. Double-click a name to select the employee and display the employee'sEmployee Information for

screen.
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4. Complete the following procedures as needed:
l Manage Employee Records (see page 100)
Note: The employee record includes the employee's name, title, Social Security Number,
addresses, phone numbers, email addresses, and important dates.

l Manage an Employee’s SystemCredentials (see page 102)
Note: System credentials include an employee's login ID, password, and roles..

5. Click the tab'sClose button to close the screen.
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Manage Employee Records
1. Complete the following procedures as needed tomanage employee records:

Add an Employee
Record

1. SelectPersonnel > Add New Employee from themain
menu to display a blankEmployee Information for screen.

2. Continue with the procedure below.

Edit an Employee
Record

1. Select an Employee (see page 98).

2. If needed, selectPersonnel > Edit Employee from themain
menu to display the employee'sEmployee Information for
screen.

3. Continue with the procedure below.

2. Enter/edit Employee information on the screen.
Note: Required fields and settings are displayed with red borders.

First Enter the employee's first name.
Middle Enter the employee'smiddle name.
Last Enter the employee's last name.
Birth Date Enter the employee's birth date (mm/dd/yyyy) or Select a Date (see page

24) with the calendar button.
Title Enter the employee's title.

100 - Personnel Administration AXIS™ Retail Management System



Date of Hire Enter the employee's hiring date (mm/dd/yyyy) or Select a Date (see page
24) with the calendar button.

SSN Enter the employee's Social Security number.
Is Terminated Check the box if the employee has been terminated.
Addresses If an address record is not needed, click itsClose (redX) button to close it.

If an additional address record is needed, click theAdd (green +) button to
open it.
Preferred If this address record is the preferredmethod of

contact, check the checkbox.
Type Select the appropriate value from the drop-down

menu.
Address 1 Enter the first line of the street address.
Address 2 Enter the second line of the street address (if

applicable).
City Enter the city.
State Enter the two-letter abbreviation for the state.
Zip Enter the ZIP code.

Phones If a phone record is not needed, click itsClose (redX) button to close it.
If an additional phone record is needed, click theAdd (green +) button to
open it.
Preferred If this phone record is the preferredmethod of

contact, check the checkbox.
Type Select the appropriate value from the drop-down

menu.
Voice If this phone number can receive voice calls, check

the checkbox.
Text If this phone number can receive text messages,

check the checkbox.
Phone Number Enter the entire (xxx-xxx-xxxx) phone number.

Emails If an email record is not needed, click itsClose (redX) button to close it.
If an additional email record is needed, click theAdd (green +) button to
open it.
Preferred If this email record is the preferredmethod of

contact, check the checkbox.
Type Select the appropriate value from the drop-down

menu.
Email Address Enter the entire email address.

3. Click theSubmit Changes button to display aRecord Saved confirmation note under the button.
4. Click the tab'sClose button to close the screen.
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Manage an Employee’s System Credentials
1. Select an Employee (see page 98).

2. SelectPersonnel > Security Management from themainmenu to display the employee'sSecurity
Information for screen.

3. Complete the following procedures as needed tomanage employee credentials:

Change an
Employee's Login ID

1. Enter a new login ID in theChange Login ID field.
2. Click theSubmit button to display a change confirmation

window.

3. Click theOK button to close the change confirmation window.

Change an
Employee’s
Password

1. Enter a new password in theNew Password field.
2. Enter the new password again in theRepeat New Password

field.
3. Click theChange Password button to display aRecord

Saved confirmation note in the lower left portion of the screen.
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Select Roles
(Permissions) for an
Employee

1. Complete the following procedures as needed to select the
desired set of roles for the employee:

l Check a role to select it for the employee.
l Uncheck a role to deselect it for the employee.
l Click theAdministrator button to select all roles for the
employee.

l Click theUnselect button to deselect all roles for the
employee.

2. Click theSubmit Roles button to display aRecord Saved
confirmation note in the lower left portion of the screen.

4. Click the tab'sClose button to close the screen.
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View the Employee List
1. Navigate to theEmployee List screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectPersonnel > Employee List from themainmenu to display theEmployee List screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Click the tab'sClose button to close the screen.
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View an Employee’s Transactions
1. Select an Employee (see page 98).

2. SelectPersonnel > Transactions from themainmenu to display the employee'sTransactions of
screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

3. Click the tab'sClose button to close the screen.
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View an Employee’s Layaways
1. Select an Employee (see page 98).

2. SelectPersonnel > Layaways from themainmenu to display the employee'sLayaways of screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

3. Click the tab'sClose button to close the screen.
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View an Employee’s Product Holds
1. Select an Employee (see page 98).

2. SelectPersonnel > Products on Hold from themainmenu to display the employee'sProduct
Holds of screen.

3. Click the tab'sClose button to close the screen.
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View an Employee’s Special Orders
1. Select an Employee (see page 98).

2. SelectPersonnel > Special Orders from themainmenu to display the employee'sSpecial Orders
of screen.

3. Click the tab'sClose button to close the screen.
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View an Employee’s Completed Work Orders
1. Select an Employee (see page 98).

2. SelectPersonnel > Work Orders from themainmenu to display the employee'sWork Orders of
screen.

3. Click the tab'sClose button to close the screen.
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Customer Administration
This section contains procedures to set up, maintain, and review customer data including personal
information, ID types, house accounts, purchase histories, and an assortment of useful customer lists.

Personal Information
Personal Information includes the customer's name, ID numbers, addresses, phone numbers, email
addresses, websites, important dates, and notes.

l Select a Customer (see page 113)
l Set Up andMaintain a Customer Record (see page 114)
l Clear the Currently Selected Customer (see page 117)

Customer List
TheCustomer List collects every customer record in the database into a single list. This list can be exported to
Excel for use outside the system. TheCustomer List screen provides tools for identifying and dealing with
duplicate customer records.

l View and Update the Customer List (see page 118)
l Import Customer Data (see page 119)
l Manage System-Identified Duplicate Customer Records (see page 121)
l ManageManually Identified Duplicate Customer Records (see page 126)

Best Customer List
The Best Customer List determines the top-spending customers in the database and displays them in a
sorted list. The list defaults to showing the top 25 customers but can be configured to display a larger list.

l View the Best Customer List (see page 129)

ID Types
ID Types include the variety of credentials (drivers licenses, military IDs, carry permits, etc.) with which a
customer's identitymay be verified.

l Manage Identification Types (see page 87)

Alias IDs
An Alias ID provides an easier and simpler way of identifying a customer in theRegister application. The
Customer Alias ID Update screen displays every customer record in the database along with its Alias ID (if
assigned) and provides a tool for assigning an Alias ID to a customer or editing an existing Alias ID.

l View and Update the Customer Alias ID List (see page 130)

House Accounts
House Accounts allow customers to charge purchases to an account (up to a preset limit) and pay the balance
at a future date. The House Accounts Report provides an up-to-date overview of all house accounts including
account holders and balances.
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l Set Up and Edit a Customer's House Account (see page 131)
l View the House Accounts Report (see page 134)

Deposits
Deposits allow customers to provide funds toward future purchases (particularly firearms). A deposit must be
redeemed all at once. The Deposits List screen provides an up-to-date list of all active deposits.

l View the Deposits List (see page 135)

Purchase Histories
Purchase Histories provide a record of a customer's transactions, purchased services, memberships, and
signed waivers.

l View and Use a Customer’s TransactionsHistory (see page 136)
l View and Update a Customer’sMemberships (see page 138)
l View and Print a Customer’s SignedWaivers (see page 141)
l View aCustomer’s Layaways (see page 142)
l View aCustomer’s Product Holds (see page 143)
l View and Update a Customer’s Special Orders (see page 144)
l View aCustomer’s CompletedWorkOrders (see page 146)
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Select a Customer
Note: This procedure selects an existing customer from the customer database for review andmaintenance
of the customer's record. To add a new customer to the database, refer to Set Up andMaintain a Customer
Record (see page 114).

1. Navigate to theCustomer Look-upwindow.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectCustomer Admin > Select Customer from themainmenu to display theCustomer
Look-upwindow.

2. Complete either of these procedures:
l Enter the customer phone number in thePhone field.
l Enter all or part of the customer’s last name in the Last Name field.

3. Press theEnter key on the keyboard to display all matching results.

4. Double-click a name to select the customer and display theOverview of screen for the customer.
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Set Up and Maintain a Customer Record
1. Complete the following procedures as appropriate tomaintain customer records:

Add a Customer
Record

1. SelectCustomer Admin > Add New Customer from the
mainmenu to display a blankCustomer Information for
screen.

2. Continue with the procedure below.

Edit a Customer
Record

1. Select a Customer (see page 113).

2. SelectCustomer Admin > Customer Info and Edit from
themainmenu to display the customer'sCustomer
Information for screen.

3. Continue with the procedure below.

2. Enter/edit Customer information on the screen.
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Note: Required fields and settings are displayed with red borders. Some fieldsmay not be present in
all situations.

Note: If the customer has a government-issued ID, click theScan button to scan it and automatically fill
certain fields.

Prefix Select a prefix from the drop-downmenu.
First Enter the customer's first name.
Middle Enter the customer'smiddle name.
Last Enter the customer's last name.
Suffix Select a suffix from the drop-downmenu.
Gender Select a gender from the drop-downmenu.
Company Enter the customer's company name.
Birth Date Enter the customer's birth date (mm/dd/yyyy) or Select a Date (see page

24) with the calendar button.
Customer ID The system automatically generates a unique number and assigns it to the

customer.
Alias ID Enter a unique retailer-generated number per store policy.
Salesperson Select the appropriate salesperson from the drop-downmenu.
Tax ID Enter the customer's unique, government-issued number to designate tax-

exempt status for the customer.
ID #1; ID #2; ID #3 Enter up to three unique ID records. Click a tab to display the fields for that

record.
ID Number/# Enter the ID number.
ID Source Select the ID source from the drop-downmenu.
ID Expiration Enter the ID expiration date (mm/dd/yyyy) or

Select a Date (see page 24) with the calendar
button.

FFL Enter the customer's FFL number.
Note Enter a brief explanatory note about the customer to be displayed at the

Register.
Scan Click the button to scan the customer’s government-issued ID and

automatically fill certain fields.
Addresses If an address record is not needed, click itsClose (redX) button to close it.

If an additional address record is needed, click theAdd (green +) button to
open it.
Preferred If this address record is the preferredmethod of

contact, check the checkbox.
Type Select the appropriate value from the drop-down

menu.
Country Select the country from the drop-downmenu.
Address 1 Enter the first line of the street address.
Address 2 Enter the second line of the street address (if

applicable).
City Enter the city.
State Enter the two-letter abbreviation for the state.
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Zip Enter the ZIP code.
County Enter the county.

Phones If a phone record is not needed, click itsClose (redX) button to close it.
If an additional phone record is needed, click theAdd (green +) button to
open it.
Preferred If this phone record is the preferredmethod of

contact, check the checkbox.
Type Select the appropriate value from the drop-down

menu.
Voice If this phone number can receive voice calls, check

the checkbox.
Text If this phone number can receive text messages,

check the checkbox.
Phone Number Enter the entire (xxx-xxx-xxxx) phone number.

Emails If an email record is not needed, click itsClose (redX) button to close it.
If an additional email record is needed, click theAdd (green +) button to
open it.
Preferred If this email record is the preferredmethod of

contact, check the checkbox.
Type Select the appropriate value from the drop-down

menu.
Email Address Enter the entire email address.

Web Sites If a website record is not needed, click itsClose (redX) button to close it.
If an additional website record is needed, click theAdd (green +) button to
open it.
Preferred If this website record is the preferredmethod of

contact, check the checkbox.
Type Select the appropriate value from the drop-down

menu.
URL Address Enter the website's URL address.

3. Click theSubmit Changes button to display a confirmation window.

4. Click theClose button to close the confirmation window and display the customer'sOverview of
screen.
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Clear the Currently Selected Customer
1. Click theCustomer Admin tab to display the Customer Administration ribbon.

2. Click theUnselect Customer button to display a blankOverview of screen.
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View and Update the Customer List
1. Navigate to theCustomer List screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectCustomer Admin > Customer List from themainmenu to display theCustomer List
screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedures as needed:
l Import Customer Data (see page 119)
Note: Customer datamay be imported into theCustomer List screen by creating, populating,
and importing a formatted Excel file.

l Manage System-Identified Duplicate Customer Records (see page 121)
Note: Customer records that contain similar information (as identified by the system) may be
merged into a single record or permanently distinguished from each other.

l ManageManually Identified Duplicate Customer Records (see page 126)
Note: Customer records that contain similar information (as identified by the user) may be
merged into a single record or permanently distinguished from each other.

3. Click the tab'sClose button to close the screen.
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Import Customer Data
Complete the following procedure to import customer data into theCustomer List screen by creating,
populating, and importing a formatted Excel file.

1. Navigate to theCustomer List screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectCustomer Admin > Customer List from themainmenu to display theCustomer List
screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Click theExport Template button to export the template format to an Excel file.

3. Populate the Excel file with customer information.
Note: The file must adhere to the validation requirements indicated in row 1 and below:

l First Name and Last Name are required fields.
l No entrymay have the same values for First Name, Last Name, andBirth Date as any other
entry in this file or already in the system.

l If theEmail Address field is populated, theEmail Type field is required.An entry in theEmail
Type field must exactlymatch one of the defined email types (Personal,Business, orOther)

l Any entry in one of the ID Source columnsmust exactlymatch one of the sources defined on the
Identification Types screen. (SelectSetup > Identification Types to view this screen.)

4. Save the Excel file.

5. Click the Import button on theCustomer List screen to display the Load Excel Importwindow.
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6. Browse to the desired location.
7. If the system detects any errors, it displays the Import Complete with Errorswindow.

Complete any of the following as needed:
l Click thePrint/Save button to display the errors in a formatted template file that may bemanually
printed and/or saved. Click another button as appropriate to close this window.

l Click theContinue button to continue with the import for the uploaded items.
l Click theCancel button to cancel the import.

8. When the import is complete, the system displays theUpload Completewindow.

9. Click theClose button to close the window.
10. Click the tab'sClose button to close the screen.
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Manage System-Identified Duplicate Customer
Records
Complete the following procedure to automatically identify duplicate customer records and either merge them
into a single record or permanently distinguish them from each other.

1. Navigate to theCustomer List screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectCustomer Admin > Customer List from themainmenu to display theCustomer List
screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Click the Find Duplicates button to display theDuplicate Customers list.

3. Click a name in theDuplicate Customers list to display the duplicate customer records.
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4. Determine the relationship between the displayed customer records:
l If both records are for the same customer, theymay bemerged into a single record. One will be
the Primary record (to be retained in the customer list) and the other will be the Secondary record
(to bemerged and removed).

l If each record is for a different customer, theymay be distinguished from each other.
5. Complete the appropriate procedure for the displayed customer records:
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Merge Customer
Records

Complete the following procedure tomerge two records into a single
customer record.

1. Determine which customer record will be retained and click its
Select Primary button to display the customer information
thePrimary Customer field.

2. Determine which customer record will bemerged into the
other and click itsSelect Secondary button to display the
customer information in theSecondary Customer field.

3. Click theMerge Customer Records button to display the
Confirm Merge Operation screen.
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4. Click theOK button to display amerge confirmation window.

5. Click theClose button.
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Distinguish
Customer Records

Complete the following procedure to establish two records as
distinct customer records.

1. Click a customer record'sSelect Primary button to display its
customer information in thePrimary Customer field.

2. Click the other customer record'sSelect Secondary button
to display its customer information in theSecondary
Customer field.

3. Click theNot Duplicate Records button.

6. Click the tab'sClose button to close the screen.
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Manage Manually Identified Duplicate Customer
Records
Complete the following procedure tomanually identify duplicate customer records and either merge them into
a single record or permanently distinguish them from each other.

1. Navigate to theCustomer List screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectCustomer Admin > Customer List from themainmenu to display theCustomer List
screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Click the Toggle Merge button to displaymerge controls withPrimary Customer andSecondary
Customer fields on the right side of the screen.

3. Identify two customer recordswith similar information and determine their relationship:
l If both records are for the same customer, theymay bemerged into a single record. One will be
the Primary record (to be retained in the customer list) and the other will be the Secondary record
(to bemerged and removed).

l If each record is for a different customer, theymay be distinguished from each other.
4. Complete the appropriate procedure for the customer records:
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Merge Customer
Records

Complete the following procedure tomerge two records into a single
customer record.

1. Right-click the name of the Primary customer record to display
a list of options.

2. Click theSelect Primary Merge Customer option to add the
customer information to thePrimary Customer field.

3. Right-click the name of the Secondary customer record to
display a list of options.

4. Click theSelect Secondary Merge Customer option to add
the customer information to theSecondary Customer field.

5. Click theMerge Customer Records button to display the
Confirm Merge Operation screen.

6. Click theOK button to display amerge confirmation window.
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7. Click theClose button.

Distinguish
Customer Records

Complete the following procedure to establish two records as
distinct customer records.

1. Right-click one of the customer records to display a list of
options.

2. Click theSelect Primary Merge Customer option to add the
customer information to thePrimary Customer field.

3. Right-click the other customer record to display a list of
options.

4. Click theSelect Secondary Merge Customer option to add
the customer information to theSecondary Customer field.

5. Click theNot Duplicate Records button.

5. Click the tab'sClose button to close the screen.
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View the Best Customer List
1. Navigate to theBest Customer List screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectCustomer Admin > Best Customer List from themainmenu to display theBest
Customer List screen.

2. If needed, complete the following procedure tomodify the contents displayed in the list:
1. Complete any of these procedures to set list criteria:

l Select the desired department(s) from theSelected Departments drop-down field.
l Enter starting and ending dates in theDate Range fields to display results from that time
frame.

l Enter the preferred number of results in theRecord Count field to limit the list length.
2. Click theUpdate button to display the updated list.

Note: If needed, Sort and Filter Onscreen Data (see page 40).

3. Click the tab'sClose button to close the screen.
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View and Update the Customer Alias ID List
1. Navigate to theCustomer Alias ID Update screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectCustomer Admin > Alias ID Update from themainmenu to display theCustomer
Alias ID Update screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedure as needed:

Create/Edit an Alias
ID

1. Click a customer’sEdit Alias ID button to display theEdit
Alias ID window.

2. Enter a new alias ID in the field.
3. Click theOK button to close theEdit Alias ID window and

display the new alias ID in the customer’s record.
3. Click the tab'sClose button to close the screen.
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Set Up and Edit a Customer's House Account
1. Navigate to the customer'sHouse Account for screen.

1. Select a Customer (see page 113).

2. SelectCustomer Admin > House Account from themainmenu to display the customer's
House Account for screen.
Note: If the customer does not have a house account, the screen will display as shown below.

2. Complete the following procedures as appropriate tomanage house accounts:
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Create a House
Account

1. Click theCreate Account button to display an account limit
entry window.

2. Enter an account limit amount in the field.
3. Click theOK button to close the account limit entry window

and display the new house account on the customer'sHouse
Account for screen.

Edit the House
Account Limit

1. Enter a new account limit amount in theHouse Account
Limit field.

2. Click theUpdate Account button to display an update
confirmation window.

3. Click theClose button to remove the confirmation window.
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View a House
Account
Transaction's Details

1. Click a transaction to display itsTransaction Detail and
Payment Detail record.

2. Double-click the record to close it.

Close a House
Account

Note: If a house account has an outstanding balance, it cannot be
closed.

1. Click theClose Account button to display an update
confirmation window.
Note: If the house account has an outstanding balance, the
followingmessage displays:

Have the customer pay off the account before attempting to
close the account.

2. Click theYes button to close the confirmation window and
display a blankHouse Account for screen.

3. Click the tab'sClose button to close the screen.
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View the House Accounts Report
1. Navigate to theHouse Accounts Report screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectCustomer Admin > House Accounts Report from themainmenu to display the
House Accounts Report screen.

2. If desired, check the Include Zero Balances checkbox to display all house accounts.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

3. Click the tab'sClose button to close the screen.
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View the Deposits List
Complete the following procedure to view all active deposits. (TheDeposits List screen does not display
redeemed deposits.)

1. Navigate to theDeposits List screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectCustomer Admin > Deposits List from themainmenu to display theDeposits List
screen.

2. If needed, Sort and Filter Reporting Screen Data (see page 44).
3. Click the tab'sClose button to close the screen.
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View and Use a Customer’s Transactions History
1. Navigate to the customer'sTransactions for screen.

1. Select a Customer (see page 113).

2. SelectCustomer Admin > Transactions from themainmenu to display the customer's
Transactions for screen.

3. Enter starting and ending dates in theDate Range fields to display results from that time frame.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedures as appropriate tomanage the customer's transactions:

View a Transaction's
Details

1. Click a transaction to display itsTransaction Detail record.

2. Double-click the record to close it.
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Reprint a
Transaction's
Receipt

1. Click a transaction to display itsTransaction Detail record.

2. Click theReprint Receipt button to display an electronic copy
(PDF format) of the receipt.

3. Select the File > Save As option from themenu bar to display
theSave Aswindow.

4. Save and Print a Document (see page 48) to create electronic
and hardcopy versions of the receipt.

5. Double-click the record to close it.
3. Click the tab'sClose button to close the screen.
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View and Update a Customer’s Memberships
1. Navigate to the customer'sMemberships for screen.

1. Select a Customer (see page 113).

2. SelectCustomer Admin > Memberships from themainmenu to display the customer's
Memberships for screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedures as appropriate tomanage the customer'smemberships:

Update a
Membership
Expiration Date

1. Double-click amembership to display its expiration date entry
window.

2. Enter a new expiration date in the field (mm/dd/yyyy) or Select
a Date (see page 24) with the calendar button.

3. Click theOK button to close the date entry window.
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Suspend a
Membership

1. Click amembership to select it.

2. Click theSuspend Membership button to display the
Suspend Membershipwindow.

3. Enter the suspension period start date in theStart field
(mm/dd/yyyy) or Select a Date (see page 24) with the
calendar button.

4. Enter the suspension period end date in theEnd field
(mm/dd/yyyy) or Select a Date (see page 24) with the
calendar button.

5. Click theSubmit button to display a suspension confirmation
window.

6. Click theClose button to close the window and display the
membership's suspension dates on theMemberships for
screen.
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Reactivate a
Suspended
Membership

1. Click a suspendedmembership to select it.

2. Click theCancel Suspend button to display a cancellation
confirmation window.

3. Click theYes button to display a reactivation confirmation
window.

4. Click theClose button to close the window and remove the
membership's suspension dates from theMemberships for
screen.

3. Click the tab'sClose button to close the screen.
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View and Print a Customer’s Signed Waivers
1. Navigate to the customer'sSigned Waivers for screen.

1. Select a Customer (see page 113).

2. SelectCustomer Admin > Signed Waivers from themainmenu to display the customer's
Signed Waivers for screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedure as appropriate:

Print a Waiver

1. Click a waiver’sPrint Waiver button to display an electronic
copy (PDF format) of the waiver.

2. Select the File > Save As option from themenu bar to display
theSave Aswindow.

3. Save and Print a Document (see page 48) to create electronic
and hardcopy versions of the waiver.

3. Click the tab'sClose button to close the screen.
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View a Customer’s Layaways
1. Navigate to the customer'sLayaways for screen.

1. Select a Customer (see page 113).

2. SelectCustomer Admin > Layaways from themainmenu to display the customer's
Layaways for screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedure as appropriate:

View a Layaway's
Details

1. Click a layaway to display itsLayaway Detail record.

2. Double-click the record to close it.
3. Click the tab'sClose button to close the screen.
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View a Customer’s Product Holds
1. Navigate to the customer'sProduct Holds for screen.

1. Select a Customer (see page 113).

2. SelectCustomer Admin > Products on Hold from themainmenu to display the customer's
Product Holds for screen.

2. Click the tab'sClose button to close the screen.
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View and Update a Customer’s Special Orders
1. Navigate to the customer'sSpecial Orders for screen.

1. Select a Customer (see page 113).

2. SelectCustomer Admin > Special Orders from themainmenu to display the customer's
Special Orders for screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedures as appropriate tomanage the customer's special orders:

View a Special
Order's Details

1. Click a special order to display itsSpecial Order Detail
record.

2. Double-click the record to close it.
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Edit a Special
Order's Note

1. Click a special order'sEdit button to display a note entry
window.

2. Enter/edit text in the field.
3. Click theOK button to close the window and add the

new/revised text in the special order'sNotes field.
4. Double-click theSpecial Order Detail record to close it.

3. Click the tab'sClose button to close the screen.
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View a Customer’s Completed Work Orders
1. Navigate to the customer'sWork Orders for screen.

1. Select a Customer (see page 113).

2. SelectCustomer Admin > Work Orders from themainmenu to display the customer'sWork
Orders for screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedure as appropriate:

View a Work Order's
Details

1. Click a work order to display itsWork Order Detail record.

2. Double-click the record to close it.
3. Click the tab'sClose button to close the screen.
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Inventory Management
This section contains procedures to set up, edit, andmaintain products, product kits, license products,
attributes, alias UPCs, andQuick Pick categories aswell as procedures to apply taxes, print labels, set
temporarymin/max values, deactivate products, and reconcile inventory data with physical counts.

Product Information
Product Information includes a product's UPC, descriptions, statuses, identifiers, ordering data, prices, taxes,
attribute/descriptor combinations, and associated images.

l Manage Product Information (see page 149)

Inventory Data File Import
Inventory Data File Import simplifies the process of entering new items into the system by importing the data
directly from an Excel file.

l Import Inventory ItemData (see page 160)

Quick Picks
TheQuick Picks feature provides a category-limited, image-basedmethod for selecting products in the
Register application. This feature is especially useful for items that are difficult to tag (e.g., bait, targets, etc.).

l ManageQuick Pick Categories (see page 162)

Min/Max Levels
Min/Max Levels help ensure items are ordered and received efficiently to avoid out-of-stock and overstock
situations.

l Manage a Product’sMin/Max Levels (see page 165)
l Import Min/Max Levels (see page 168)

Seasonal Min/Max Settings
Seasonal Min/MaxSettings temporarily set minimumandmaximum inventory values (used with Auto
Ordering) for selected items for a defined period of time.

l Manage Seasonal Min/MaxValues (see page 170)

Taxes
l Update Tax Types for a Product (see page 173)

Product Kits
Product Kits are collections of individual products grouped together and sold as a single product.

l Manage Product Kits (see page 174)

Non-Stock Items
Non-Stock Items are items that are not physically stocked in inventory.
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l View and Edit Non-Stock Items (see page 179)

License Products Information
License Product Information includes the UPC, descriptions, price, vendor, andmandatory attributes for each
license (i.e., hunting) sold through the store.

l Manage License Types (see page 180)

Attributes and Descriptors
An Attribute is a broad category bywhich productsmay be identified and sorted. A Descriptor is a specific
value within an Attribute category that can be assigned to similar products to distinguish them from others.

l ManageMandatory Attributes (see page 91)
l View Descriptor Values for Mandatory Attributes (see page 182)
l Assign aMandatory Attribute to a Group of Products (see page 183)
l Assign an Attribute to a Group of Products (see page 185)

Serial Item (Non-Firearm) List
The Serial Item (Non-Firearm) List displays all serialized, non-firearm items including the acquisition date,
UPC, description, manufacturer, department, serial number, vendor, and, if applicable, the buyer and date
sold for each.

l View the Serial Number Report (see page 187)

Physical Inventory Stocktaking Counts
Physical Inventory Counts provide ameans of reconciling Quantity on Hand valueswith actual, physical
inventory in the store/warehouse through counting and identifying discrepancies.

l Perform a Physical Inventory Count for Non-Firearm Items (see page 188)
l Import Inventory Stocktaking Data (see page 193)
l Perform a Physical Inventory Count for Firearms (see page 250)
l View theGroup History Report (see page 198)
l View the Product Stock Adjustment Report (see page 200)
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Manage Product Information
1. Navigate to theProduct Maintenance screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Inventory Management > Product Maintenance from themainmenu to display the
Product Maintenance screen.

3. Select onscreen options to determine what products are displayed on the screen:
l Check theClick to show inactive products checkbox to display all active and inactive
products.

l Click anAttribute button and one of its associatedDescriptor buttons to display only
matching products. (Repeat as needed to further restrict products with additional
attributes and descriptors.)

l Click theDelete button beside an attribute/descriptor combination to remove them.
l Click theClear button to remove all attribute/descriptor combinations.

2. Complete the following procedures as needed tomanage product information:
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Add a Product

1. Click theAdd Product button to display a blankProduct
Editwindow.

2. Continue with the procedure below.

Clone a Product 1. Check a product’s checkbox to select it.

2. Click theClone Product button to display a copy of the
product’sProduct Editwindow.

3. Enter the UPC for the new (clone) product in theUPC field.
4. Continue with the procedure below.

Edit a Product 1. Check a product’s checkbox to select it.

2. Click theEdit Product button to display the product’s
Product Editwindow.

3. Continue with the procedure below.
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Bulk Edit a Group of
Products

1. Check a product’s checkbox to select it. (Repeat as needed to
select additional products, or click theSelect All button to
select all products on the screen.)

2. Click theBulk Edit button to display theBulk Edit Products
window.

3. Complete the following procedure to update a property for all
selected products:

1. Check the property’s checkbox.
2. Select a value from the corresponding drop-down field.
3. Repeat as needed to update values for other

properties.
4. Complete the following procedures as needed to determine

how tax typeswill be affected by this bulk edit:
l To update tax types for all selected products,

1. Check theCheck to include tax edits in this
edit checkbox.

2. Check a tax type’s Include/Exclude checkbox to
apply the tax to all selected products.

3. Uncheck a tax type’s Include/Exclude checkbox
to remove the tax from all selected products.

l To complete the bulk edit without changing the tax type
for any products, uncheck theCheck to include tax
edits in this edit checkbox.

5. Click theSubmit button to close theBulk Edit Products
window and update the products.

6. Click the tab'sClose button to close the screen.
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Deactivate
(/Reactivate) a
Product

A product that has been discontinued or is no longer carried for any
reasonmay be deactivated (marked as "inactive"). An inactive
product remains in the database (and can be reactivated if needed),
but it will not appear in product searches or reports.

1. Check a product’s checkbox to select it.

2. Click theEdit Product button to display the product’s
Product Editwindow.

3. Complete the following procedures as needed tomanage the
product's active status:

l To deactivate the product:

1. Click theDelete Product button to display a
confirmation screen.

2. Click theYes button to close the confirmation
screen and deactivate the item.

l To reactivate the product:
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1. Check theActive checkbox.
2. Click theSubmit button to reactivate the product

and close theProduct Editwindow.
4. Click the tab'sClose button to close the screen.
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Manage a Product's
Alias UPC

An Alias UPC (or Alternate UPC) allows a product to be identified
and associated with other products for various purposes. For
instance, a product packaged in a box is identical to the same
product in a blister pack, but each package has a unique UPC;
establish an Alias UPC for the different packages to share.

1. Check a product’s checkbox to select it.

2. Click theAlias UPCs button to display theManage
Alternate UPC Numberswindow.

3. Complete the following procedures as needed tomanage the
product's alias UPC(s):

l To add an alias UPC to the product:

1. Enter the alias UPC in theAdd Alternative
UPC field.

2. Click theAdd button to add the alias UPC to the
Alternate UPC list.

3. Click theClose button to close theManage
Alternate UPC Numberswindow.

l To remove an alias UPC from the product:

1. Click an alias UPC’sDelete button to remove it
from theAlternate UPC list.

2. Click theClose button to close theManage
Alternate UPC Numberswindow.

4. Click the tab'sClose button to close the screen.
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Print Labels for a
Product or Group of
Products

1. Check a product’s checkbox to select it. (Repeat as needed to
select additional products, or click theSelect All button to
select all products on the screen.)

2. Click thePrint Labels button to display a number entry
screen.

3. Enter the number of labels to print in the field.
4. Click theOK button to print the labels.
5. Click the tab'sClose button to close the screen.

3. Enter/edit Product information in theProduct Info section:
Note: Required fields and settings are displayed with red borders.

Active Check the checkbox tomark the item as active andmake it available for
search and selection in theRegister application.

Is Firearm Check the checkbox tomark the item as a firearm.
Serialized Non-Firearm Check the checkbox tomark the item as a serial non-firearm and

require a serial number to receive or sell it.
Is Stock Item Check the checkbox tomark the item as a physical item that can be

inventoried and sold.
Product UPC Enter the product's UPC code.
Manufacturer Ref # Enter themanufacturer’s stock number for the item.
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Receipt Description Enter a concise item description (30 charactersmaximum) to be shown
on labels and customer receipts.

Item Description Enter a lengthy item description (80 charactersmaximum) to be shown
on information screens in theRegister application.
Note: If an item has been automatically added to the system by a
vendor, a description beginning with "AUTO" displays in this field. Feel
free to remove the "AUTO" andmodify the description as needed.

Register Lookup
Description

This field automatically populates for AcuSport items. The field may be
left blank for Non-AcuSport items.

Auto Order l SelectA (automatic) to let the system automatically order the
item tomaintain inventory levels (as defined by theMin Level
andMax Level values).

l SelectN (normal) to retain standard ordering procedures for this
item.

Note: The Auto Order feature is available only to AcuSport Exchange
retailers.

Min/Max Type Select amin/max type (Suggested,Manual, orAutomatic) to modify
the product'sMin/Max Type designation on the Inventory Level
screen.

Current Min Level Enter/edit a value tomodify the product'sCurrent Min value on the
Inventory Level screen.
If the item's inventory level drops below theminimum, the system can
calculate the number of items needed to restock the item to theMax
Level value. For example, after a big sale, an item having aMin Level
of 3 and aMax Level of 10 has only 2 items remaining in inventory. The
system recognizes that inventory is below theminimum level and
calculates that 8 (10-2) need to be ordered to bring the item inventory
to themaximum level.
IfAuto Order is activated for the item, the system automatically
recognizes these shortages and orders items accordingly.
Min/Max calculations are also used to generate suggested ordering
quantities whenmanually creating a vendor-specific purchase order.
Refer to Create a Vendor PurchaseOrder (see page 353) for more
information.

Current Max Level Enter/edit a value tomodify the product'sCurrent Max value on the
Inventory Level screen.

Suggested Min Level The field displays the product'sSuggested Min value as shown on the
Inventory Level screen.

Suggested Max Level The field displays the product'sSuggested Max value as shown on
the Inventory Level screen.

Price Enter/edit the standard price for the item as needed.
Note: If no price is entered, the itemwill ring up for $0.00 in the
Register application.

Last Cost Edit the last cost for the item as needed.
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Avg Cost Edit the average cost for the item as needed.
QoH The field displays the product's quantity on hand.
Adjust QoH Edit the quantity on hand for the item as needed.

Note: TheAdjust QoH field should not be used with firearms or
serialized nonfirearm items.

On Order The field displays the quantity of the product that is on order.
Excluded On Order The field displays the quantity of the product that is on order but is not

included in QoH calculations.

4. Complete theProduct Tax Info section to apply tax types to the item:
1. Select the appropriate tax for the item from the drop-down field.

Note: If the required tax type is not available, completeManage Tax Types (see page 321) to
create it.

2. Click theAdd Product Tax button to display the selected tax in the list.
3. Repeat as needed to add additional taxes.

5. Complete theProduct Attribute Descriptor section:
1. Select an attribute from the firstAdd/Edit Attribute Descriptor drop-down field.
2. Select a descriptor from the secondAdd/Edit Attribute Descriptor drop-down field.
3. Click theUpdate A/D button to display the selected attribute/descriptor combination in the list.
4. Repeat as needed to add additional attribute/descriptor combinations.

Note: A descriptor must be selected for eachmandatory attribute. Refer to ManageMandatory
Attributes (see page 91) for more information.

6. Complete theProduct Image section:
l To add an image of the product to theQuick Picks screen,

1. Click theSelect Image button under theQuick Pick Image field to display anOpen
window.

2. Browse to the desired location and double-click the appropriate file (.png or .jpg format) to
display it in theQuick Pick Image field.

l To add an image of the product to theRegister Lookup screen,
1. Click theSelect Image button under theRegister Lookup Image field to display an

Openwindow.
2. Browse to the desired location and double-click the appropriate file (.png or .jpg format) to

display it in theRegister Lookup Image field.
7. Complete theProduct Price Info section:

1. Select price type from the drop-down (first) field.
Note: If the required price type is not available, refer to Manage Price Types (see page 320) to
create it.

2. Enter a price in the second field.
3. Click theAdd/Update Product Price button to display the price in the list..
4. Repeat as needed to add additional price types.

8. If desired, click theVendor Product tab to display it and complete any of the following procedures:
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Add a Vendor Product
Detail record for this UPC

1. Click theAdd button to display the UPC'sVendor Product
Detailwindow.

2. Enter/edit the information in the fields:

Vendor Select a vendor from the drop-down.
Vendor Part # Enter the vendor’s part number for the

product.
Catalog Cost Enter the product’s cost from the vendor’s

catalog.
Vendor
Priority

Select the vendor’s relative rank (1-5) among
possible vendors of this product from the
drop-down.

Sell Pack Enter theminimumnumber (generally 1) of
the product that can be purchased.

3. Click theSubmit button to create a vendor part number for
the product.
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Delete a Vendor Product
Detail record for this UPC

1. Check aVendor Product Detail record’s checkbox to select
it.

2. Click theDelete button to display a deletion confirmation
window.

3. Click theOK button to close the window and remove the
record from the screen.

Control the behavior of this
UPC's Vendor Product
Detail window

Check /uncheck theDisable Vendor Product Details Pop-up for
this product checkbox as desired:

l Check the checkbox to prevent the window from displaying in
the future.

l Uncheck the checkbox to allow the window to display in the
future.

9. If desired, click theSales Analysis tab to display it and complete any of the following procedures:

Display case UPC or unit
UPC data

l If the tab displays aCase UPC field, click the field to display
theSales Analysis tab for the associated case UPC.

l If the tab displays aUnit UPC field, click the field to display the
Sales Analysis tab for the associated unit UPC.

Adjust lead time Enter/edit the value in the Lead Time (Days) field to display its
effect on calculations.
Note: This adjustment is only temporary. To change the value
permanently, modify the value of the Lead Time Days field on the
vendor'sVendor Information for screen. Refer to Set Up and
Maintain a Vendor Record (see page 338) for more information.

Modify min/max levels l Enter/edit the value in theMIN field to update the product's
Current Min value on the Inventory Level screen.

l Enter/edit the value in theMAX field to update the product's
Current Max value on the Inventory Level screen.

10. Click theSubmit button to add/update the product on theProduct Maintenance screen.
11. Click the tab'sClose button to close the screen.
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Import Inventory Item Data
Complete the following procedure to import item data into the inventory by creating, populating, and importing
a formatted Excel file.

1. Navigate to theExcel Import screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. Select Inventory Management > Excel Import from themainmenu to display theExcel
Import screen.

2. Complete the following for each tax type listed in the Tax Name column:
Note: If an item being imported already exists in the database, the item's tax settingswill be updated to
reflect the tax options selected here.

l If the tax type will be applied to the items being imported, check the tax type's Include/Exclude
checkbox.

l If the tax type will not be applied to the items being imported, uncheck the tax type's
Include/Exclude checkbox.

3. Complete one of the following procedures to export a template format to an Excel file.
l Click the Template button to export an unpopulated template.

l Click the Template with System Data button to export a template populated with all item data
from the system.

4. Populate the Excel file with item information.
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Note: The file must adhere to the validation requirements indicated in row 1 andmay not contain
duplicate UPCs.

5. Save the Excel file.
6. Click theSelect Excel File to Import button on theExcel Import screen to display the Load Excel

Importwindow.

7. Browse to the desired location.
8. Double-click the saved Excel file to select it and start the import process.
9. If the system detects any errors, it displays the Import Complete with Errorswindow.

Complete any of the following as needed:
l Click thePrint/Save button to display the errors in a formatted template file that may be
manually printed and/or saved. Click another button as appropriate to close this window.

l Click theContinue button to continue with the import for the uploaded items.
l Click theCancel button to cancel the import.

10. When the import is complete, the system displays theUpload Completewindow.

11. Click theClose button to close the window.
12. Click the tab'sClose button to close the screen.
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Manage Quick Pick Categories
Note: RTG recommends having nomore than 12Quick Pick categories.

1. Navigate to theQuick Pick Setup screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. Select Inventory Management > Quick Pick Setup from themainmenu to display theQuick
Pick Setup screen.

2. Complete the following procedures as needed tomanageQuick Pick categories:

Create a Quick Pick
Category

1. Click theAdd button under theCategory list to display the
new category entry window.

2. Enter a name for the category in theCategory field.
3. Click theOK button to add the category to theCategory list.
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Add a Product to a
Quick Pick Category

1. Click a category in theCategory list to display its contents on
the screen.

2. Click theAdd button in the contents section to display the
Product Searchwindow.

3. Select One or More Products (see page 28) to be added to the
category and displayed on theQuick Pick Setup screen.

Edit a Product's
Quick Pick Image

1. Click a category in theCategory list to display its contents on
the screen.

2. Double-click a product in the contents section to display its
Product Editwindow.

3. Click theSelect Image button under theQuick Pick Image
field to display anOpenwindow.

4. Browse to the desired location and double-click the
appropriate file (.png or .jpg format) to display it in theQuick
Pick Image field.

5. Click theSubmit button to add the image to theQuick Pick
Setup screen.
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Remove a Product
from a Quick Pick
Category

1. Click a category in theCategory list to display its contents on
the screen.

2. Click a product in the contents section to select it.

3. Click theDelete button in the contents section to display a
deletion confirmation window.

4. Click theYes button to close the window and remove the
product from theQuick Pick Setup screen.

Delete a Quick Pick
Category

1. Click a category in theCategory list to display its contents on
the screen.

2. Click theDelete button under theCategory list to display a
deletion confirmation window.

3. Click theYes button to close the window and remove the
category from theQuick Pick Setup screen.

3. Click the tab'sClose button to close the screen.
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Manage a Product’s Min/Max Levels
Complete the following procedure to control themethod bywhich an item'smin/max levels are set and adjust
these levels as needed.

1. Navigate to the Inventory Level screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. Select Inventory Management > Inventory Level from themainmenu to display the
Inventory Level screen.

2. If desired, select a vendor from theVendor drop-down to display only items associated with that
vendor. (Click theSelect All vendor name to display items from all vendors.)
Note: If an item is linked to a case UPC, the case UPC will display on the screen and the unit UPC will
not.

3. Select one of the following options from theMin/Max Type drop-down to display items that utilize the
correspondingmethod to set min/max levels.

l Suggested: The system calculates and displaysSuggested Min andSuggested Max values,
and the user can update theCurrent Min andCurrent Max values by accepting the calculated
values or manually entering new values.

l Manual: Thismethod is useful for items that may not benefit from routinemin/maxmaintenance
as they are seasonal, hard-to-get, or otherwise unusual. It functions just like theSuggested
method.

l Automatic: The system automatically resetsCurrent Min andCurrent Max values tomatch
suggested valueswhen they are calculated.

4. Sort and Filter Reporting Screen Data (see page 44) as desired.
5. Complete the following procedures as needed tomanagemin/max levels:
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View an Item's Sales
Data

1. Click an item'sDetails button to display itsSales Analysis
tab in theProduct Editwindow.

2. Complete any of the following procedures as desired:
l Enter/edit the value in the Lead Time (Days) field to
display its effect on calculations.
Note: This adjustment is only temporary. To change
the value permanently, modify the value of the Lead
Time Days field on the vendor'sVendor Information
for screen. Refer to Set Up andMaintain a Vendor
Record (see page 338) for more information.

l Enter/edit the values in theMIN andMAX fields to
update the product'sCurrent Min andCurrent Max
values (respectively) on the Inventory Level screen.

l Click theProduct Edit tab to display it andmodify
values.

Note: Refer to Manage Product Information (see page 149)
for more information.

3. Click theSubmit button to close theProduct Editwindow.
4. Complete either of the following to display the updated

information on the Inventory Level screen
l Close and reopen the Inventory Level screen.
l Click theSubmit button to display a change
confirmation window and click the window'sOK button
to close it.
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Adjust an Item's
Min/Max Levels to
Suggested Values

Note: This feature is not available whenAutomatic is selected in
theMin/Max Type drop-down.

1. Locate theAdjust to Suggested column in the list.
2. Complete the following procedures as needed to select the

item(s) that will be adjusted:
Note:When an item is selected, the values in itsCurrent Min
andCurrent Max cells will temporarily change tomatch the
values in itsSuggested Min andSuggested Max cells
(respectively)

l Check an item’sAdjust to Suggested checkbox to
select it.

l Uncheck an item’sAdjust to Suggested checkbox to
deselect it.

l Check theAdjust to Suggested checkbox in the
column header to select all items.

l Uncheck theAdjust to Suggested checkbox in the
column header to deselect all items.

3. Click theSubmit button to display a change confirmation
window.

4. Click theOK button to close the window and update the
screen.

Change an Item's
Min/Max Type

1. Locate themin/max type (Suggested,Manual, and
Automatic) columns in the list.

2. Complete the following procedures as needed to select the
item(s) that will be changed:

l Click an item’smin/max type radio button to select that
type for the item.

l Check amin/max type column header's checkbox to
select that type for all items.

l Click the dash (-)in amin/max type column header's
checkbox to revert the selected items in that column to
their original setting.

3. Click theSubmit button to display a change confirmation
window.

4. Click theOK button to close the window and update the
screen.
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Import Min/Max Levels
Complete the following procedure to import min/max data into the system by creating, populating, and
importing a formatted Excel file.

1. Navigate to theMin/Max Import screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. Select Inventory Management > Min/Max Import from themainmenu to display theMin/Max
Import screen.

2. Click theExport to Excel button to export the template format to an Excel file.

3. Populate the Excel file with min/max information.
4. Save the Excel file.
5. Navigate to theMin/Max Import screen.

6. Click the Import from Excel button to display the Load Excel Importwindow.
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7. Browse to the desired location.
8. Double-click the saved Excel file to select it and start the import process.
9. If the system detects any errors, it displays the Import Complete with Errorswindow.

Complete any of the following as needed:
l Click thePrint/Save button to display the errors in a formatted template file that may be
manually printed and/or saved. Click another button as appropriate to close this window.

l Click theContinue button to continue with the import for the uploaded items.
l Click theCancel button to cancel the import.

10. When the import is complete, the system displays theUpload Completewindow.

11. Click theClose button to close the window.
12. Click the tab'sClose button to close the screen.
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Manage Seasonal Min/Max Values
1. Navigate to theSeasonal Min/Max screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Inventory Management > Seasonal Min/Max from themainmenu to display the
Seasonal Min/Max screen.

2. Complete the following procedures as needed tomanage seasonal minimumandmaximum values:

Create a New
Seasonal Min/Max
Period

1. Click theCreate New Seasonal Min/Max button to display
theDefine/Edit Product Pricing Seasonwindow.

2. Continue with the procedure below.

Edit a Seasonal
Min/Max Period

1. Click a season’sEdit button to display itsDefine/Edit
Product Pricing Seasonwindow.

2. Continue with the procedure below.
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Add a Product to a
Seasonal Min/Max
Period

1. Click a season to display itsSeasonal Min/Max Products
record.

2. Click theAdd Products button to display theProduct
Searchwindow.

3. Complete any of these procedures to limit the number of
products shown:

l Enter all or part of a product’s description in the
Description field.

l Enter all or part of a product’s UPC code number in the
UPC field.

l Click anAttribute button and one of its associated
Descriptor buttons. (Repeat as needed to further
restrict products with additional attributes and
descriptors.)

l Click theClear button to remove all Attribute/Descriptor
filters.

4. Complete any of these procedures to select the desired
product(s):

l Check a product’s checkbox to select it.
l Uncheck a product's checkbox to deselect it.
l Click theSelect All button to select all products.
l Click theUnselect All button to deselect all products.

5. Enter aminimumquantity in theMin field.
6. Enter amaximumquantity in theMax field.
7. Click theAdjust button to add the selected product(s) to the

Seasonal Min/Max Productswindow.
8. Double-click theSeasonal Min/Max Products record to

close it.
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Edit a Product's
Seasonal Min/Max
Values

1. Click a season to display itsSeasonal Min/Max Products
window.

2. Click a product’sEdit button to display itsEdit Min/Max
window.

3. Edit theminimumquantity in theMin field.
4. Edit themaximumquantity in theMax field.
5. Click theSubmit button to display updated quantity levels in

theSeasonal Min/Max Productswindow.
6. Double-click theSeasonal Min/Max Productswindow to

close it.
7. Click the tab'sClose button to close the screen.

Remove a Product
from a Seasonal
Min/Max Period

1. Click a season to display itsSeasonal Min/Max Products
window.

2. Click a product’sDelete button to display a deletion
confirmation window.

3. Click theYes button to close the window and remove the
product from theSeasonal Min/Max Productswindow.

4. Double-click theSeasonal Min/Max Productswindow to
close it.

5. Click the tab'sClose button to close the screen.

Delete a Seasonal
Min/Max Period

1. Click a season’sDelete button to display a deletion
confirmation window.

2. Click theYes button to close the window and remove the
season from theSeasonal Min/Max screen.

3. Click the tab'sClose button to close the screen.

3. Enter/edit Seasonal Min/Max information in the window.
Note: Required fields and settings are displayed with red borders.

Season Name Enter a name for the seasonal period.
Start Month Select themonth in which the season starts.
Start Day Enter the date (e.g., 29) on which the season starts.
End Month Select themonth in which the season ends.
End Day Enter the date (e.g., 29) on which the season ends.

4. Click theSubmit button to add/update the season on theSeasonal Min/Max screen and display its
Seasonal Min/Max Productswindow.

5. Complete procedures toAdd a product, Edit a product's Min/Max values, orRemove a product
as needed.

6. Click the tab'sClose button to close the screen.
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Update Tax Types for a Product
1. Navigate to theProduct Tax screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Inventory Management > Product Taxes from themainmenu to display theProduct
Tax screen.

2. Locate the product requiring an update and complete the following procedures as needed:
l To apply a tax type to the product, check the product checkbox associated with the tax type.
l To remove a tax type from a product, uncheck the product checkbox associated with the tax
type.

3. Repeat steps as needed to update taxes for additional products.
4. Click theSubmit button to complete the tax type update and close the screen.
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Manage Product Kits
1. Navigate to theProduct Kit Maintenance screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Inventory Management > Product Kit Maintenance from themainmenu to display
theProduct Kit Maintenance screen.

2. Complete the following procedures as needed tomanage product kits:

Create a Product Kit

1. Click theAdd Product Kit button to display theProduct
Editwindow.

2. Continue with the procedure below.
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Edit a Product Kit

1. Click a product kit'sEdit button to display itsProduct Edit
window.

2. Continue with the procedure below.

Add a Product to a
Kit

1. Click a product kit to display itsProduct Kit Items record.

2. Click theAdd Kit Item button to display theProduct Search
window.

3. Select a Single Product (see page 27) to display theEnter
Quantitywindow.

4. Enter the quantity of this product to include in the kit in the
Enter Quantity field.

5. Click theOK button to close the window.
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Edit a Product
Quantity in a Kit

1. Click a product kit to display itsProduct Kit Items record.

2. Click a product’sEdit Quantity button to display itsEnter
Quantitywindow.

3. Edit the quantity of this product to include in the kit in theEnter
Quantity field.

4. Click theOK button to close the window.

Delete a Product
from a Kit

1. Click a product kit to display itsProduct Kit Items record.

2. Click a product’sDelete button to display a deletion
confirmation window.

3. Click theYes button to close the window and remove the
product from theProduct Kit Itemswindow.

Delete a Product Kit

1. Click a product kit’sDelete button to remove it from the
Product Kits screen.

2. Click the tab'sClose button to close the screen.

3. Enter/edit Product information in theProduct Info section:
Note: Required fields and settings are displayed with red borders.

Active Check the checkbox tomark the kit as active andmake it available for
search and selection in theRegister application.

Is Firearm Check the checkbox tomark the kit as a firearm.
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Serialized Non-Firearm Check the checkbox tomark the kit as a serial non-firearm and require
a serial number to receive or sell it.

Is Stock Item Check the checkbox tomark the kit as a physical item that can be
inventoried and sold.

Product UPC Enter the kit’s UPC code.
Item Number Enter a stock number for the item.
Receipt Description Enter a concise kit description (30 charactersmaximum) to be shown

on labels and customer receipts.
Item Description Enter a lengthy kit description (80 charactersmaximum) to be shown

on information screens in theRegister application.
Note: If an item has been automatically added to the system by a
vendor, a description beginning with "AUTO" displays in this field. Feel
free to remove the "AUTO" andmodify the description as needed.

Price Enter the standard price for the kit.
Note: If no price is entered, the kit will ring up for $0.00 in theRegister
application.

Register Lookup
Description

This field automatically populates for AcuSport items. The field may be
left blank for Non-AcuSport items.

4. Complete theProduct Tax Info section to apply tax types to the item:
1. Select the appropriate tax for the item from the drop-down field.

Note: If the required tax type is not available, completeManage Tax Types (see page 321) to
create it.

2. Click theAdd Product Tax button to display the selected tax in the list.
3. Repeat as needed to add additional taxes.

5. Complete theProduct Attribute Descriptor section:
1. Select an attribute from the firstAdd/Edit Attribute Descriptor drop-down field.
2. Select a descriptor from the secondAdd/Edit Attribute Descriptor drop-down field.
3. Click theUpdate A/D button to display the selected attribute/descriptor combination in the list.
4. Repeat as needed to add additional attribute/descriptor combinations.

Note: A descriptor must be selected for eachmandatory attribute. Refer to ManageMandatory
Attributes (see page 91) for more information.

6. Complete theProduct Image section:
l To add an image of the product to theQuick Picks screen,

1. Click theSelect Image button under theQuick Pick Image field to display anOpen
window.

2. Browse to the desired location and double-click the appropriate file (.png or .jpg format) to
display it in theQuick Pick Image field.

l To add an image of the product to theRegister Lookup screen,
1. Click theSelect Image button under theRegister Lookup Image field to display an

Openwindow.
2. Browse to the desired location and double-click the appropriate file (.png or .jpg format) to

display it in theRegister Lookup Image field.
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7. Complete theProduct Price Info section:
1. Select price type from the drop-down (first) field.

Note: If the required price type is not available, completeManage Price Types (see page 320) to
create it.

2. Enter a price in the second field.
3. Click theAdd/Update Product Price button to display the price in the list..
4. Repeat as needed to add additional price types.

8. Click theSubmit button to add the kit to theProduct Maintenance screen.
9. Click the tab'sClose button to close the screen.
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View and Edit Non-Stock Items
1. Navigate to theNon-Stock Items screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Inventory Management > Non-Stock Items from themainmenu to display theNon-
Stock Items screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedure as needed to edit a non-stock item:

Edit a Non-Stock
Item

1. Click an item’sEdit button to display itsProduct Edit
window.

2. Enter/edit information in this window as appropriate.
Note: Refer to Manage Product Information (see page 149)
for information on completing the sections of this window.

3. Click theSubmit button to update the item on theNon-Stock
Items screen.
Note: If the itemwas changed to a stock item or set to inactive
status, it will not display on theNon-Stock Items screen.

3. Click the tab'sClose button to close the screen.
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Manage License Types
Complete the following procedure to set up andmaintain licenses in the product database.

1. Navigate to the License Maintenance screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. Select Inventory Management > License Maintenance from themainmenu to display the
License Maintenance screen.

2. Complete the following procedures as needed tomanage license types:

Create a New
License Type

1. Click theCreate New License Type button to display the
Define/Edit License Productwindow.

2. Continue with the procedure below.

Edit a License Type 1. Click a license’sEdit button to display itsDefine/Edit
License Productwindow.

2. Continue with the procedure below.
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Delete a License
Type

1. Click a license’sDelete button to display a deletion
confirmation window.

2. Click theYes button to close the window and remove the
license from the License Maintenance screen.

3. Click the tab'sClose button to close the screen.

3. Enter/edit License Product information in the window.
Note: Required fields and settings are displayed with red borders.

Receipt Description Enter a concise item description (30 charactersmaximum) to be shown
on labels and customer receipts.

Item Description Enter a lengthy item description (80 charactersmaximum) to be shown
on information screens in theRegister application.

Register Lookup
Description

This field automatically populates for AcuSport items. The field may be
left blank for Non-AcuSport items.

Price Enter the standard price for the item.
Note: If no price is entered, the itemwill ring up for $0.00 in the
Register application.

Select Vendor Select the license's vendor from the drop-down.
Select Manufacturer Select the license'smanufacturer from the drop-down.
Select Department Select the license's department attribute descriptor from the drop-

down.
Select Item Select the license's item attribute descriptor from the drop-down.

4. Click theSubmit button to add/update the license on the License Maintenance screen.
5. Click the tab'sClose button to close the screen.
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View Descriptor Values for Mandatory Attributes
1. Navigate to theMandatory Product Attribute Descriptor Values screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Inventory Management > Mandatory PADs from themainmenu to display the
Mandatory Product Attribute Descriptor Values screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. If a product has amissing or incorrect attribute/descriptor combination, click the product to display its
Product Editwindow.
Note: Refer to Manage Product Information (see page 149) for information about assigning
attribute/descriptor combinations.

3. Click the tab'sClose button to close the screen.

182 - InventoryManagement AXIS™ Retail Management System



Assign a Mandatory Attribute to a Group of Products
1. Navigate to theRequired Attr/Desc Mass Define screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Inventory Management > Required Attr/Desc Mass Define from themainmenu to
display theRequired Attr/Desc Mass Define screen.

2. Use onscreen controls as needed to determine what products are displayed on the screen:
l Scroll to view the entire list of products.
l Enter all or part of an product’s description in theProduct Description Search field to display
onlymatching products.

l Clear the text from theProduct Description Search field to display all products as originally
shown.

3. Complete any of these procedures to select the desired product(s):
l Check a product’s checkbox to select it.
l Uncheck a product's checkbox to deselect it.
l Click theSelect All button to select all products.
l Click theDeselect All button to deselect all products.
l Click theClear Selections button to deselect all products.

4. Complete the following procedures as needed to updatemandatory attributes for selected product(s):
l Select a descriptor from theManufacturer drop-down field or enter the name of a new
descriptor in the corresponding text entry field.

l Select a descriptor from the Item drop-down field or enter the name of a new descriptor in the
corresponding text entry field.

l Select a descriptor from theDepartment drop-down field or enter the name of a new descriptor
in the corresponding text entry field.
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Note: Be sure to spell and capitalize descriptor names correctly as they cannot be edited after entry.

5. Click theAdd Descriptors button to update all selected products.
6. Click the tab'sClose button to close the screen.

184 - InventoryManagement AXIS™ Retail Management System



Assign an Attribute to a Group of Products
1. Navigate to theBulk Define Attr/Desc screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Inventory Management > Bulk Define Attr/Desc from themainmenu to display the
Bulk Define Attr/Desc screen.

2. Use onscreen controls as needed to determine what products are displayed on the screen:
l Scroll to view the entire list of products.
l Enter all or part of an product’s description in theProduct Description Search field to display
onlymatching products.

l Clear the text from theProduct Description Search field to display all products as originally
shown.

3. Complete any of these procedures to select the desired product(s):
l Check a product’s checkbox to select it.
l Uncheck a product's checkbox to deselect it.
l Click theSelect All button to select all products.
l Click theDeselect All button to deselect all products.
l Click theClear Selections button to deselect all products.

4. Complete either of these procedures to select the attribute to be set for all selected products:
l Select the attribute from theAttribute drop-down field.
l Enter the name of a new attribute in the corresponding text entry field.
Note: Be sure to spell and capitalize the attribute name correctly as it cannot be edited after
entry.

5. Complete either of these procedures to select the descriptor to be set for all selected products:
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l Select the descriptor from theDescriptor drop-down field.
l Enter the name of a new descriptor in the corresponding text entry field.
Note: Be sure to spell and capitalize the descriptor name correctly as it cannot be edited after
entry.

6. Click theSet Attributes button to update all selected products.
7. Click the tab'sClose button to close the screen.
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View the Serial Number Report
1. Navigate to theSerial Number Report screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Inventory Management > Serial Report from themainmenu to display theSerial
Number Report screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Click the tab'sClose button to close the screen.
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Perform a Physical Inventory Count for Non-Firearm
Items
Complete the following procedure to take a physical inventory count for select non-firearm inventory items. 
Note: A physical inventory count is essential for verifying Quantity on Hand values against actual, physical
inventory in the store/warehouse, identifying and accounting for discrepancies (due to theft, entry errors, etc.),
and ensuring resulting counts and values are accurate. A physical inventory count is not intended to be used
for initial entry of inventory which is new to the system.  Inventory values cannot be accurate without the cost
history captured through the Receiving process.

Note: Because this procedure does not capture or verify serial numbers, it is intended only for counting non-
serialized/non-firearm items.

1. Navigate to theProduct Inventory Stocktaking screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. Select Inventory Management > Inventory Stocktaking from themainmenu to display the
Inventory Groupswindow in front of theProduct Maintenance screen.

3. Complete one of the following procedures as appropriate to select the desired inventory group:
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Create a New
Inventory Group

1. Click theAdd New button to close the
Inventory Groupswindow and display the
Product Inventory Stocktaking screen.

2. Complete the following procedure as needed to
filter the items displayed on the screen with
attribute/descriptor combinations:

1. Click anAttribute button and one of its
associatedDescriptor buttons to filter
the items shown.

2. If needed, select another
attribute/descriptor combination to further
filter the list.
Note: To remove an unwanted filter
(attribute/descriptor combination), click its
Delete (redX) button in theSelected
Filters list.
To remove all filters, click theClear
Filters button so a new searchmay be
done.

3. Click theSave Filters button to display the
Please enter new group namewindow.

4. Enter a unique name for the inventory group in
theGroup Name field.
Note: Group namesmay not be reused.

5. Click theOK button to create the group and
close the Inventory Groupswindow.
TheProduct Inventory Stocktaking screen
will display the selected group name in the
Current Group Name: heading.

6. Continue with the procedure below.
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Select an
Existing
Inventory Group

1. Double-click an inventory group name to select
the group and close the Inventory Groups
window.
TheProduct Inventory Stocktaking screen
will display the selected group name in the
Current Group Name: heading.

2. Continue with the procedure below.

Delete an
Inventory Group

Note: An inventory stocktaking group can be deleted
from the Inventory Groupswindow if no other users
are actively logged into the group.

1. Click a group'sDelete button to display a
deletion confirmation window.
Note: If another user is logged into the group,
the systemwill display amessage indicating the
group cannot be deleted and why.

l If no counts have been entered for the
group's items, the system displays this
message:

l If any item counts have been entered for
the group, the system displays this
message:

2. Click theYes button to close the window and
remove the group from the list.
Note:When a group is deleted, its items are
once again available for inclusion in another
group.

3. Click the tab'sClose button to close the screen.
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2. For each item on the list, use either of the followingmethods to record an accurate count value in the
item'sStocktaking-NOW Count field:
Note: These count proceduresmay be performedwith a tablet, laptop with scanner, handheld PDA, or
an electronic device outside of the range of the server to be submitted when the device is back in range
with the server.

l Count the number of items in a location andmanually update the value in the field accordingly.
l Complete one of these procedures to identify a single item by its UPC and increase the value in
the field by one (1):

l Scan an item’s UPC code in theEnter or scan UPC number field and press theEnter
key.

l Enter the item’s UPC code in theEnter or scan UPC number field and press theEnter
key.

l Click in theEnter or scan UPC number field, click the number keys on the bottom of the
screen to enter the UPC code, and click theEnter button.

3. If needed, complete the following procedure to populate all emptyStocktaking-NOW Count and
Stocktaking-NOW Total Count fields with a value of zero (0):

1. Click the Zero Count button to display a confirmation window.

2. Click theYes button to populate every empty cell in theStocktaking-NOW Count and
Stocktaking-NOW Total Count columnswith a zero (0) quantity.

4. Review theStocktaking-NOW Loss/Gain field for each item on the list:
l If an item'sLoss/Gain field displays a positive or negative number, select the appropriate
loss/gain reason from the item'sStocktaking-NOW Loss/Gain Reason drop-down field.

l If an item'sLoss/Gain field displays a zero (0), the inventory count matches the previousQOH.
(No loss-gain reason is required.)

5. Complete the following procedure as needed to generate and view theVariance Report:
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Note: TheVariance Report displays a record of differences between theQuantity on Hand (QOH)
shown in the books and the quantities captured during a stocktaking procedure.

View the Variance
Report

1. Click theVariance Report button to display theVariance
Report in theReport Viewer window.

2. Review the report for issues that require attention or
correction and update stocktaking data on theProduct
Inventory Stocktaking screen as needed.

3. Continue with the procedure below.
Note:When theSubmit button is clicked, theVariance
Reportwill not display discrepancies between the count and
theQOH.

6. After all counts have been entered and loss/gains have been accounted for, click theSubmit button to
save all changes, and display a confirmation window.

7. Click theClose button to close the window and display the Inventory Groupswindow in front of the
Product Inventory Stocktaking screen.

8. Click theCancel button to close the window and the screen.
Note: To view or print the saved information, refer to View the Product Stock Adjustment Report (see
page 200).
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Import Inventory Stocktaking Data
Complete the following procedure to import stocktaking data into theProduct Inventory Stocktaking
screen by creating, populating, and importing a formatted Excel file.

1. Navigate to theProduct Inventory Stocktaking screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. Select Inventory Management > Inventory Stocktaking from themainmenu to display the
Inventory Groupswindow in front of theProduct Maintenance screen.

3. Complete one of the following procedures as appropriate to select the desired inventory group:
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Create a New
Inventory Group

1. Click theAdd New button to close the
Inventory Groupswindow and display the
Product Inventory Stocktaking screen.

2. Complete the following procedure as needed to
filter the items displayed on the screen with
attribute/descriptor combinations:

1. Click anAttribute button and one of its
associatedDescriptor buttons to filter
the items shown.

2. If needed, select another
attribute/descriptor combination to further
filter the list.
Note: To remove an unwanted filter
(attribute/descriptor combination), click its
Delete (redX) button in theSelected
Filters list.
To remove all filters, click theClear
Filters button so a new searchmay be
done.

3. Click theSave Filters button to display the
Please enter new group namewindow.

4. Enter a name for the inventory group in the
Group Name field.

5. Click theOK button to create the group and
close the Inventory Groupswindow.
TheProduct Inventory Stocktaking screen
will display the selected group name in the
Current Group Name: heading.

6. Continue with the procedure below.
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Select an
Existing
Inventory Group

1. Double-click an inventory group name to select
the group and close the Inventory Groups
window.
TheProduct Inventory Stocktaking screen
will display the selected group name in the
Current Group Name: heading.

2. Continue with the procedure below.

2. Right-click on the list to display anExport to Excel option.

3. Click theExport to Excel option to export the template format to an Excel file.

4. Populate the Excel file with stocktaking information.
Note: The file must adhere to the validation requirements indicated in row 1 and below:

l All UPC’smust be in the system database prior to upload.
l New countsmay be entered in theMy Count column.
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l Any entry in the Loss/Gain Reason columnmust exactlymatch one of the reasons defined on
the Loss/Gain Reasons screen. (SelectSetup > Loss/Gain Reasons to view this screen.)

5. Save the Excel file.
6. Click the Import button on theProduct Inventory Stocktaking screen to display the Load Excel

Importwindow.

7. Browse to the desired location.
8. Double-click the saved Excel file to select it and start the import process.
9. The system displays an amend/overwrite selection window.

10. Complete one of the following procedures to close this window:
Note: No quantities are entered into the system at this point.

l Click theAmend button to add the counts in the Excel file to any counts already displayed on the
Product Inventory Stocktaking screen.

l Click theOverwrite button to replace the counts displayed on theProduct Inventory
Stocktaking screen with the counts in the Excel file.

11. If the system detects any errors, it displays the Import Complete with Errorswindow.

Complete any of the following as needed:
l Click thePrint/Save button to print and save the list of invalid UPCswith Description andQty in
the original format and return to this screen.

l Click theContinue button to continue with the import for the uploaded items.
l Click theCancel button to cancel the import.

12. When the import is complete, the system displays theUpload Completewindow.
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13. Click theClose button to close the window.
14. Click the tab'sClose button to close the screen.
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View the Group History Report
Complete the following procedure to generate and view a record of inventory count group stocktaking counts.

1. Navigate to theStock Taking Groups screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. Select Inventory Management > Group History Report from themainmenu to display the
Stock Taking Groups screen.

3. Complete the following procedure to determine which group counts are displayed on the screen:
1. Enter starting and ending dates in theDate Range fields to define the time frame.
2. Click theSubmit button to display selected group counts.

2. Click theExecute Report (green arrow) button beside a group name to display the group's report in
theReport Viewer window.

3. Use the scroll bar(s) and or page controls as needed to view the entire report.
4. Complete the following procedures as appropriate:

Print the Report 1. Click thePrint button to display thePrintwindow.
2. Modify print options (e.g., select a different printer, adjust

settings, etc.) as needed.
3. Click thePrint button to print the document.

Save the Report as
an Electronic File

1. Click theExport button to display a drop-downmenu of
options.

2. Click the desired option (Excel, PDF, orWord) to display the
Save Aswindow.

3. Browse to the desired location.
4. If needed, edit the document name in the File name field.
5. Click theSave button to save the document.

5. Click theClose button to close theReport Viewer window.
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6. Click the tab'sClose button to close the screen.
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View the Product Stock Adjustment Report
1. Navigate to theProduct Stock Adjustment Report screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Inventory Management > Product Stock Adjustment Report from themainmenu to
display theProduct Stock Adjustment Report screen.

3. Select onscreen options to determine what products are displayed on the screen:
l Enter starting and ending dates in theDate Range fields to define the time frame..
l Sort and Filter Onscreen Data (see page 40).

2. Click the tab'sClose button to close the screen.
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Firearms Management
This section contains procedures to document the acquisition and disposition of firearms, maintain Bound
Books, perform firearm stocktaking, set up, maintain, and review range, lane, and waiver information, range
products and rentals, and an assortment of useful statistical reports on range usage.

Document Firearm Acquisitions and Dispositions
Firearm acquisitions and dispositionsmay be documented for sales, purchases, trades, thefts, transfers, and
consignments.

l Document a FirearmSale (see page 203)
l Document a FirearmPurchase (see page 205)
l Document a Firearm Trade (see page 207)
l Document a Firearm Theft (see page 209)

Firearm Transfers
l Document an Incoming Firearm Transfer (see page 211)
l Document anOutgoing Firearm Transfer (see page 213)
l Document an Interstore Firearm Transfer (see page 215)

Firearm Consignments
l Document an Incoming Consignment Firearm (see page 217)
l Document the Return of an Incoming Consignment Firearm (see page 219)
l View the Inbound Consignments Report (see page 221)

Bound Book Features
Bound Book Features include procedures to set firearm transfer dates, view and edit firearm tracking
(identification, acquisition, and disposition) information, print books (with or without audits), and view audit
logs for the bound books.

l Manage a Bound Book (see page 224)
l Import Bound BookData (see page 231)
l View a Bound Book Archive (see page 234)
l View the Bound Book Audit Log Report (see page 235)

Electronic 4473 Form Process
The Electronic 4473 Form provides a simple, interactive way for the retailer and customer to complete,
process, and update the 4473 forms needed for a firearm transaction.

l Oversee the Electronic 4473 FormProcess (see page 236)
l Start a 4473 Form for a Customer (see page 237)
l Fill Out the Customer Portion of an Electronic 4473 Form (see page 238)
l Process a 4473 Form (see page 239)
l Update a 4473 FormDisposition (see page 244)
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l View and Use a List of All 4473 Forms (see page 246)
l View and Use a List of Denied 4473 Forms (see page 247)
l Clear a FirearmHold (see page 248)

Firearm Labels
Firearm Labelsmay be printed for selected firearms (defined as a range of log numbers or transaction
numbers) in any desired quantity.

l Print Firearm Labels (see page 249)

Firearm Physical Inventory Counts
FirearmPhysical Inventory Counts are essential for verifying the physical presence of individual firearms in
the store/warehouse and should be performed regularly (preferably once every thirty days).

l Perform a Physical Inventory Count for Firearms (see page 250)

Firearm Taxes
A Firearm Tax is defined as a tax type that applies to firearms transactions, whether a standard product tax
type (e.g., state tax) or tax type created specifically for firearms.

l Manage a Firearm Tax (see page 251)

Firearm Reports
FirearmReports provide up-to-date records of firearm inventory levels and transactions available with or
without specific financial information.

l View the FirearmSalesReport (see page 252)
l View the Firearm TransactionsReport (see page 254)
l View and Update the Firearm InventoryWith Costs Report (see page 256)
l View the Firearm InventoryWithout Costs Report (see page 258)
l View and Update the Firearm Inventory Aging Report (see page 259)

3310 Forms Feature
The 3310 Forms Feature provides the ability to generate, review, and send 3310-4 and 3310-12 forms
(reportingmultiple firearm sales) to the ATF and state/local authorities.
By default, the system generates 3310 forms every day at 10:45 p.m. If needed, a 3310 formmay bemanually
generated, but this should only be done after business hours. For every day on which a 3310 form is
generated, the system collects all generated 3310 forms from that date in a corresponding folder in the
SharedPath on the AXIS server.

l Generate, View, and Print 3310-4 Forms (see page 261)
l Generate, View, and Print 3310-12 Forms (see page 263)
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Document a Firearm Sale
1. Navigate to the Firearm Sale screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Transactions > Sale from themainmenu to display the Firearm Sale
screen.

2. Complete this procedure to add buyer information:
1. Click theSelect Buyer button to display theCustomer Look-upwindow.
2. Select or Add a FirearmCustomer (see page 29).

Note: Be sure all customer information is correct. Incorrect customer informationmay create
errors in the Bound Book.

3. Complete this procedure if the transaction requires a transfer agent:
1. Click the Transfer Agent button to display the Transfer Agent Look-upwindow.
2. Select a Transfer Agent (see page 34).

4. Complete the following procedures as appropriate to add outgoing firearm information:
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Add an Outgoing
Firearm

1. Click theAdd Outgoing button to display the Firearm
Inventorywindow.

2. Select a Firearm from the Firearm InventoryWindow (see
page 36). (Repeat steps as needed to add additional
firearms.)

Edit an Outgoing
Firearm's Price

1. Click the firearm'sEdit button to display a new price entry
window.

2. Enter a new price in the field.
3. Click theOK button to display the updated price on the screen.

Remove an
Outgoing Firearm
from the Screen

Click the firearm'sDelete button to remove it from the screen.

5. Complete the remaining fields:
1. Enter the transaction date (mm/dd/yyyy) or Select a Date (see page 24) with the calendar button

in theSet Date field.
Note: This is the date of the transaction, not the date of the disposition.

2. Enter the NICS approval code in theNICS Approval Code field.
3. Enter the transaction serial number in the Transaction Serial Number field.
4. If needed, enter transaction notes in theNotes field.
5. If the transaction occurred at a gun show, select the gun show from theGun Show drop-down

field.
Note: If the gun show is not available in the drop-down, create it before completing this firearm
transaction. Refer to ManageGun Show Information (see page 76) for more information.

6. Click theSubmit button to send the transaction to the customer'sCurrent record in theRegister
application for processing and payments.
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Document a Firearm Purchase
1. Navigate to the Firearm Purchase screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Transactions > Purchase from themainmenu to display the Firearm
Purchase screen.

2. Complete this procedure to add seller information:
1. Click theSelect Seller button to display theCustomer Look-upwindow.
2. Select or Add a FirearmCustomer (see page 29).

Note: Be sure all customer information is correct. Incorrect customer informationmay create
errors in the Bound Book.

3. Complete the following procedures as appropriate to add incoming firearm information:
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Add an Incoming
Firearm

1. Click theAdd Incoming button to display the Firearm
Descriptionwindow.

2. Describe a Firearm (see page 37). (Repeat steps as needed
to add additional firearms.)

Edit an Incoming
Firearm's
Description

1. Click the firearm'sEdit button to display itsFirearm
Descriptionwindow.

2. Describe a Firearm (see page 37) as needed.

Remove an
Incoming Firearm
from the Screen

Click the firearm'sDelete button to remove it from the screen.

4. Complete the remaining fields:
1. Enter the transaction date (mm/dd/yyyy) or Select a Date (see page 24) with the calendar button

in theSet Date field.
Note: This is the date of the acquisition.

2. If needed, enter transaction notes in theNotes field.
3. If the transaction occurred at a gun show, select the gun show from theGun Show drop-down

field.
Note: If the gun show is not available in the drop-down, create it before completing this firearm
transaction. Refer to ManageGun Show Information (see page 76) for more information.

5. Click theSubmit button to send the transaction to the customer'sCurrent record in theRegister
application for processing and payments.
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Document a Firearm Trade
1. Navigate to the Firearm Trade screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Transactions > Trade from themainmenu to display the Firearm Trade
screen.

2. Complete this procedure to add buyer information:
1. Click theSelect Buyer button to display theCustomer Look-upwindow.
2. Select or Add a FirearmCustomer (see page 29).

Note: Be sure all customer information is correct. Incorrect customer informationmay create
errors in the Bound Book.

3. Complete this procedure if the transaction requires a transfer agent:
1. Click the Transfer Agent button to display the Transfer Agent Look-upwindow.
2. Select a Transfer Agent (see page 34).

4. Complete the following procedures as appropriate to add outgoing firearm information:

Add an Outgoing
Firearm

1. Click theAdd Outgoing button to display the Firearm
Inventorywindow.

2. Select a Firearm from the Firearm InventoryWindow (see
page 36). (Repeat steps as needed to add additional
firearms.)
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Edit an Outgoing
Firearm's Price

1. Click the firearm'sEdit button to display a new price entry
window.

2. Enter a new price in the field.
3. Click theOK button to display the updated price on the

screen.

Remove an
Outgoing Firearm
from the Screen

Click the firearm'sDelete button to remove it from the screen.

5. Complete the following procedures as appropriate to add incoming firearm information:

Add an Incoming
Firearm

1. Click theAdd Incoming button to display the Firearm
Descriptionwindow.

2. Describe a Firearm (see page 37). (Repeat steps as needed
to add additional firearms.)

Edit an Incoming
Firearm's
Description

1. Click the firearm'sEdit button to display itsFirearm
Descriptionwindow.

2. Describe a Firearm (see page 37) as needed.

Remove an
Incoming Firearm
from the Screen

Click the firearm'sDelete button to remove it from the screen.

6. Complete the remaining fields:
1. Enter the transaction date (mm/dd/yyyy) or Select a Date (see page 24) with the calendar button

in theSet Date field.
Note: This is the date of the transaction, not the date of the disposition.

2. Enter the NICS approval code in theNICS Approval Code field.
3. Enter the transaction serial number in the Transaction Serial Number field.
4. If needed, enter transaction notes in theNotes field.
5. If the transaction occurred at a gun show, select the gun show from theGun Show drop-down

field.
Note: If the gun show is not available in the drop-down, create it before completing this firearm
transaction. Refer to ManageGun Show Information (see page 76) for more information.

7. Click theSubmit button to send the transaction to the customer'sCurrent record in theRegister
application for processing and payments.

208 - FirearmsManagement AXIS™ Retail Management System



Document a Firearm Theft
1. Navigate to theStolen Firearm screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Transactions > Stolen Firearm from themainmenu to display theStolen
Firearm screen.

2. Complete the following procedures as appropriate to add stolen firearm information:

Add a Firearm 1. Click theAdd Firearms button to display the Firearm
Inventorywindow.

2. Select a Firearm from the Firearm InventoryWindow (see
page 36). (Repeat steps as needed to add additional
firearms.)

Edit a Firearm's
Price

1. Click the firearm'sEdit button to display a new price entry
window.

2. Enter a new price in the field.
3. Click theOK button to display the updated price on the

screen.

Remove a Firearm
from the Screen

Click the firearm'sDelete button to remove it from the screen.
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3. Complete the remaining fields:
1. Enter the theft date (mm/dd/yyyy) or Select a Date (see page 24) with the calendar button in the

Date of Theft field.
2. Enter the BATF incident number in theBATF Incident Number field.
3. Enter the Police incident number in thePolice Incident Number field.
4. If needed, enter notes in theNotes field.
5. If the transaction occurred at a gun show, select the gun show from theGun Show drop-down

field.
Note: If the gun show is not available in the drop-down, create it before completing this firearm
transaction. Refer to ManageGun Show Information (see page 76) for more information.

4. Click theSubmit button to send the transaction to the customer'sCurrent record in theRegister
application for processing and payments.
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Document an Incoming Firearm Transfer
1. Navigate to the Transfer In screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Transactions > Transfer > Transfer In from themainmenu to display the
Transfer In screen.

2. Complete the following procedures as appropriate to add the transferring party's information:

Transfer from a
Customer

1. Click theSelect Customer button to display theCustomer
Look-upwindow.

2. Select or Add a FirearmCustomer (see page 29).
Note: Be sure all customer information is correct. Incorrect
customer informationmay create errors in the Bound Book.

Transfer from a
Dealer

1. Click theSelect Dealer button to display theVendor Look-
upwindow.

2. Select a FirearmVendor (see page 32).

3. Complete the following procedures as appropriate to add incoming transfer firearm information:

Add an Incoming
Firearm

1. Click theAdd Transfer button to display the Firearm
Descriptionwindow.

2. Describe a Firearm (see page 37). (Repeat steps as needed
to add additional firearms.)
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Edit an Incoming
Firearm's
Description

1. Click the firearm'sEdit button to display itsFirearm
Descriptionwindow.

2. Describe a Firearm (see page 37) as needed.

Remove an
Incoming Firearm
from the Screen

Click the firearm'sDelete button to remove it from the screen.

4. Complete the remaining fields:
1. Enter the acquisition date (mm/dd/yyyy) or Select a Date (see page 24) with the calendar button

in theSet Date field.
Note: This is the date of the transaction, not the date of the disposition.

2. If needed, enter transaction notes in theNotes field.
5. Click theSubmit button to send the transaction to the customer'sCurrent record in theRegister

application for processing and payments.
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Document an Outgoing Firearm Transfer
1. Navigate to the Transfer Out screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Transactions > Transfer > Transfer Out from themainmenu to display
the Transfer Out screen.

2. Complete the following procedures as appropriate to add the transfer-receiving party's information:

Transfer to a
Customer

1. Click theSelect Customer button to display theCustomer
Look-upwindow.

2. Select or Add a FirearmCustomer (see page 29).
Note: Be sure all customer information is correct. Incorrect
customer informationmay create errors in the Bound Book.

Transfer to a Dealer 1. Click theSelect Dealer button to display theVendor Look-
upwindow.

2. Select a FirearmVendor (see page 32).

3. Complete the following procedures as appropriate to add outgoing transfer firearm information:

Add an Outgoing
Firearm

1. Click theAdd Outgoing button to display the Firearm
Inventorywindow.

2. Select a Firearm from the Firearm InventoryWindow (see
page 36). (Repeat steps as needed to add additional
firearms.)
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Edit an Outgoing
Firearm's Price

1. Click the firearm'sEdit button to display a new price entry
window.

2. Enter a new price in the field.
3. Click theOK button to display the updated price on the

screen.

Remove an
Outgoing Firearm
from the Screen

Click the firearm'sDelete button to remove it from the screen.

4. Complete the remaining fields:
1. Enter the transaction date (mm/dd/yyyy) or Select a Date (see page 24) with the calendar button

in theSet Date field.
Note: This is the date of the transaction, not the date of the disposition.

2. Enter the NICS approval code in theNICS Approval Code field.
3. Enter the transaction serial number in the Transaction Serial Number field.
4. If needed, enter transaction notes in theNotes field.

5. Click theSubmit button to send the transaction to the customer'sCurrent record in theRegister
application for processing and payments.
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Document an Interstore Firearm Transfer
1. Navigate to the Interstore Transfer Receive screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Transactions > Interstore Receive from themainmenu to display the
Interstore Transfer Receive screen.

2. Click theSelect Transfer button to display the Interstore Transferswindow.

3. Click a firearm to display its transfer record.
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4. Click theSubmit button to add transfer and firearm information to the Interstore Transfer Receive
screen.

5. Complete the following procedures as appropriate to add incoming transfer firearm information:

Edit an Incoming
Firearm's
Description

1. Click the firearm'sEdit button to display itsFirearm
Descriptionwindow.

2. Describe a Firearm (see page 37) as needed.

Remove an
Incoming Firearm
from the Screen

Click the firearm'sDelete button to remove it from the screen.

6. Complete the remaining fields:
1. Enter the acquisition date (mm/dd/yyyy) or Select a Date (see page 24) with the calendar button

in theSet Date field.
2. If needed, enter transaction notes in theNotes field.

7. Click theSubmit button to add the firearm to the receiving store's inventory.
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Document an Incoming Consignment Firearm
1. Navigate to the Inbound Consignment screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Transactions > Consignment > Inbound Consignment from themain
menu to display the Inbound Consignment screen.

2. Complete this procedure to add party information:
1. Click theSelect Party button to display theCustomer Look-upwindow.
2. Select or Add a FirearmCustomer (see page 29).

Note: Be sure all customer information is correct. Incorrect customer informationmay create
errors in the Bound Book.

3. Complete the following procedures as appropriate to add incoming firearm information:

Add an Incoming
Firearm

1. Click theAdd Incoming button to display the Firearm
Descriptionwindow.

2. Describe a Firearm (see page 37). (Repeat steps as needed
to add additional firearms.)

Edit an Incoming
Firearm's
Description

1. Click the firearm'sEdit button to display itsFirearm
Descriptionwindow.

2. Describe a Firearm (see page 37) as needed.

Remove an
Incoming Firearm
from the Screen

Click the firearm'sDelete button to remove it from the screen.
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4. Complete the remaining fields:
1. Enter the transaction date (mm/dd/yyyy) or Select a Date (see page 24) with the calendar button

in theSet Date field.
Note: This is the date of the transaction, not the date of the disposition.

2. If needed, enter transaction notes in theNotes field.
3. If the transaction occurred at a gun show, select the gun show from theGun Show drop-down

field.
Note: If the gun show is not available in the drop-down, create it before completing this firearm
transaction. Refer to ManageGun Show Information (see page 76) for more information.

5. Click theSubmit button to send the transaction to the customer'sCurrent record in theRegister
application for processing and payments.
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Document the Return of an Incoming Consignment
Firearm

1. Navigate to the Inbound Consignment Return screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. Select Firearms > Transactions > Consignment > Inbound Consignment Return from
themainmenu to display the Inbound Consignment Return screen.

2. Complete this procedure to add party information:
1. Click theSelect Party button to display theCustomer Look-upwindow.
2. Select or Add a FirearmCustomer (see page 29).

Note: Be sure all customer information is correct. Incorrect customer informationmay create
errors in the Bound Book.

3. Complete this procedure if the transaction requires a transfer agent:
1. Click the Transfer Agent button to display the Transfer Agent Look-upwindow.
2. Select a Transfer Agent (see page 34).

4. Complete this procedure to add firearm information:
1. Click theAdd Return button to display the Firearm Inventorywindow.
2. Complete one of the following procedures to select a firearm:

l Scan the firearm’s log number in theScan Log # here field and press theEnter key.
l Enter the firearm’s log number in theScan Log # here field and press theEnter key.
l Locate the firearm in the list and check itsSelect checkbox.

3. Repeat steps as needed to reattempt a failed selection and/or select additional firearms.
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4. Click theSubmit button.
Note: If needed, click a firearm'sDelete button. to remove it from the screen.

5. Complete the remaining fields:
1. Enter the transaction date (mm/dd/yyyy) or Select a Date (see page 24) with the calendar button

in theSet Date field.
Note: This is the date of the transaction, not the date of the disposition.

2. Enter the NICS approval code in theNICS Approval Code field.
3. Enter the transaction serial number in the Transaction Serial Number field.
4. If needed, enter transaction notes in theNotes field.
5. If the transaction occurred at a gun show, select the gun show from theGun Show drop-down

field.
Note: If the gun show is not available in the drop-down, create it before completing this firearm
transaction. Refer to ManageGun Show Information (see page 76) for more information.

6. Click theSubmit button to send the transaction to the customer'sCurrent record in theRegister
application for processing and payments.
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View the Inbound Consignments Report
1. Navigate to the Inbound Consignments (report) screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Reporting > Inbound Consignments from themainmenu to display the
Inbound Consignments screen.

2. Complete the following procedures as needed tomodify the list displayed on the screen:
l Click theRefresh button to display recent updates.
l Use the scroll bar(s).
l Sort and Filter Onscreen Data (see page 40).

3. Complete the following procedures as appropriate to add consignment item information:
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Edit an Unsold
Inbound
Consignment Item

1. Click the consignment’sEdit button to display theEdit
Consignmentwindow.
Note: If the consignment has been sold, a notification window
appears.

Click theOK button to close the window.

2. Edit Consignment information in the window.

Consignment
Fee

Select Fixed or Percentage to determine
how the consignment fee is calculated.

Amount If the selectedConsignment Fee is
Fixed, enter a fixed amount with no dollar
sign and two decimal places (0.00) in the
Amount field.
If the selectedConsignment Fee is
Percentage, enter the percentage
amount in the form of a decimal (.2 instead
of 20%) in thePercentage field.

Minimum
Amount

Enter theminimumamount for which the
firearmmay be sold.

Sales Price Enter the price for the firearm.
Note: If no price is entered, a price will
have to be entered at the time of sale.

3.  Click theSubmit button to close theEdit Consignment
window.
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Review Sales
Information for an
Inbound
Consignment Item 1. Click the consignment’sView button to display itsView

Consignment Trxwindow.
Note: If the consignment has not yet been sold, a notification
window appears.

Click theOK button to close the window.

2. Click theClose button to close theView Consignment Trx
window.

4. Click the tab'sClose button to close the screen.

User Guide FirearmsManagement - 223



Manage a Bound Book
1. Navigate to the desiredBound Book screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Bound Books to display amenu of options.
3. Click the desired Bound Book option (Non-NFA,Gunsmith, orNFA) to display the associated

Bound Book screen.

2. Complete the following procedures as needed tomodify the list of records displayed on the screen:
l Check the Include Active Records Only checkbox to display only active records.
l Enter starting and ending dates in theAcquisition Date Range fields and press theEnter key
to display results from that time frame.

l Click theRefresh button to display recent updates.
l Use the scroll bar(s).
l Sort and Filter Onscreen Data (see page 40).

3. Complete the following procedure tomanage an individual firearm record in the bound book:
1. Click the firearm record to display its Information for Log #window.

l If the record displays the highest/lastBound Book # associated with a given Log #, it is
the active record for that firearm. The systemwill display its Information for Log #
window.
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Note: Refer toModify a Firearm Record for information onmodifying this record.

l If the record displays aBound Book # that is lower/earlier than another associated with
the same Log #, it is an inactive record for that firearm and cannot bemodified. The
systemwill display a grayed out Information for Log #window. This window displays
only historical information and the record cannot bemodified.

2. Complete the following procedures as appropriate to update the firearm record:

Modify a Firearm
Record

Complete this procedure tomodify firearm, acquisition, or
disposition information in a firearm record.

1. Make changes to the appropriate fields as needed.
Note: Changesmadewill not be saved unless theSave
Changes button is clicked and confirmed.

Note: Changes to the following fields will cause the
system to deactivate the current record and create a new
record to reflect themodified information.

l In the Firearm Information section:
Manufacturer, Importer,Model, Serial Number,
Gauge/Caliber, and Type of Firearm

l In theAcquisition Information section:
Acquisition Date,Company, First,Middle,
Last,Address,City, State, Zip, and FFL #

l In theDisposition Information section:
Transferred Date,Company, First,Middle,
Last,Address,City, State, Zip, and FFL #

2. Continue with the procedure below.

User Guide FirearmsManagement - 225



Set a Firearm
Transfer Date

Complete the following procedure to establish a firearm's
transfer date in the Bound Book.
Note: Per the ATF, the transfer date is the actual date the
customer takes possession of the firearm. The transfer date
cannot be set until after the customer has paid for and taken
possession of a firearm at the register.
Manually setting a transfer date will cause the system to
deactivate the current record and create a new record to reflect
themodified information.

1. Enter the transfer date (mm/dd/yyyy) or Select a Date
(see page 24) with the calendar button in the
Transferred Date field.
Note: Changesmadewill not be saved unless theSave
Changes button is clicked and confirmed.

2. Continue with the procedure below.

Delete a Firearm
Record's
Disposition
Information

Complete this procedure to delete a firearm record's disposition
information andmake it available for sale again.
Note: This procedure will cause the system to deactivate the
current record and create a new record to reflect themodified
information.

1. Click theDelete Disposition button to clear all fields in
theDisposition Information section of the Information
for Log #window.
Note: Changesmadewill not be saved unless theSave
Changes button is clicked and confirmed.

2. Continue with the procedure below.

Delete a Firearm
Record

Complete this procedure to delete a firearm record from a
bound book and create an empty record.
Note: This procedure will cause the system to deactivate the
current record and create a new record to reflect themodified
information.

1. Click theDelete Record button to clear all the fields in
the Information for Log #window.
Note: Changesmadewill not be saved unless theSave
Changes button is clicked and confirmed.

2. Continue with the procedure below.

Print a Label from
a Firearm Record

1. Click thePrint Label button to print a label for the
firearm.

2. Click theClose button to close the Information for Log
#window.

3. Click the tab'sClose button to close the screen.

3. Click theSave Changes button to display a confirmation window.
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Note: If the changes do not require the current record to be deactivated, the system updates the
record and displays it in the Information for Log #window. Click theClose button to close the
Information for Log #window.

4. Click theSave Changes button in the confirmation window to deactivate the current record,
create a new record with themodified information and a new, system-generatedBound Book
#, and generateNotes for both records.
Note: The new record’s number will be the current record’s number with the next sequential
letter. (For example, if a firearm record withBound Book # 1001weremanually changed, the
newly generated record would be assignedBound Book # 1001A. If this record were changed,
the new record would be assignedBound Book # 1001B.)

4. Complete the following procedures as appropriate tomanage the bound book as a whole:
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Export a Bound
Book to Excel

Complete the following procedure to export an onscreen Bound
Book to an Excel file.

1. Right-click on the list to display amenu of options.

2. Click theExport to Excel option to open the Excel program
and display the report as a spreadsheet.

3. Select File > Save As from themenu bar to display theSave
Aswindow.

4. Save and Print a Document (see page 48) to create electronic
and hardcopy versions of the spreadsheet as needed.

228 - FirearmsManagement AXIS™ Retail Management System



Print a Bound Book 1. Right-click on the list to display amenu of options.

2. Click thePrint Bound Book ATF 2013-5 option to display
theSave Asmenu.

3. Browse to the desired location.
4. If needed, edit the document name in the File name field.
5. Click theSave button to save the document as an electronic

file and open it for viewing.

6. Select File > Print from themenu bar to display print controls.
7. Modify print options (e.g., select a different printer, adjust

settings, etc.) as needed.
8. Click thePrint button to print the document.
9. Select File > Close from themenu bar to close the document.
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Print a Bound Book
with Audits

Note: This procedure produces a version of the Bound Book that
may be useful for informational purposes but is not compliant with
ATF regulations.

1. Right-click on the list to display amenu of options.

2. Click thePrint Bound Book with Audits pre ATF 2013-5
option to display theSave Asmenu.

3. Browse to the desired location.
4. If needed, edit the document name in the File name field.
5. Click theSave button to save the document as an electronic

file and open it for viewing.

6. Select File > Print from themenu bar to display print controls.
7. Modify print options (e.g., select a different printer, adjust

settings, etc.) as needed.
8. Click thePrint button to print the document.
9. Select File > Close from themenu bar to close the document.

5. Click the tab'sClose button to close the screen.
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Import Bound Book Data
Complete the following procedure to import firearm data into a Bound Book by creating, populating, and
importing a formatted Excel file.

1. Navigate to the desired Import data from Excel screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. Select Firearms > Enter Bound Book to display amenu of options.
3. Click the desired option (Non-NFA,Gunsmith, orNFA) to display a warning window in front of

the associated Import data from Excel screen.

4. Click theContinue button to close the warning window and display the associated Import data
from Excel screen.

2. Right-click on the list to display aSave Template option.

3. Click theSave Template option to display aSave Aswindow.

4. Complete the following procedure to save the template (Excel file):
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1. Browse to the desired location.
2. If needed, enter/edit the document name in the File name field.
3. Click theSave button to save the document as an electronic file.

5. Open the saved Excel file template.
6. Populate the Excel file with firearm information.

Note: The file must adhere to the validation requirements indicated below:

l No entrymay have the same value for Log # as any other entry in this file or already in the
system.

l A UPCmust be a 12-digit number.
l TheNew/Used,Manufacturer, Importer,Model, S/N (serial number),Action,
Caliber/Gauge, andAcquired Date columns are required.

l Any entry in theAction columnmust conform to the selected Bound Book: The NFA book only
accepts NFA options, the Non-NFA book only accepts non-NFA options, and theGunsmith book
accepts all firearm types.

l The system requires that either theACQ Vendor Name column or theACQ First Name and
ACQ Last Name columns are populated.

l Any entry in the ID Type In or the ID Type Outcolumnmust exactlymatch one of the types
defined on the Identification Types screen. (SelectSetup > Identification Types to view this
screen.)

l If an entry'sDisp Date column is populated, the system requires that either theDisp Vendor
Name column or theDisp First Name andDisp Last Name columns are populated.

7. Save the populated Excel file.

8. Click theUpload button on the Import data from Excel screen to display the Load Excel Import
window.
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9. Browse to the desired location.
10. Double-click the saved Excel file to select it and start the import process.

Note: This processwill overwrite any information that was previously on the screen.

11. When the import is complete, the system displays the uploaded information on the Import data from
Excel screen.
Note: If the system detects any errors with the uploaded data, it highlights the cells containing bad or
missing information.

12. Locate and fix any validation errors.
13. Click theSubmit button to place the displayed data in the associated Bound Book.
14. If the system detects validation errors, it displays an error message window.

Click theClose button to return to the Import data from Excel screen without updating the
associated Bound Book and fix any outstanding validation errors as needed.

15. When the import is complete, the system displays an informational window.

16. Click theClose button to close the window and screen
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View a Bound Book Archive
1. Navigate to the desired Bound Book Archive screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Archived Bound Books to display amenu of options.
3. Click the desired Bound Book Archive option to display the associated Bound Book Archive

screen.
l Non-NFA: Contains an archive of the Non-NFA Bound Book.
l Gunsmith: Contains an archive of the Gunsmith Bound Book.
l NFA: Contains an archive of the NFA Bound Book.
l Non-NFA BB Pre 2013-5: Contains an archive of the Non-NFA Bound Bookwith audits
as it existed when the systemwas updated for the 2013-5 transition.

l Gunsmith BB Pre 2013-5: Contains an archive of the Gunsmith  Bound Bookwith audits
as it existed when the systemwas updated for the 2013-5 transition.

l NFA BB Pre 2013-5: Contains an archive of the NFA Bound Bookwith audits as it
existed when the systemwas updated for the 2013-5 transition.

2. Complete the following procedures (if available) as needed tomodify the list of records displayed on the
screen:

l Enter starting and ending dates in theDate Range fields and press theEnter key to display
results from that time frame.

l Click theRefresh button to display recent updates.
l Use the scroll bar(s).
l Sort and Filter Onscreen Data (see page 40).

3. Click the tab'sClose button to close the screen.
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View the Bound Book Audit Log Report
1. Navigate to theAudit Log Report screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Bound Books > Audit Log to display theAudit Log Report screen.

2. Complete the following procedures as needed tomodify the list of records displayed on the screen:
l Click theRefresh button to display recent updates.
l Use the scroll bar(s).
l Sort and Filter Onscreen Data (see page 40).

3. Click the tab'sClose button to close the screen.
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Oversee the Electronic 4473 Form Process
Complete the following procedure tomanage the creation and processing of an Electronic 4473 form for a
firearm transaction:

1. Start a 4473 Form for a Customer (see page 237).
2. Have the customer Fill Out the Customer Portion of an Electronic 4473 Form (see page 238).
3. When the customer returnswith a valid ID, Process a 4473 Form (see page 239).
4. Update a 4473 FormDisposition (see page 244).
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Start a 4473 Form for a Customer
1. Navigate to theStart Customer 4473 screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > 4473 > Start Customer 4473 from themainmenu to display theStart
Customer 4473 screen.

2. Click theSelect button to display theCustomer Look-upwindow.
3. Select or Add a FirearmCustomer (see page 29).

Note: Be sure all customer information is correct. Incorrect customer informationmay create errors in
the Bound Book.

4. Click theCreate 4473 Record button to display the customer’s 4473 ID code.

5. Give the 4473 ID code to the customer and have him/her Fill Out the Customer Portion of an Electronic
4473 Form (see page 238) on a device running the Form 4473 application.

6. Click the tab'sClose button to close the screen.
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Fill Out the Customer Portion of an Electronic 4473
Form
This proceduremay be completed with a tablet PC, kiosk, or computer running the Form 4473 application.

1. Ensure the Form 4473 application is available and displaying the code entry screen.

2. If needed, click a language button (English or Espanol) to change the language used on the screen
and in documents.

3. Enter the 4473 ID code provided in theEnter 4473 Code field.
4. Click theNext button to display theWarnings screen.

5. Click theContinue button to display another screen.
6. Complete these steps for every screen that follows:

1. Read the screen carefully. Scroll if needed.
2. Enter information in fields and answer questions as directed.
3. Click theContinue button to display the next screen. (If needed, click theBack button to review

or revise previously completed pages.)

7. Notify the salesperson when prompted or when the original code entry screen displays again.

238 - FirearmsManagement AXIS™ Retail Management System



Process a 4473 Form
1. Navigate to theProcess Customer 4473 screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > 4473 > Process Customer 4473 from themainmenu to display the
Process Customer 4473 screen.

2. Complete the following procedures as appropriate:

Process a
Customer's 4473
Form

1. Double-click the customer to display theCustomer Entered
Information screen.
Note: If this screen or any of the following screens indicate
the customer’s 4473 form contains an error or reason for
concern, click theBack button as needed to return to the
Process Customer 4473 screen andRevise a Customer's
4473 Form.

2. Continue with the procedure below.
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Revise a Customer's
4473 Form

1. Click the customer’sBuyer Edit button to display the
Confirmationwindow.

2. Click theYes button to display a window indicating the
customer’s 4473 ID code.

3. Click theOK button to close the window.
4. Give the 4473 ID code to the customer and have him/her Fill

Out the Customer Portion of an Electronic 4473 Form (see
page 238).

5. Click the tab'sClose button to close the screen.

3. Review the information on theCustomer Entered Information screen and click theContinue button
to display the completed 4473 form.

4. Review the form and click theContinue button near the bottom to display the 4473 decision screen.
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5. Determine whether or not the sale should happen and complete the following procedures as
appropriate:

Approve the
Transaction

1. Click theContinue button to display theSeller Firearm
Information screen.
Note: If theContinue button is grayed out, the system has
identified a reason to prohibit the transaction. The gun seller is
responsible for verifying all answers and ultimately deciding
whether or not to continue the transaction.

2. Continue with the procedure below.
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Deny the
Transaction

Note: It may be useful at this point toSave & Print the 4473 Form
to create a hardcopy of the customer’s 4473 form. The form can be
filed as a record of a prohibited sale or, if the sale was prohibited due
to a legitimate error, used to explain to the customer where errors
weremade so that the process can be restarted and completed
correctly.

1. Click theMark Dealer Denied button to display theUpdate
Disposition screen.

2. Click theYes button to display an informational screen.
3. Click theOK button.

Save & Print the
4473 Form

Click thePrint Form button to Save and Print a Document (see
page 48) to create a hardcopy of the customer’s 4473 form.

6. If the firearmwas sold at a Gun Show, select the show from the drop-down field. Click theContinue
button to display theSeller Identification Check screen.

7. Review the information and complete the screen. Click theContinue button to display theSeller
Aliens screen.

8. Enter information as needed and complete the screen. Click theContinue button to display theSeller
NICS screen.

9. Review instructions and complete the screen. Click theContinue button to display the firearm
selection screen.

10. Complete the following procedure to identify the firearm(s) associated with this transaction.
1. Complete one of the following procedures to select a firearm and display theSerial Number

Verificationwindow:
l Scan the firearm’s log number in theScan Log # here field and press theEnter key.
l Enter the firearm’s log number in theScan Log # here field and press theEnter key.
l Locate the firearm in the list and check itsSelect checkbox.
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2. Enter the firearm’s serial number in the Firearm Serial Number field.
3. Click theVerify button to check the entered number against serial number in the database:

Note: If the numbersmatch, the firearm selection screen returns.
If the numbers do not match, an informational screen appears.

Click the screen’sClose button to return to the firearm selection screen.

4. Repeat steps as needed to reattempt a failed selection and/or select additional firearms.
11. Click theContinue button to display theSeller Section D screen.
12. Answer the question and complete the screen. Click theContinue button to display theSeller FFL

Information screen.
13. Review the information and complete the screen. Click theContinue button to display the completed

4473 form.
Note: The Transaction Serial Number is located on the upper right side of the 4473. If the store
does not number transactions, clear the default number from the field.

14. Review the form and click theContinue button to display theSeller Certification screen.
15. Read the screen and click the I agree with and certify the above statement button to display the

Save Aswindow.
16. Save and Print a Document (see page 48) to create a hardcopy of the form.

Note: Save the electronic document for future reference. Have the customer sign the printed form and
save it in a secure location.

17. Click theClose button to close the screen.
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Update a 4473 Form Disposition
1. Navigate to theUpdate 4473 Disposition screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > 4473 > Update 4473 Disposition from themainmenu to display the
Update 4473 Disposition screen.

2. Double-click the customer to display the customer’s 4473 information on the screen.

3. Enter the NICS transaction number in theNICS field.
4. If needed, modify the information in the Transaction Serial Number field to reflect the accepted

numbering convention.
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5. Determine the disposition and complete the following procedures as appropriate:

Approve the 4473
Disposition

1. Select an “Approved” disposition from theSelect New
Disposition drop-down field.

2. Continue with the procedure below.

Deny the 4473
Disposition

1. Select a “Denied” disposition from theSelect New
Disposition drop-down field.

2. Click theSubmit button to close theUpdate 4473
Disposition screen.
Note: If needed, refer to View and Use a List of Denied 4473
Forms (see page 247) for more information.

Delay the 4473
Disposition

1. Select a “Pending” disposition from theSelect New
Disposition drop-down field.

2. Click theSubmit button to close theUpdate 4473
Disposition screen.

6. Select the firearm transaction type from theSelect Transaction To Create drop-down field.
7. Click theSubmit button to display the firearm transaction screen for the corresponding procedure.
8. Verify and complete the firearm transaction screen.

Note: Do not edit customer or firearm information on the transaction screen. Changing this information
will cause errors in the Bound Book.

Note: Refer to the appropriate procedure (Document the Return of an Incoming Consignment Firearm
(see page 219), Document a FirearmSale (see page 203), Document a Firearm Trade (see page
207), or Document anOutgoing Firearm Transfer (see page 213)) to complete the transaction.

User Guide FirearmsManagement - 245



View and Use a List of All 4473 Forms
1. Navigate to theAll 4473s screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > 4473 > List All 4473s from themainmenu to display theAll 4473s screen.
3. Enter starting and ending dates in theDate Range fields to display results from that time frame.

Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedure as appropriate:

Print a Customer’s
4473 Form

Click the customer’sPrint button.
Note: Refer to Save and Print a Document (see page 48) for more
information.

3. Click the tab'sClose button to close the screen.
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View and Use a List of Denied 4473 Forms
1. Navigate to theDenied 4473s screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > 4473 > List Denied 4473s from themainmenu to display theDenied
4473s screen.

3. Enter starting and ending dates in theDate Range fields to display results from that time frame.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedure as appropriate:

Print a Customer’s
4473 Form

Click the customer’sPrint button.
Note: Refer to Save and Print a Document (see page 48) for more
information.

3. Click the tab'sClose button to close the screen.
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Clear a Firearm Hold
1. Navigate to theClear Firearms Holds screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > 4473 > Clear Firearms Holds from themainmenu to display theClear
Firearms Holds screen.

2. Check a firearm’sSelect checkbox to select the firearm for clearing. (Repeat this step as needed to
select additional firearms for clearing.)

3. Click theRelease button to clear each selected firearm from the screen and return it to inventory.
4. Click the tab'sClose button to close the screen.
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Print Firearm Labels
1. Navigate to the Firearm Label Print Control screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Print Gun Labels from themainmenu to display the Firearm Label Print
Control screen.

2. Click theNon-NFA orNFA button as needed to select the appropriate type of firearm.
3. Enter starting and ending log numbers in the Log Number fields to print labels for that range of log

numbers.
Note: If desired, starting and ending transaction numbersmay be entered in the fields to print labels for
that range of transactions.

4. Enter the desired number of labels to print for each log number (or transaction) in theCopies field.
5. Click thePrint button.
6. Click the tab'sClose button to close the screen.
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Perform a Physical Inventory Count for Firearms
Complete the following procedure to take a physical inventory count for firearms. 
Note: A physical inventory count is essential for verifying the physical presence of individual firearms in the
store/warehouse. RTG recommends performing a complete physical firearm inventory count once every thirty
days.

1. Navigate to the appropriate (Gunsmithing,NFA, orNon-NFA) Physical Firearm Inventory Count
screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Physical Firearm Inventory Count to display amenu of options.
3. Click the desired firearm type option (Gunsmithing,NFA, orNon-NFA) to display the

associatedPhysical Firearm Inventory Count screen.

2. If needed, Sort and Filter Onscreen Data (see page 40).
3. Complete the following procedure for each located firearm:

1. Scan or enter the firearm'sLog Number (or INV#) in the blank field.
2. Press theEnter key tomove the firearm to the bottom of the list and update the value in its

Status cell to "Scanned."
4. If needed, review theStatus cell for each entry in the list to determine the firearm's status. A Status cell

can display one of the following values:
l "Waiting for Scan" indicates the firearm is not present or has not been scanned.
l "Scanned" indicates the firearm has been counted.
l "ItemDoesNot Have Inbound Status" indicates the firearm has been disposed.
l "FirearmNot Found" indicates the entered Log Number is invalid or has been voided.

5. When all firearms have entered, click theUpdate button.
6. Click the tab'sClose button to close the screen.
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Manage a Firearm Tax
1. Navigate to the Firearm Taxes screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Firearm Taxes from themainmenu to display the Firearm Taxes screen.

2. Complete the following procedures as appropriate tomanage firearm taxes:

Add a Firearm Tax

1. Select an available tax type from the drop-down field.
Note: If a new tax type is needed, refer to Manage Tax Types
(see page 321) for more information.

2. Click theAdd Firearm Tax button to display the tax on the
screen.

3. Click the tab'sClose button to close the screen.

Delete a Firearm Tax

1. Click a tax’sDelete button to remove it from the screen.
2. Click the tab'sClose button to close the screen.
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View the Firearm Sales Report
1. Navigate to the Firearm Sales Report screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Reporting > Sales Report to display the Firearm Sales Report screen.

2. Complete the following procedure to determine which transactions are displayed on the screen:
1. Enter starting and ending dates in theDate Range fields to define the time frame.
2. Click theSubmit button to display selected transactions.

3. Complete the following procedures as needed tomodify the list displayed on the screen:
l Use the scroll bar(s).
l Sort and Filter Onscreen Data (see page 40).

4. Complete the following procedure as appropriate to view information about a particular transaction:
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View a Transaction's
Details

1. Click the transaction’sView button to display itsTransaction
Detailswindow.

2. Click an item to view its specific details.

3. Click theClose button to close the Transaction Details
window.

5. Click the tab'sClose button to close the screen.
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View the Firearm Transactions Report
1. Navigate to the Firearm Transactions Report screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Reporting > Transactions Report to display the Firearm Transactions
Report screen.

2. Complete the following procedure to determine which transactions are displayed on the screen:
1. Enter starting and ending dates in theDate Range fields to define the time frame.
2. Select a transaction type from the Transaction Type drop-down to restrict the types of

transactions to include in the report.
3. Click theSubmit button to display selected transactions.

3. Complete the following procedures as needed tomodify the list displayed on the screen:
l Use the scroll bar(s).
l Sort and Filter Onscreen Data (see page 40).

4. Complete the following procedures as appropriate to view information about a particular transaction:

View a Transaction's
Component Record

1. Click the transaction’sExpand (+) button to display its
component record.

2. Click the transaction’sContract (–) button to close its
component record.
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View a Transaction's
Details

1. Click the transaction’sView button to display itsTransaction
Detailswindow.

2. Click an item to view its specific details.
3. Click theClose button to close the Transaction Details

window.
5. Click the tab'sClose button to close the screen.
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View and Update the Firearm Inventory With Costs
Report

1. Navigate to the Firearm Inventory With Costs screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. Select Firearms > Inventory Report With Costs to display the Firearm Inventory With
Costs screen.

2. Complete the following procedures as needed tomodify the list displayed on the screen:
l Check the Include NFA checkbox to display all firearm types.
l Check the Include Rentals checkbox to display rental firearms in the list.
l Click theRefresh button to display recent updates.
l Use the scroll bar(s).
l Sort and Filter Onscreen Data (see page 40).

3. Complete the following procedures as appropriate to view information about a particular transaction:

Edit a Firearm's
Description

1. Click a firearm’sEdit button to display itsFirearm
Descriptionwindow.

2. Describe a Firearm (see page 37).
3. Click theSubmit button to close the Firearm Description

window.
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Edit a Firearm's
Sales Price

1. Click a firearm’sSales Price cell to select it.
2. Enter/edit the value in the cell as needed.
3. Press theEnter key to deselect the cell.

View a Firearm's
Details

1. Click the firearm’sTrans button to display itsTransaction
Detailswindow.

2. Click an item to view its specific details.
3. Click theClose button to close the Transaction Details

window.

Print a Firearm Label 1. Complete any of these procedures to select the firearm(s) for
which labels will be printed:

l Check a firearm’s checkbox to select it.
l Uncheck a firearm's checkbox to deselect it.
l Check theSelect All button to select all firearms.
l Uncheck theDeselect All button to deselect all
firearms.

2. Click thePrint button to print labels for selected firearms.

4. Click the tab'sClose button to close the screen.
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View the Firearm Inventory Without Costs Report
1. Navigate to the Firearm Inventory Without Costs screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Inventory No Costs to display the Firearm Inventory Without Costs
screen.

2. Complete the following procedures as needed tomodify the list displayed on the screen:
l Check the Include NFA checkbox to display all firearm types.
l Check the Include Rentals checkbox to display rental firearms in the list.
l Click theRefresh button to display recent updates.
l Use the scroll bar(s).
l Sort and Filter Onscreen Data (see page 40).

3. Click the tab'sClose button to close the screen.
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View and Update the Firearm Inventory Aging Report
1. Navigate to the Firearm Inventory Aging screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > Inventory Aging Report to display the Firearm Inventory Aging screen.

2. Complete the following procedure to determine which transactions are displayed on the screen:
1. Enter the APR value in theEnter cost of funds as APR in decimal form field.

Note: The APR value is the decimal form of the percentage for calculating the actual cost of
holding the firearm inventory (interest rate on borrowed funds).

2. Click theSubmit button to display the firearm inventory.
3. Complete the following procedures as needed tomodify the list displayed on the screen:

l Use the scroll bar(s).
l Sort and Filter Onscreen Data (see page 40).

4. Complete the following procedure as appropriate to edit a firearm's description:
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Edit a Firearm's
Description

1. Click the firearm’sEdit button to display the Firearm
Descriptionwindow.

2. Describe a Firearm (see page 37).
3. Click theSubmit button to close the Firearm Description

window.
5. Click the tab'sClose button to close the screen.
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Generate, View, and Print 3310-4 Forms
1. Navigate to the 3310-4 screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > 3310-4 from themainmenu to display the 3310-4 screen.

2. Enter or select the desired date in the date field. (The date field defaults to today’s date.)
3. Click theGenerate button to generate 3310-4 forms for the selected date and display a form

generation confirmation window.
Note: If the date’s firearm transactions did not generate any 3310-4 forms, the system displays the
3310-4 Form Generation information window to indicate this:

Click theOK button to close the window.

4. Click theOK button to close the confirmation window.

5. Click a form’sOpen button to view it.
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6. Select File > Print from themenu bar to display print controls.
7. Modify print options (e.g., select a different printer, adjust settings, etc.) as needed.
8. Click thePrint button to print the document.
9. Select File > Close from themenu bar to close the document.
10. Click the tab'sClose button to close the screen.
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Generate, View, and Print 3310-12 Forms
1. Navigate to the 3310-12 screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Firearms > 3310-12 from themainmenu to display the 3310-12 screen.

2. Enter or select the desired date in the date field. (The date field defaults to today’s date.)
3. Click theGenerate button to generate 3310-12 forms for the selected date and display a form

generation confirmation window.
Note: If the date’s firearm transactions did not generate any 3310-12 forms, the system displays the
3310-12 Form Generation information window to indicate this:

Click theOK button to close the window.

4. Click theOK button to close the confirmation window.

5. Click a form’sOpen button to view it.
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6. Select File > Print from themenu bar to display print controls.
7. Modify print options (e.g., select a different printer, adjust settings, etc.) as needed.
8. Click thePrint button to print the document.
9. Select File > Close from themenu bar to close the document.
10. Click the tab'sClose button to close the screen.
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Range Management
This section contains procedures to set up, maintain, and review range, lane, and waiver information, range
products and rentals, and an assortment of useful statistical reports on range usage.

Range Information
Range Information includes the range's name, addresses, phone number, days and hours of operation,
number of lanes, session length, and reservation limits.

l Manage Range Information (see page 267)

Range Lane Information
Range Lane Information includes the lane's name, availability, reservation status, and last cleaning date.

l Manage Range Lanes (see page 269)

Range Products
Range Products are blocks of range time sold to customerswishing to access and use the range. Like a
standard product, a range product has a UPC and can be selected through theProduct Search functions in
theRegister application.

l Manage Range Use Products (see page 271)

Range Rentals
Range Rentals are firearms available for rent for use during a range session.

l Manage the Rental Firearm List (see page 274)
l View and Update the Current Rentals List (see page 275)

Waiver Information
Waiver Information includes the standard text on the electronic range waiver and the number of days for
which it is valid.

l Set Up and Edit the RangeWaiver (see page 276)

Range Shooters Report
TheRange Shooters Report displays the customerswho have used the range and the number of visits for
each.

l View the Range Shooters Report (see page 277)

Reservation Statistics Report
TheReservation Statistics Report displays every range reservation and the details (customer, date, day, time,
and lane) for each.

l View the Reservation Statistics Report (see page 278)
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Lane Use Statistics Report
The Lane Statistics Report displays every lane use session and the details (date, day, lane, type, number of
shooters, and times) for each.

l View the Lane Use Statistics Report (see page 279)

Rental Firearm Statistics Report
TheRental FirearmStatistics Report displays every rental firearm and general information (log number,
manufacturer, model, serial number, gauge/caliber, dates of first and last use, and number of rounds fired) for
each. Clicking a firearm displays a record showing detailed information (renter name, date, and number of
rounds fired) for each time the firearmwas rented.

l View the Rental FirearmStatistics Report (see page 280)
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Manage Range Information
Complete the following procedure to establish or update the range's name, addresses, phone number, days
and hours of operation, number of lanes, session length, and reservation limits.

1. Navigate to theDefine/Edit Range screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectRange > Range Setup from themainmenu to display theDefine/Edit Range screen.

2. Enter/edit Range information on the screen.

Range Name Enter the name of the range.
Address Enter the range's street address.
Phone Number Enter the range's phone number.
City Enter the range's city.
State Select the range's state from the drop-down.
Zip Code Enter the range's ZIP code.
Range Closed Check a weekday's checkbox if the range is normally closed on that

day of the week.
Open Enter the range opening time (in 24 hour/military time) for each day the

range is open during a normal businessweek.
Close Enter the range closing time (in 24 hour/military time) for each day the

range is open during a normal businessweek.
Number of Lanes Enter the range's total number of lanes.
Enter Lane Numbers That
Are Handicap Accessible

Enter the individual lane numbers of lanes (separated by commas)
that numbers that are handicap accessible are for the AXIS Nexus for
online range reservations.

Session Length in Minutes Enter the duration (in minutes) of a standard range session.
Number of days
reservations can be made
in advance

Enter themaximumnumber of days before a range session that a
reservation for it may bemade.

3. Click theSubmit button to display a confirmation window.
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4. Click theOK button to close the confirmation window and theDefine/Edit Range screen.
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Manage Range Lanes
Complete the following procedure to establish or update a lane's name, availability, reservation status, and
last cleaning date.

1. Navigate to theRange Lanes screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectRange > Range Lanes from themainmenu to display theRange Lanes screen.
3. Complete the following procedures as needed tomodify the list displayed on the screen:

l Use the scroll bar(s).
l Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedures as needed tomodify lane information:

Edit a Lane Name 1. Double-click a lane’sName field to select it.

2. Enter a name (up to 3 characters) in the field.
3. Press theEnter key to save the name.

Activate (/Deactivate)
a Lane For Use

1. Locate the lane to be activated (or deactivated) for use.

2. Check the lane’sOpen checkbox tomark it available for use.
(Uncheck the checkbox tomark the lane unavailable.)
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Activate (/Deactivate)
a Lane For
Reservations

1. Locate the lane to be activated (or deactivated) for
reservations.

2. Check the lane’sReservable checkbox tomark it available to
be reserved. (Uncheck the checkbox tomark the lane
unreservable.)

Update a Lane's
Cleaning Record

1. Locate the lane cleaning record to be updated.

2. Double-click a lane’sLast Cleaned field to select it.
3. Enter the cleaning date (mm/dd/yyyy) or Select a Date (see

page 24) with the calendar button in the Last Cleaned field.
4. Pres the Tab key to save the date.

3. Click the tab'sClose button to close the screen.
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Manage Range Use Products
Complete the following procedure to establish or update a range product (block of range time sold to a
customer wishing to access and use the range).

1. Navigate to theRange Use Products screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectRange > Range Use Products from themainmenu to display theRange Use
Products screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedures as needed tomanage lane use products:

Create a Range Use
Product

1. Click theCreate New Range Use Product button to display
theRange Use Productwindow.

2. Continue with the procedure below.
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Edit a Range Use
Product

1. Click a product’sEdit button to display itsRange Use
Productwindow.

2. Continue with the procedure below.

Delete a Range Use
Product

1. Click a product’sDelete button to display a deletion
confirmation window.

2. Click theYes button to remove the product from theRange
Use Productwindow.

3. Enter/edit the product description in theProduct Description field.
4. Enter/edit the concise product description in theShort Description field.
5. If needed, modify the autofilled value in theProduct UPC field.
6. If this is a primary shooter product, check thePrimary Shooter Product checkbox.

Note: A primary shooter product (checked box) can be assigned to a range lane by itself. A secondary
shooter product (unchecked box) can be assigned only if a primary shooter is already on the lane.

7. Select a range type from theRange Type drop-down field.
Note: A customer will be allowed to rent only the selected type of firearmwhen purchasing this
product.

8. Enter/edit the price to charge for this product in thePrice field.
9. Do not click theSelect Image button as it has been deactivated in this window.

Note: To add aProduct Image, complete the remainder of this procedure to create this range use
product. Then complete the procedure to select the range use product and add a product image.
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10. Click theSubmit button to display the new/modified product on theRange Use Products screen.
11. Click the tab'sClose button to close the screen.
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Manage the Rental Firearm List
Complete the following procedure to establish or update the list of firearms available for rent for use during a
range session.

1. Navigate to theRental Control screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectRange > Rental Control from themainmenu to display theRental Control screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedures as needed tomanage the rental firearm list:

Add a Firearm to the
Rental Firearm List

1. Check a firearm’sRental checkbox to add it to the list of rental
firearms.

2. Enter the price to rent the firearm in the firearm’sRental Cost
field.

3. Click the tab'sClose button to close the screen.

Remove a Firearm
from the Rental
Firearm List

1. Uncheck a firearm’sRental checkbox to remove it from the list
of rental firearms.

2. Click the tab'sClose button to close the screen.
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View and Update the Current Rentals List
Complete the following procedure to review or update the list of firearms currently rented to range users.

1. Navigate to theCurrent Rentals screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectRange > Current Rentals from themainmenu to display theCurrent Rentals screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedure as needed to remove a rental record from the list:

Remove a Record
from the Current
Rentals List

1. Click a rental record'sClear button to gray out the button.
2. Click theRefresh button to remove the rental record from the

screen.
3. Click the tab'sClose button to close the screen.
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Set Up and Edit the Range Waiver
Complete the following procedure to establish or update the standard text on the electronic range waiver and
the number of days for which it is valid.

1. Navigate to theRange Waiver screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectRange > Waiver Setup from themainmenu to display theRange Waiver screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Enter/edit text in theHeader,Main Text, and Footer fields.
Note: Variable commands <<name>> and <<date>>may be used in the text fields. When the range
waiver displays, it will replace <<name>> with the customer's name and <<date>> with the actual
date.

3. Enter/edit the value in theNumber of days before this waiver needs to be resigned field. (If a
waiver is only good for one day, set the value to zero (0) days.)

4. Click theSubmit button to display an update confirmation window.
5. Click theOK button to close the confirmation window.
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View the Range Shooters Report
Complete the following procedure to view a report showing customerswho have used the range and the
number of visits for each.

1. Navigate to theRange Shooters screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectRange > Range Shooters from themainmenu to display theRange Shooters screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedure as needed to view a shooter's detail record:

View a Range
Shooter's Detail
Record

1. Click a shooter's name to display his/her Shooter Detail
window.

2. Click theOK button to close theShooter Detailwindow.
3. Click the tab'sClose button to close the screen.
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View the Reservation Statistics Report
Complete the following procedure to view a report showing range reservations and the details (customer,
date, day, time, and lane) for each.

1. Navigate to theRange Reservations Statistics screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectRange > Reservation Statistics from themainmenu to display theRange
Reservations Statistics screen.

3. Enter starting and ending dates in theDate Range fields and press theSubmit key to display
results from that time frame.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Click the tab'sClose button to close the screen.
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View the Lane Use Statistics Report
Complete the following procedure to view a report showing select lane use sessions and the details (date,
day, lane, type, number of shooters, and times) for each.

1. Navigate to theRange Lane Use Statistics screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectRange > Lane Statistics from themainmenu to display theRange Lane Use
Statistics screen.

3. Enter starting and ending dates in theDate Range fields and press theSubmit key to display
results from that time frame.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Click the tab'sClose button to close the screen.
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View the Rental Firearm Statistics Report
Complete the following procedure to view a report showing rental firearms, general information (log number,
manufacturer, model, serial number, gauge/caliber, dates of first and last use, and number of rounds fired) for
each, and detail information (renter name, date, and number of rounds fired) for each time a firearmwas
rented.

1. Navigate to theRental Firearm Statistics screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectRange > Rental Firearm Statistics from themainmenu to display theRental Firearm
Statistics screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedure as needed to view a firearm's detail record:

View a Firearm's
Detail Record

1. Click a firearm to display itsRental Firearm Statistics Detail
window.

2. Click theOK button to close theRental Firearm Statistics
Detailwindow.

3. Click the tab'sClose button to close the screen.
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Facilities Management
This section contains procedures to set up, maintain, and review facilities (classrooms, multipurpose rooms,
lounges, etc.) and tomanage reservations for those facilities.

l Maintain a Facility (see page 282)
l Manage Facility Reservations (see page 284)
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Maintain a Facility
1. Navigate to the Facility Maintenance screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Facilities > Facility Maintenance from themainmenu to display the Facility
Maintenance screen.

2. Complete the following procedures as appropriate tomaintain facilities:

Add a Facility

1. Click theNew Facility button to display theDefine/Edit
Facilitywindow.

2. Enter the name for the facility in the Facility Name field.
3. Click theSubmit button to add the new facility to the Facility

Maintenance screen.
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Edit a Facility

1. Click a facility'sEdit button to display itsDefine/Edit Facility
window.

2. Edit the facility name in the Facility Name field.
3. Click theSubmit button to update the facility on the Facility

Maintenance screen.

Delete a Work Order

1. Click a facility'sDelete button to display a deletion
confirmation window.

2. Click theYes button to remove the class from the Facility
Maintenance screen.

3. Click the tab'sClose button to close the screen.
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Manage Facility Reservations
1. Navigate to the Facility Usage screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. Select Facilities > Facility Usage from themainmenu to display the Facility Usage screen.

2. Complete the following procedures as needed to display reservations for a specific facility, date, and/or
time frame:

l To display only reservations for a specific facility, complete the following procedure:
1. Check the Limit by facility checkbox.
2. Select the facility from the Limit by facility drop-downmenu.

l To display only reservations for a specific date, Select a Date (see page 24) on the calendar.
l To display only reservations for a specific time frame, enter the desired number of days in the
Reservations in the next __ days field.

3. If needed, Sort and Filter Onscreen Data (see page 40).
4. Complete the following procedures as appropriate tomanage facility reservations:

Reserve a Facility

1. Click theNew Reservation button to display theReserve
Facilitywindow.

2. Continue with the procedure below.
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Edit a Facility
Reservation

1. Click the reservation'sEdit button to display itsReserve
Facilitywindow.

2. Continue with the procedure below.

Cancel a Facility
Reservation

1. Click the reservation'sDelete button to display a deletion
confirmation window.

2. Click theYes button to remove the reservation from the
Facility Usage screen.

5. Enter/edit Facility Reservation information in the window.
Note: Required fields and settings are displayed with red borders.

Facility Name Select the facility to be reserved.
Facility Use Enter the purpose of the reservation (meeting, training, class, etc.).
Choose Date Select a Date (see page 24) for the reservation.
Start Time Enter the starting time for the reservation.
End Time Enter the ending time for the reservation.

6. Click theSubmit button.
Note: If any date/time combinations conflict with an existing reservation for the same facility, the
Submit button will remain grayed out.

7. Click the tab'sClose button to close the screen.
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Membership Management
This section contains procedures to set up, edit, andmaintain memberships, associated incentives, member
lists, billing functions, and histories for individual customers.

Membership Information
Membership Information includes themembership's name, terms, prices, discounts, and billing and expiration
dates.

l Define aMembership (see page 288)

Membership Incentives
Membership Incentives aremember-only discounts (either percentages or dollar amounts) on selected
products. Incentivesmay be applied to individual products or to all products having a particular
attribute/descriptor combination.

l Define aMembership Incentive (see page 292)

Member Lists
Member Lists display all current membershipmembers and the details (name, ID, address, and birth date) for
each. Clicking amember displays a record showing associated groupmembers (if applicable) and the details
for each.

l Manage aMembershipMember List (see page 298)
l View theMember List for All Memberships (see page 303)

Recurring Billing Functions
Recurring Billing Functions provide the ability to collect regular, ongoingmembership fees through credit card
charges.

l Manage aMember's Recurring Billing Information (see page 304)
l Manage Recurring Payments (see page 307)
l View Processed Payments (see page 311)
l View Denied Payments (see page 312)

Member Histories
Member Histories provide a record of a customer'smemberships and associated dates.

l View and Update a Customer’sMemberships (see page 138)
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Define a Membership
Complete the following procedure to establish or update amembership's name, terms, prices, discounts, and
billing and expiration dates.

1. Navigate to theMemberships screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectMemberships > Define Memberships from themainmenu to display the
Memberships screen.

2. Complete the following procedures as needed tomanagememberships:
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Create a New
Membership

1. Click theAdd button to display a new membership name
window.

2. Enter the name of themembership in theMembership field.
3. Click theOK button to add themembership to the

Membership Name list and display itsDefine/Edit
Membership section.

4. Continue with the procedure below.

Edit a Membership

1. Click amembership in theMembership Name list to display
itsDefine/Edit Membership section.

2. Continue with the procedure below.
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Delete a Membership

1. Click amembership in theMembership Name list to display
itsDefine/Edit Membership section.

2. Click theDelete button to display a deletion confirmation
window.

3. Click theYes button to remove themembership from the
Membership Name list.

3. Enter/edit Membership information in theDefine/Edit Membership section.
Note: Required fields and settings are displayed with red borders.

Membership Name Edit themembership name as needed.
Membership Terms Enter themembership's terms. The terms entered can serve as a

description.
Price Enter themembership's initial price.

If a price is entered, this amount will be charged when themembership
is purchased through theRegister application.
If no price is entered (or the price is set to zero), a member may be
added through theData Center application without an initial
transaction.

Recurring Monthly Price Enter the price to be automatically charged to themember's credit card
on amonthly basis.
If a recurring price is entered, the systemwill prompt for credit card
information when amembership is purchased through theRegister
application and allow the operator to modify the recurring billing date if
needed.
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Additional Family
Members Allowed

Enter the number of group/familymembers that may be added to a
member'smembership.

Length of Membership Enter themembership's length in months.
If a never-endingmembership is desired, enter "9999" in the field.

No Expiration Check the checkbox to have no expiration for themembership.
Contract Expiration Enter themembership's contract expiration in months.
Billing Start Date Enter themaximumnumber of days that can occur between a

member's initial join date and the first billing date.
Class Discount Check to add a percentage discount on classes.
Percentage Discount Enter the percentage discount in decimal form (e.g., .25).
Range Rental Discount Check to add a percentage discount on range firearm rentals.
Percentage Discount Enter the percentage discount in decimal form (e.g., .25).

4. Click theSubmitbutton to display a save confirmation window.

5. Click theOK button to close the window.
6. Complete the following procedures as needed:

l Define aMembership Incentive (see page 292)
Note: Amembership incentive is amember-only discount (either a percentage or dollar amount)
on selected products. An incentivemay be applied to individual products or to all products having
a particular attribute/descriptor combination.

l Manage aMembershipMember List (see page 298)
Note: Amember list displays all current members of amembership and the details (name, ID,
address, and birth date) for each.

7. Click the tab'sClose button to close the screen.
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Define a Membership Incentive
Complete the following procedure to establish or update amembers-only discount (either a percentage or a
dollar amount) on selected products. An incentive discount may be applied to individually selected products or
to all products having a specified attribute/descriptor combination.

1. Navigate to theMemberships screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectMemberships > Define Memberships from themainmenu to display the
Memberships screen.

2. Click amembership in theMembership Name list to display itsMembership Incentives section.

3. Complete the following procedures as needed tomanage themembership's incentives:
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Create a New
Incentive

1. Click theAdd button in theMembership Incentives section
to display theAdd Membership Incentivewindow.

2. Continue with the procedure below.
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Edit an Incentive 1. Click an incentive in theMembership Incentives section to
display its details record.

2. Click theEdit button to display the incentive'sEdit
Membership Incentivewindow.

3. Continue with the procedure below.

Delete an Incentive

1. Click an incentive’sDelete button to display a deletion
confirmation window.

2. Click theYes button to remove the incentive from the list.

4. Enter/edit Membership Incentive information in the window.

Description Enter a descriptive name for the incentive.
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Discount Type Select the type of discount (Percentage orDollar Amount) from the
drop-down.

Percentage Discount /
Dollar Discount

Enter the incentive discount (percentage or dollar amount).

5. Click theSubmit button to display a save confirmation window.

6. Click theYes button to close the window and add/update the incentive on the list ofMembership
Incentives.

7. Click the incentive to display its details record, including lists of associated products and
attribute/descriptor combinations.

8. Complete the following procedures as needed tomanage the products/categories associated with the
membership incentive:
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Add a Product to an
Incentive

1. Click theAdd Products button to display theProduct
Searchwindow.

2. Select One or More Products (see page 28) to be added to the
category.

3. Click theSelect button to close the window and add the
product(s) to the list.

4. Continue with the procedure below.

Remove a Product
from an Incentive

1. Click a product'sDelete button to remove it from the list.
2. Continue with the procedure below.
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Add an
Attribute/Descriptor
Combination to an
Incentive

1. Click theAdd Attr/Desc button to display theSelect
Attribute/Descriptor window.

2. Select an attribute from theAttribute drop-down field.
3. Select a descriptor from theDescriptor drop-down field.
4. Click theSubmit button to close the window and add the

attribute and descriptor to the list.
5. Continue with the procedure below.

Remove an
Attribute/Descriptor
Combination from
an Incentive

1. Click an attribute/descriptor combination'sDelete button to
remove it from the list.

2. Continue with the procedure below.

9. Double-click the details record to close it.
10. Click the tab'sClose button to close the screen.
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Manage a Membership Member List
Complete the following procedure to add or remove amembership'smembers and group/familymembers (if
applicable).

1. Navigate to theMemberships screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectMemberships > Define Memberships from themainmenu to display the
Memberships screen.

2. Click amembership in theMembership Name list to display itsMember List section.

3. Complete the following procedures as neededmanage themembership list:
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Add a New Member Note: This procedure adds an existing customer to amembership.
To add a new customer to themembership, create a database
record for the new customer and then return to this procedure and
add the now-existing customer as amember. Refer to Set Up and
Maintain a Customer Record (see page 114) for more information.

1. Click theAdd Members button in theMember List section to
display theCustomer Look-upwindow.
Note: If this button is grayed out, a new member cannot be
added to thismembership throughData Center, but onemay
be added as a transaction through theRegister application.

2. If needed, complete either of these procedures to display only
matching results on theCustomer Look-upwindow:

l Enter the customer's phone number in thePhone field.
l Enter all or part of the customer’s last name in the Last
Name field and press theEnter key.

3. Double-click a customer name to add the customer as a
member in theMember List section.
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Remove a Member

1. Click amember name in theMember List section to display
themember’s details record.

2. Click theDelete button to display a deletion confirmation
window.

3. Click theYes button to remove themember from theMember
List section.
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Add a Group/Family
Member

Note: This procedure adds an existing customer to a group
membership. To add a new customer to the groupmembership,
create a database record for the new customer and then return to
this procedure and add the now-existing customer as a group
member. Refer to Set Up andMaintain a Customer Record (see
page 114) for more information.

1. Click amember name in theMember List section to display
themember’s details record.

2. Click theAdd Family Member button to display the
Customer Look-upwindow.
Note: If this button is grayed out, thismembership does not
offer a groupmembership option.

3. If needed, complete either of these procedures to display only
matching results on theCustomer Look-upwindow:

l Enter the customer's phone number in thePhone field.
l Enter all or part of the customer’s last name in the Last
Name field and press theEnter key.

4. Double-click a customer name to add the customer as a group
member in themember’sAdditional Members list.

5. Double-click the details record to close it.
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Remove a
Group/Family
Member

1. Click amember name in theMember List section to display
themember’s details record.

2. Locate the groupmember to be deleted in theAdditional
Members list.

3. Click the groupmember'sDelete button to remove the group
member from theAdditional Members list.

4. Click the tab'sClose button to close the screen.
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View the Member List for All Memberships
1. Navigate to theMember List screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectMemberships > Member List from themainmenu to display theMember List screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Click the tab'sClose button to close the screen.
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Manage a Member's Recurring Billing Information
Complete the following procedure to update billing information or renew amembership for amember of a
membership with recurring billing.

1. Navigate to theRecurring Membership Status screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectMemberships > Recurring Member List from themainmenu to display theRecurring
Membership Status screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedures as needed tomanage billing information for amember of a
membership with recurring billing:
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Edit a Member's
Billing Information

1. Click themember’sEdit button to display theCredit Card
Informationwindow.

2. Edit Credit Card information in the window.
Note: Required fields and settings are displayed with red
borders.

First Name Enter the card holder's first name as it
appears on the card.

Middle Initial Enter the card holder'smiddle initial as it
appears on the card.

Last Name Enter the card holder's last name as it
appears on the card.

Credit card
number

Enter the credit card number.

Expiration Date Enter the card's expiration date.
Billing Address Enter the street address for the card

holder's billing address.
Billing City Enter the city for the card holder's billing

address.
Billing State Enter the state for the card holder's billing

address.
Billing Zip Enter the ZIP code for the card holder's

billing address.
3. Click theSubmit button to save credit card information.
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Renew a Member's
Membership

1. Click themember’sEdit button to display theCredit Card
Informationwindow.

2. Click theRenew Membership button to display theRenew
Membershipwindow.

3. Click theRenew Membership button to display a renewal
confirmation window.

4. Click theOK button to close the confirmation window.
5. Click theSubmit button to close theCredit Card

Informationwindow.

3. Click the tab'sClose button to close the screen.
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Manage Recurring Payments
Complete the following procedure to process or update information for recurring payments.

1. Navigate to theProcess Membership Payments screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectMemberships > Process Payments from themainmenu to display theProcess
Membership Payments screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedures as needed tomanage recurring payments:
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Process a Payment Note: This proceduremay be used to process a payment for a single
member or to processmultiple payments for multiple members.

1. Complete the following procedures as needed to select one or
moremembers for payment processing:

l Check amember’sSelect checkbox to select the
member.

l Uncheck amember’sSelect checkbox to deselect the
member.

l Click theSelect All button to select all members for
processing.

l Click theClear All button to deselect all members for
processing.

2. If needed, check amember’sPay Monthly Fee checkbox to
include themonthlymembership fee in the payment.
(Uncheck the checkbox to process a payment without this
amount.)

3. If needed, check amember’sAcct Balance checkbox to
include the balance of the customer’s house account in the
payment. (Uncheck the checkbox to process a payment
without this amount.)

4. Click theSubmit button to display aCompleted confirmation
note above theClear All andSelect All buttons.
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Modify Payment
Information

Note: This proceduremay be used tomodify payment date and
amount for a singlemember or to modify payment date for multiple
members.

1. Complete the following procedures as needed to select one or
moremembers for payment informationmodification:

l Check amember’sSelect checkbox to select the
member.

l Uncheck amember’sSelect checkbox to deselect the
member.

l Click theSelect All button to select all members for
modification.

l Click theClear All button to deselect all members for
modification.

2. Complete either of the following as appropriate:
l If a singlemember was selected,

1. Click theChange Billing Date button to display
aChange Billing Datewindow withmember-
specific information.

2. If needed, enter a new due date in theSelect a
new due date in the future field to change the
billing date.

3. If needed, enter a new billing amount in theNext
billing amount field to change the billing
amount.

4. Click theSubmit button to display a verification
window.
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l If multiple members were selected,
1. Click theChange Billing Date button to display

aChange Billing Datewindow identifying the
number of members selected and a date change
field.

2. If needed, enter a new due date in theSelect a
new due date in the future field to change the
billing date.

3. Click theSubmit button to display a verification
window.

3. Click the tab'sClose button to close the screen.
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View Processed Payments
Complete the following procedure to view a record of processed recurring payments.

1. Navigate to theMembership Payments screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectMemberships > List Payments from themainmenu to display theMembership
Payments screen.

3. Enter starting and ending dates in theDate Range fields to display results from that time frame.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Click the tab'sClose button to close the screen.
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View Denied Payments
Complete the following procedure to view a record of denied recurring payments.

1. Navigate to thePayment Charge Denials screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectMemberships > List Denials from themainmenu to display thePayment Charge
Denials screen.

3. Enter starting and ending dates in theDate Range fields to display results from that time frame.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Click the tab'sClose button to close the screen.
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Education Administration
This section contains procedures to set up, edit, andmaintain educational classes and associated rosters of
participants.

Class Information
Class Information includes the class's title, description, date, time, location, cost, maximumnumber of
participants, and contact person details.

l Set Up and Edit a Class (see page 314)

Class Roster Information
ClassRoster Information includes the class information (title, description, date, time, location, cost, maximum
number of participants, and contact person) aswell as personal information (name, address, phone, and
email) for each registered participant.

l View and Update a ClassRoster (see page 317)
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Set Up and Edit a Class
Complete the following procedure to establish or update a class's title, description, date, time, location, cost,
maximumnumber of participants, and contact person details.

1. Navigate to theClass Maintenance screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectEducation > Class Maintenance from themainmenu to display theClass
Maintenance screen.

2. If needed, check theShow Past Classes checkbox to display all past and present classes.
3. Complete the following procedures as appropriate tomanage classes:

Create a New Class

1. Click theCreate New Class button to display theDefine/Edit
Classwindow.

2. Continue with the procedure below.
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Edit a Class

1. Click a class'sEdit button to display its to display its
Define/Edit Classwindow.

2. Continue with the procedure below.

Clone a Class

1. Click a class'sClone Class Information button to display a
completedDefine/Edit Classwindow.

2. Continue with the procedure below.
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Delete a Class

1. Click a product’sDelete button to display a deletion
confirmation window.

2. Click theYes button to remove the class from the list on the
Class Maintenance screen.

4. Enter/edit Class information in the window to reflect information for the appropriate class.
Note: Required fields and settings are displayed with red borders.

Class Title Enter the title of the class.
TheClass Titlewill display on theRegister screen.

Description Enter an extensive description of the class.
TheDescriptionwill display on theRegister screen when theClass
Title is clicked andmay be used to explain the class to customers.

Contact Name Enter the name of the contact person for the class.
Phone Number Enter the contact person's phone number (xxx-xxx-xxxx).
Address Enter the class location's street address.
City Enter the class location's city.
State Select the 2-letter abbreviation of the class location's state.
Postal Code Enter the class location's ZIP code.
Google Map HTML Enter the URL of the GoogleMap coordinates of the class's location.

(This information will be useful when future software developments
allow for online class registration.)

Class Date Enter the class's date (mm/dd/yyyy) or Select a Date (see page 24)
with the calendar button.

Class Time Select the class's start time (24-hour/military clock) from the drop-down
menu.

Last Web Registration
Date

Enter the last date for class registration (mm/dd/yyyy) or Select a Date
(see page 24) with the calendar button. (The system automatically
enters the day before the class's start date, but the date can be edited
to provide adequate lead time for the instructor.)

Max Participants Enter themaximumnumber of participants that may enroll in the class.
Class Cost Enter the cost for the class.

5. Click theSubmit button to add/update the class on theClass Maintenance screen.
6. Click the tab'sClose button to close the screen.
7. If needed, Manage Facility Reservations (see page 284) (classroom, range, etc.) for the class.
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View and Update a Class Roster
Complete the following procedure to review, update, and utilize a class's roster of registered participants.

1. Navigate to theClass Rosters screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectEducation > Class Rosters from themainmenu to display theClass Rosters screen.

2. If needed, check theShow Historical Classes checkbox (and click theRefresh button) to display all
past and present classes.

3. Click a class to display itsCourse Description record and a roster of registered participants.

4. Complete the following procedures as appropriate tomanage class rosters:
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Edit a Class Roster

1. Click a participant’sDelete button to display a removal
confirmation window.

2. Click theYes button to remove the name from the roster.
3. Continue with the procedure below to close the roster and the

screen.

Print a Class
Roster/Check-In
Form

1. Right-click in the roster section to display amenu of options.

2. Click theCopy To Excel option to open the Excel program
and display the roster as a spreadsheet.

3. Select File > Save As from themenu bar to display theSave
Aswindow.

4. Save and print the document for use as a hardcopy check-in
form.

5. Continue with the procedure below to close the roster and the
screen.

5. Double-click theCourse Description record to close the roster.
6. Click the tab'sClose button to close the screen.
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Pricing Administration
This section contains procedures to set up, edit, andmaintain price types, tax types, and special pricing
calculators includingmarkup categories, sales events, and split quantity events.

Price Types
Price Types allow supplemental pricing information (e.g., MSRP, MAP, etc.) to be associated with a product
to aid purchasing andmanagement decisions.

l Manage Price Types (see page 320)

Tax Types
Tax Types allow specific taxes (e.g., State, City, Firearms, etc.) to be associated with a product. A TaxRate
may be assigned to a Tax Type for a defined period of time.

l Manage Tax Types (see page 321)

Markup Categories
Markup Categories calculate new prices for associated products using a specifiedmarkup (dollar amount or
percentage) method.

l ManageMarkup Categories (see page 323)

Sales Events
Sales Events define time periods during which the system calculates temporary sale prices for associated
products using a specified adjustment (dollar amount or percentage) method.

l Manage Sales Events (see page 327)

Split Quantity Pricing Events
Split Quantity Pricing Events define time periods during which the system calculates special prices for
associated products purchased in defined quantities using a specified adjustment (dollar amount or
percentage) method.

l Manage Split Quantity Pricing Events (see page 331)
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Manage Price Types
1. Navigate to thePrice Types screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectPricing > Price Types from themainmenu to display thePrice Types screen.

2. Complete the following procedures as needed tomanage price types:

Set Up a New Price
Type

1. Click theNew Price Type button to display theDefine/Edit
Price Typewindow.

2. Continue with the procedure below.

Edit a Price Type 1. Click a pricing type’sEdit button to display itsDefine/Edit
Price Typewindow.

2. Continue with the procedure below.

Delete a Price Type 1. Click a pricing type’sDelete button to display a deletion
confirmation window.

2. Click theYes button to remove the pricing type from thePrice
Types screen.

3. Click the tab'sClose button to close the screen.
3. Enter/edit the pricing type's name in thePricing Type field.
4. Enter/edit the pricing type's description in theDescription field.
5. Click theSubmit button to display the new/updated pricing type on thePrice Types screen.
6. Click the tab'sClose button to close the screen.
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Manage Tax Types
1. Navigate to the Tax Types screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectPricing > Tax Types from themainmenu to display the Tax Types screen.

2. Complete the following procedures as needed tomanage tax types:

Set Up a New Tax
Type

1. Click theNew Tax Type button to display theDefine/Edit
Tax Typewindow.

2. Continue with the procedure below.

Edit a Tax Type 1. Click a tax type’sEdit button to display itsDefine/Edit Tax
Typewindow.

2. Continue with the procedure below.

Add a Tax Rate to a
Tax Type

1. Click a tax type’sRates button to display itsTax Rate
Informationwindow.

2. Enter the tax rate as a decimal in theRate (in decimal form)
field.

3. Enter the date to start collecting the tax in theStart Date field.
4. Click theSubmit button to add the new tax rate to the Tax

Rate Informationwindow.
5. Click theClose button to close the Tax Rate Information

window.
Note: The tax type'sCurrent Rate column on the Tax Types
screen will display "0.0000" until the tax rate's start date.
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Remove a Tax Rate
from a Tax Type

1. Click a tax type’sRates button to display itsTax Rate
Informationwindow.

2. Click a tax rate’sDelete button to remove it from the list.
3. Click theClose button to close the Tax Rate Information

window.

Delete a Tax Type 1. Click a tax type’sDelete button to display a deletion
confirmation window.

2. Click theYes button to remove the tax type from the Tax
Types screen.

3. Click the tab'sClose button to close the screen.
3. Enter/edit the tax type's name in the Tax Type field.
4. Enter/edit the tax type's description in theDescription field.
5. Click theSubmit button to display the new/updated tax type on the Tax Types screen.
6. If needed, define a tax rate for this tax type.

Note: Refer toAdd a Tax Rate to a Tax Type for more information.

7. Click the tab'sClose button to close the screen.
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Manage Markup Categories
1. Navigate to theMarkup Categories screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectPricing > Markups from themainmenu to display theMarkup Categories screen.

2. Complete the following procedures as needed tomanagemarkup categories:

Set Up a New
Markup Category

1. Click theCreate New Markup Category button to display
theDefine/Edit Markup Categorywindow.

2. Continue with the procedure below.

Edit a Markup
Category

1. Click a category’sEdit button to display itsDefine/Edit
Markup Categorywindow.

2. Continue with the procedure below.

Add a Product to a
Markup Category

1. Click a category to display itsMarkup Category Items
record.

2. Click theAdd Products button to display theProduct
Searchwindow.

3. Select One or More Products (see page 28) to be added to the
category.

4. If needed, recalculate product prices set new prices for added
products.
Note: Refer toRecalculate Product Prices with a Markup
Category for more information.

5. Double-click theMarkup Category Items record to close it.
6. Click the tab'sClose button to close the screen.
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Remove a Product
from a Markup
Category

1. Click a category to display itsMarkup Category Items
record.

2. Click a product’sDelete button to display a deletion
confirmation window.

3. Click theYes button to remove the product from theMarkup
Category Items record.

4. Double-click theMarkup Category Items record to close it.
5. Click the tab'sClose button to close the screen.
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Recalculate Product
Prices with a Markup
Category

1. Click a category to display itsMarkup Category Items
record.

2. If needed, add one or more products to themarkup category.
Note: Refer toAdd a Product to a Markup Category for
more information.

3. Click theRecalculate Prices button to display theDefine
Markup Rounding Optionwindow.

4. Select one of these roundingmethods from theRounding
Type drop-down field:

l No Rounding : Calculates a price that is equal to the
Current Price.

l Round to Nearest Value : Calculates a price by
rounding the cost up or down to the closest amount that
matches theRound To settings.

l Round Up : Calculates a price by rounding the cost up
to the next higher amount that matches theRound To
settings.

l Round Down : Calculates a price by rounding the cost
down to the next lower amount that matches the
Round To settings.

5. If needed, enter values in theDollar Round To,Dime
Round To, and/or Penny Round To fields to generate
calculated priceswith specific digits in designated places.

6. Click theSubmit button to display a recalculated price in the
product’sCalculated Price field.

7. If desired, click theSave Price Adjustment button to save
the calculated price for the product.

8. Double-click theMarkup Category Items record to close it.
9. Click the tab'sClose button to close the screen.
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Delete a Markup
Category

1. Click a category’sDelete button to display a deletion
confirmation window.

2. Click theYes button to remove the category from theMarkup
Categories screen.

3. Click the tab'sClose button to close the screen.
3. Enter/edit the category's name in theCategory Name field.
4. Select an adjustment type from theAdjustment Type drop-down field:

l SelectDollar Amount to mark up prices by a fixed amount.
l SelectPercentage to mark up prices by a percentage of cost.

5. Enter a value in theAdjustment Value field:
l IfDollar Amountwas selected as theAdjustment Type, enter themarkup amount in dollars.
l If Percentagewas selected as theAdjustment Type, enter themarkup amount as a
percentage.

6. Click theSubmit button to display the new/updated category on theMarkup Categories screen.
7. Click the tab'sClose button to close the screen.
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Manage Sales Events
1. Navigate to theSales Events screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectPricing > Sales Events from themainmenu to display theSales Events screen.

2. Complete the following procedures as needed tomanage sales events:

Set Up a New Sales
Event

1. Click theCreate New Sales Event button to display the
Define/Edit Sales Eventwindow.

2. Continue with the procedure below.

Edit a Sales Event 1. Click an event’sEdit button to display itsDefine/Edit Sales
Eventwindow.

2. Continue with the procedure below.
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Add a Product to a
Sales Event

1. Click an event to display itsSale Event Products and
Pricing record.

2. Click theAdd Products button to display theProduct
Searchwindow.

3. Complete any of these procedures to limit the number of
products shown:

l Enter all or part of a product’s description in the
Description field.

l Enter all or part of a product’s UPC code number in the
UPC field.

l Click anAttribute button and one of its associated
Descriptor buttons. (Repeat as needed to further
restrict products with additional attributes and
descriptors.)

l Click theClear button to remove all Attribute/Descriptor
filters.

4. Complete any of these procedures to select the desired
product(s):

l Check a product’s checkbox to select it.
l Uncheck a product's checkbox to deselect it.
l Click theSelect All button to select all products.
l Click theUnselect All button to deselect all products.

5. Complete one of these procedures as appropriate to add the
selected product(s) and adjusted price(s) to theSale Event
Products and Pricing record:

l To adjust the price(s) by a dollar amount
1. Enter the dollar amount in theAdjustment field.
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Be sure to include aminus sign (-) to reduce the
price by that amount.

2. Click theAdjust Selection by Amount button.
l To adjust the price(s) by a percentage,

1. Enter the percentage as a decimal in the
Adjustment field. Be sure to include aminus
sign (-) to reduce the price by that percentage.

2. Click theAdjust Selection by Percentage
button.

6. If needed, edit a product's sales price.
Note: Refer toEdit a Product’s Sales Event Price for
more information.

7. Double-click theSale Event Products and Pricing record
to close it.

8. Click the tab'sClose button to close the screen.

Remove a Product
from a Sales Event

1. Click an event to display itsSale Event Products and
Pricing record.

2. Click a product’sDelete button to display a deletion
confirmation window.

3. Click theYes button to remove the product from theSale
Event Products and Pricing record.

4. Double-click theSale Event Products and Pricing record
to close it.

5. Click the tab'sClose button to close the screen.
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Edit a Product’s
Sales Event Price

1. Click an event to display itsSale Event Products and
Pricing record.

2. If needed, add one or more products to the sale event.
Note: Refer to for more information.

3. Click a product’sEdit button to display theEdit Sale Price
window.

4. Enter the new sale price in theSale Price field.
5. Click theSubmit button to display the new price in the

product’sSales Price field.
6. Double-click theSale Event Products and Pricing record

to close it.
7. Click the tab'sClose button to close the screen.

Delete a Sales Event 1. Click an event’sDelete button to display a deletion
confirmation window.

2. Click theYes button to remove the category from theSales
Events screen.

3. Click the tab'sClose button to close the screen.
3. Enter/edit the sales event's name in theEvent Name field.
4. Enter/edit the event’s start date (mm/dd/yyyy) or Select a Date (see page 24) with the calendar button

in theStart Date field.
5. Enter/edit the event’s start time in theStart Time field.
6. Enter/edit the event’s end date (mm/dd/yyyy) or Select a Date (see page 24) with the calendar button in

theEnd Date field.
7. Enter/edit the event’s end time in theEnd Time field.
8. Click theSubmit button to display the new/updated event on theSales Events screen.
9. Click the tab'sClose button to close the screen.
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Manage Split Quantity Pricing Events
1. Navigate to theSplit Quantity Events screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectPricing > Split Quantity Pricing from themainmenu to display theSplit Quantity
Events screen.

2. Complete the following procedures as needed tomanage split quantity pricing events:

Set Up a New Split
Quantity Pricing
Event

1. Click theCreate New Split Quantity Event button to display
theDefine/Edit Split Quantity Eventwindow.

2. Continue with the procedure below.

Edit a Split Quantity
Pricing Event

1. Click an event’sEdit button to display itsDefine/Edit Split
Quantity Eventwindow.

2. Continue with the procedure below.
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Add a Product to a
Split Quantity
Pricing Event

1. Click an event to display itsSplit Quantity Event Products
and Pricing record.

2. Click theAdd Products button to display theProduct
Searchwindow.

3. Complete any of these procedures to limit the number of
products shown:

l Enter all or part of a product’s description in the
Description field.

l Enter all or part of a product’s UPC code number in the
UPC field.

l Click anAttribute button and one of its associated
Descriptor buttons. (Repeat as needed to further
restrict products with additional attributes and
descriptors.)

l Click theClear button to remove all Attribute/Descriptor
filters.

4. Complete any of these procedures to select the desired
product(s):

l Check a product’s checkbox to select it.
l Uncheck a product's checkbox to deselect it.
l Click theSelect All button to select all products.
l Click theUnselect All button to deselect all products.

5. Complete one of these procedures as appropriate to add the
selected product(s) and adjusted price(s) to theSplit
Quantity Event Products and Pricing record:

l To adjust the price(s) by a dollar amount
1. Enter the dollar amount in theAdjustment field.

Be sure to include aminus sign (-) to reduce the
price by that amount.

2. Click theAdjust Selection by Amount button.
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l To adjust the price(s) by a percentage,
1. Enter the percentage as a decimal in the

Adjustment field. Be sure to include aminus
sign (-) to reduce the price by that percentage.

2. Click theAdjust Selection by Percentage
button.

6. If needed, edit a product's split quantity event price.
Note: Refer toEdit Product’s Split Quantity Pricing
Event Price for more information.

7. Double-click theSplit Quantity Event Products and
Pricing record to close it.

8. Click the tab'sClose button to close the screen.

Remove a Product
from a Split Quantity
Pricing Event

1. Click an event to display itsSplit Quantity Event Products
and Pricing record.

2. Click a product’sDelete button to display a deletion
confirmation window.

3. Click theYes button to remove the product from theSplit
Quantity Event Products and Pricing screen.

4. Double-click theSplit Quantity Event Products and
Pricing record to close it.

5. Click the tab'sClose button to close the screen.

Edit a Product’s
Split Quantity
Pricing Event Price

1. Click an event to display itsSplit Quantity Event Products
and Pricing record.

2. If needed, add one or more products to the split quantity
event.
Note: Refer to for more information.

3. Click a product’sEdit button to display theEdit Split
Quantity Pricewindow.

4. Enter the new sale price in theSale Price field.
5. Click theSubmit button to display the new price in the

product’sSales Price field.
6. Double-click theSplit Quantity Event Products and

Pricing record to close it.
7. Click the tab'sClose button to close the screen.
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Delete a Split
Quantity Pricing
Event

1. Click an event’sDelete button to display a deletion
confirmation window.

2. Click theYes button to remove the event from theSplit
Quantity Events screen.

3. Click the tab'sClose button to close the screen.
3. Enter/edit the split quantity event's name in theEvent Name field.
4. Enter/edit the event’s start date (mm/dd/yyyy) or Select a Date (see page 24) with the calendar button

in theStart Date field.
5. Enter/edit the event’s start time in theStart Time field.
6. Enter/edit the event’s end date (mm/dd/yyyy) or Select a Date (see page 24) with the calendar button in

theEnd Date field.
7. Enter/edit the event’s end time in theEnd Time field.
8. Enter/edit the event’s price break quantity in thePrice Break Quantity field.
9. Click theSubmit button to display the new/updated event on theSplit Quantity Events screen.
10. Click the tab'sClose button to close the screen.
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Purchasing Administration
This section contains procedures to set up, maintain, and review vendors, vendor catalogs, purchase orders,
and special order products.

Vendor Information
Vendor Information includes the vendor's name, addresses, phone numbers, email addresses, websites,
contacts, FFL number, FTP information, and various identifiers.

l Select a Vendor (see page 336)
l Set Up andMaintain a Vendor Record (see page 338)
l Set Up and Edit a Vendor Contact (see page 341)
l View and Update the Vendor List (see page 344)
l Import Vendor Data into the Vendor List (see page 345)

Vendor Catalogs
Vendor Catalogs provide a list of the products available for purchase from a specific vendor.

l View, Update, and Add Products from a Vendor Catalog (see page 346)

Purchase Order Features
PurchaseOrder Features provide procedures for manually ordering products, tracking unfulfilled orders, and
streamlining the Receiving process.

l Create a PurchaseOrder (see page 349)
l Import PurchaseOrder Data (see page 351)
l Create a Vendor PurchaseOrder (see page 353)
l Update a Pending PurchaseOrder (see page 355)

Special Order Features
Special Order Features allow special orders to be reviewed, edited, printed, and assigned to purchase orders.

l View and Update Special Orders (see page 359)
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Select a Vendor
Note: This procedure selects an existing vendor from the vendor database for review andmaintenance of
the vendor 's record. To add a new vendor to the database, refer to Set Up andMaintain a Vendor Record
(see page 338).

1. Navigate to theVendor Look-upwindow.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectPurchasing > Select Vendor from themainmenu to display theVendor Look-up
window.

2. If needed, enter all or part of the vendor's name in theName field and press theEnter key to display all
matching results.

3. Double-click a name to display the vendor'sVendor Information for screen.

4. Complete the following procedure to edit the vendor record as needed:
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1. Enter/edit Vendor information on the screen.
Note: Refer to Set Up andMaintain a Vendor Record (see page 338) for more information.

2. Click theSubmit Changes button to display a save confirmation window.
3. Click theClose button to close the confirmation window.

5. Click the tab'sClose button to close the screen.
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Set Up and Maintain a Vendor Record
1. Complete the following procedures as appropriate tomaintain vendor records on theVendor

Information for screen.

Add a Vendor
Record

1. SelectPurchasing > Add New Vendor from themainmenu
to display a blankVendor Information for screen.

2. Continue with the procedure below.

Edit a Vendor
Record

1. Select a Vendor (see page 336).
2. Continue with the procedure below.

2. Enter/edit Vendor information on the screen.
Note: Required fields and settings are displayed with red borders.

Vendor Name Enter the vendor's name.
FTP Address Enter the vendor's FTP address.
FTP User ID Enter the vendor's FTP user name.
FTP Password Enter the vendor's FTP password.
Dun Bradstreet # Enter the vendor's Dun Bradstreet number.
FFL Number Enter the vendor's FFL number.
Vendor Expiration
Date

Enter the vendor's expiration date (mm/dd/yyyy) or Select a Date (see page
24) with the calendar button.

Vendor Terms Enter the vendor's terms.
Vendor Notes Enter notes about the vendor.
Back Orders If the vendor accepts back orders, check the checkbox.
Lead Time Days Enter the number of days needed to process an order before shipping.
Is Transfer Agent If the vendor is a transfer agent, check the checkbox.
Is Manufacturer If the vendor is amanufacturer, check the checkbox.
Auto Order If auto order is active for the vendor, check the checkbox.
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Customer # Enter the vendor's customer number.
Shipping Break
Minimum

Enter the vendor's shipping breakminimum.

Addresses If an address record is not needed, click itsClose (redX) button to close it.
If an additional address record is needed, click theAdd (green +) button to
open it.
Preferred If this address record is the preferredmethod of

contact, check the checkbox.
Type Select the appropriate value from the drop-down

menu.
Address 1 Enter the first line of the street address.
Address 2 Enter the second line of the street address (if

applicable).
City Enter the city.
State Enter the two-letter abbreviation for the state.
Zip Enter the ZIP code.

Phones If a phone record is not needed, click itsClose (redX) button to close it.
If an additional phone record is needed, click theAdd (green +) button to
open it.
Preferred If this phone record is the preferredmethod of

contact, check the checkbox.
Type Select the appropriate value from the drop-down

menu.
Voice If this phone number can receive voice calls, check

the checkbox.
Text If this phone number can receive text messages,

check the checkbox.
Phone Number Enter the entire (xxx-xxx-xxxx) phone number.

Emails If an email record is not needed, click itsClose (redX) button to close it.
If an additional email record is needed, click theAdd (green +) button to
open it.
Preferred If this email record is the preferredmethod of

contact, check the checkbox.
Type Select the appropriate value from the drop-down

menu.
Email Address Enter the entire email address.

Web Sites If a website record is not needed, click itsClose (redX) button to close it.
If an additional website record is needed, click theAdd (green +) button to
open it.
Preferred If this website record is the preferredmethod of

contact, check the checkbox.
Type Select the appropriate value from the drop-down

menu.
URL Address Enter the website's URL address.
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Contacts If a contact record is not needed, click itsClose (redX) button to delete it.
If an additional contact record is needed, click theAdd (green +) button to
open a blankContact Informationwindow.
To view or edit an existing contact record, click the record'sView button to
display the contact'sContact Informationwindow.
Note: Refer to Set Up and Edit a Vendor Contact (see page 341) for more
information.

3. Click theSubmit Changes button to display a save confirmation window.
4. Click theClose button to close the confirmation window.
5. Click the tab'sClose button to close the screen.
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Set Up and Edit a Vendor Contact
1. Navigate to the desired vendor'sVendor Information for screen.

Note: Refer to Set Up andMaintain a Vendor Record (see page 338) for more information.

2. Complete the following procedures as needed tomanage vendor contacts:

Add a Contact

1. Click theAdd (green +) button beside theContacts heading
to display theContact Informationwindow.

2. Continue with the procedure below.
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Edit a Contact

1. Click a contact’sView button to display the contact’sContact
Informationwindow.

2. Continue with the procedure below.

Delete a Contact

1. Click a contact’sClose (redX) button to delete it from the
Vendor Information for screen.

2. Click theSubmit Changes button to display a save
confirmation window.

3. Click theClose button to close the confirmation window.
4. Click the tab'sClose button to close the screen.

3. Enter/edit Vendor Contact information in the window.
Note: Required fields and settings are displayed with red borders.

First Enter the contact's first name.
Last Enter the contact's last name.
Title Enter the contact's title.
Addresses If an address record is not needed, click itsClose (redX) button to close it.

If an additional address record is needed, click theAdd (green +) button to
open it.
Preferred If this address record is the preferredmethod of

contact, check the checkbox.
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Type Select the appropriate value from the drop-down
menu.

Address 1 Enter the first line of the street address.
Address 2 Enter the second line of the street address (if

applicable).
City Enter the city.
State Enter the two-letter abbreviation for the state.
Zip Enter the ZIP code.

Phones If a phone record is not needed, click itsClose (redX) button to close it.
If an additional phone record is needed, click theAdd (green +) button to
open it.
Preferred If this phone record is the preferredmethod of

contact, check the checkbox.
Type Select the appropriate value from the drop-down

menu.
Voice If this phone number can receive voice calls, check

the checkbox.
Text If this phone number can receive text messages,

check the checkbox.
Phone Number Enter the entire (xxx-xxx-xxxx) phone number.

Emails If an email record is not needed, click itsClose (redX) button to close it.
If an additional email record is needed, click theAdd (green +) button to
open it.
Preferred If this email record is the preferredmethod of

contact, check the checkbox.
Type Select the appropriate value from the drop-down

menu.
Email Address Enter the entire email address.

4. Click theSave button to close the window and display the contact information on theVendor
Information for screen.

5. Click theSubmit Changes button to display a save confirmation window.
6. Click theClose button to close the confirmation window.
7. Click the tab'sClose button to close the screen.
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View and Update the Vendor List
1. Navigate to theVendor List screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectPurchasing > Vendor List from themainmenu to display theVendor List screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedures as needed:

View a List of
Vendor Contacts

1. Click a vendor to display the vendor’sVendor Contacts
window.

2. Click theOK button to close the window.

Import Vendor Data Refer to Import Vendor Data into the Vendor List (see page 345) for
more information.

3. Click the tab'sClose button to close the screen.
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Import Vendor Data into the Vendor List
Complete the following procedure to import vendor data into theVendor List screen by creating, populating,
and importing a formatted Excel file.

1. Navigate to theVendor List screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectPurchasing > Vendor List from themainmenu to display theVendor List screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Click the Template button to export the template format to an Excel file.
3. Populate the Excel file with vendor information.
4. Save the Excel file.
5. Click the Import button on theVendor List screen to display the Load Excel Importwindow.
6. Browse to the desired location.
7. If the system detects any errors, it displays the Import Complete with Errorswindow.

Complete any of the following as needed:
l Click thePrint/Save button to display the errors in a formatted template file that may be
manually printed and/or saved. Click another button as appropriate to close this window.

l Click theContinue button to continue with the import for the uploaded items.
l Click theCancel button to cancel the import.

8. When the import is complete, the system displays theUpload Completewindow.
9. Click theClose button to close the window.
10. Click the tab'sClose button to close the screen.
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View, Update, and Add Products from a Vendor
Catalog

1. Navigate to theVendor Catalog Detail screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectPurchasing > Vendor Catalog from themainmenu to display theVendor Catalog
Detail screen.

2. Complete the following procedures as appropriate tomaintain vendor catalogs.

View/Update the
AcuSport Catalog

1. ClickAcuSport in theSelect Vendor list to display the
AcuSport catalog on theVendor Catalog Detail screen.

2. If needed, click theUpdate Catalog button to refresh the
screen.
Note: If needed, Sort and Filter Onscreen Data (see page
40).
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View/Update a Non-
AcuSport Vendor
Catalog

1. Complete these procedures as needed to restrict the vendors
displayed in theSelect Vendor list:

l Check theShow Active Only checkbox to show only
active vendors in the list.

l Enter all or part of a vendor’s name in the field to show
onlymatching vendors.

2. Click a vendor name in theSelect Vendor list to display that
vendor on theVendor Catalog Detail screen.

3. Click theUpdate Catalog button to display anOpenwindow.
4. Browse to the desired location and double-click the

appropriate file (.xlsx format) containing the vendor catalog to
upload it.
Note: The vendor catalog file must be a formatted Excel
spreadsheet (.xlsx format) containing 15 columns named and
arranged (left-to-right) in the order shown below:

Vendor Part # The vendor part number
MFG Part # Themanufacturer's part number
Receipt Description A short (32 characters or less)

description that will print on the
register receipt

Item Description A long (80 characters or less)
description of the item used at
the register

Size Size
Color Color
UoM Unit of measure
Catalog Pg Catalog page number
Class Class (Item attribute descriptor)
Mfg Manufacturer
UPC TheUPC code number with

check digit included
Cost Cost
Retail Retail price
Weight Weight
Sell Pack Sell pack

5. If needed, Sort and Filter Onscreen Data (see page 40).

3. Complete the following procedure as appropriate to add catalog products to the product database.
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Add a Vendor
Catalog Product to
the Product
Database

1. Check a product’sAdd checkbox to select it. (Repeat as
needed to select additional products.)

2. Click theAdd Product button to add the selected product(s)
to theProduct Maintenance screen.
Note: To display theProduct Maintenance screen, click the
Inventory Management tab. Then click theProduct
Maintenance button.

4. Click the tab'sClose button to close the screen.
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Create a Purchase Order
1. Navigate to thePurchase Orders screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectPurchasing > Create Purchase Orders from themainmenu to display thePurchase
Orders screen.

2. Use onscreen controls as needed to restrict and sort the products displayed on the screen:
l Check theClick to show inactive products checkbox to display both active and inactive
products.

l Uncheck theClick to show inactive products checkbox to display only active products.
l Click anAttribute button and one of its associatedDescriptor buttons to display only products
with matching attribute/descriptor pairs. (Repeat as needed to further restrict the products
displayed with additional attribute/descriptor pairs.)

l Click theDelete button beside an attribute/descriptor pair to remove it as a restriction on
displayed products.

l Click theClear button to remove all attribute/descriptor pairs to remove them as restrictions on
displayed products.

l Enter starting and ending dates in theNumber Sold Date Range fields and press theEnter
key to display only sales results from a specific time frame.

l Sort and Filter Onscreen Data (see page 40).
3. Check a product’s checkbox to select it. (Repeat steps as needed to display and select additional

products. Click theClear selected products button to deselect all products.)
4. If desired, check theDisplay only selected products checkbox to display only selected items on the

screen.
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5. Click theNext button to display thePurchase Orders (Enter the Quantity, Price, and Vendor)
screen.

6. Select the desired vendor from a product’sOrder From Vendor drop-down field. (Selecting a vendor
for one product will autoselect that vendor for all products. Select a different vendor for other products
as needed.)

7. Enter a quantity for each product in itsQuantity field.
8. Enter/edit the cost for each product in itsCost field as needed.
9. If needed, click a product’sDelete button to remove it from the list.
10. Click theNext button to display thePurchase Orders (Process Purchase Orders) screen.
11. Continue working with the purchase order as appropriate.

Note: Refer to Update a Pending PurchaseOrder (see page 355) for more information.

12. Click the tab'sClose button to close the screen.
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Import Purchase Order Data
Complete the following procedure to import purchase order data into thePurchase Orders screen by
creating, populating, and importing a formatted Excel file.

1. Navigate to thePurchase Orders screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectPurchasing > Create Purchase Orders from themainmenu to display thePurchase
Orders screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Click the Template button to export the template format to an Excel file.

3. Populate the Excel file with purchase order information.
Note: The file must adhere to the validation requirements indicated in row 1 and below:

l UPC andQuantity are required fields.
4. Save the Excel file.

5. Click the Import button on thePurchase Orders screen to display the Load Excel Importwindow.
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6. Browse to the desired location.
7. If the system detects any errors, it displays the Import Complete with Errorswindow.

Complete any of the following as needed:
l Click thePrint/Save button to display the errors in a formatted template file that may bemanually
printed and/or saved. Click another button as appropriate to close this window.

l Click theContinue button to continue with the import for the uploaded items.
l Click theCancel button to cancel the import.

8. When the import is complete, the system displays theUpload Completewindow.

9. Click theClose button to close the window.
10. Click the tab'sClose button to close the screen.
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Create a Vendor Purchase Order
1. Navigate to theCreate Purchase Order screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectPurchasing > Create Vendor Purchase Order from themainmenu to display the
Create Purchase Order screen and theVendor Look-upwindow.

3. If needed, enter all or part of the vendor's name in theName field and press theEnter key to
display all matching results.

4. Double-click a name to select the vendor and close theVendor Look-upwindow.

2. Use onscreen controls as needed to restrict and sort the products displayed on the screen:
l Click anAttribute button and one of its associatedDescriptor buttons to display only products
with matching attribute/descriptor pairs. (Repeat as needed to further restrict the products
displayed with additional attribute/descriptor pairs.)

l Click theDelete button beside an attribute/descriptor pair to remove it as a restriction on
displayed products.

l Click theClear button to remove all attribute/descriptor pairs to remove them as restrictions on
displayed products.

l Enter starting and ending dates in theNumber Sold Date Range fields and press theEnter
key to display only sales results from a specific time frame.

l Sort and Filter Onscreen Data (see page 40).
3. Select the desired product(s):

l Check a product’s checkbox to select it. (Repeat as needed to select additional products.)
l Uncheck a product's checkbox to deselect it.
l Click theSelect All button to select all products on the screen.
l Click theClear Selected Products button to deselect all products.
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4. Click theAdd Products button to add the selected product(s) to thePurchase Order Details section.
5. Complete the following procedures as needed to enter a quantity for each product:

l Enter a quantity in a product’sQuantity field.
l Click the Fill to Suggested Order Qty button to display a confirmation screen. Click theYes
button to close the screen and automatically populate theQuantity field(s).
Note: The system calculates the suggested order quantity for a product by subtracting itsQOH
from itsMax Level. If the product'sQOH is greater than itsMin Level, the system does not
calculate a suggested order quantity for the product.

6. Complete the following procedures as needed to assign the selected product(s) to a purchase order:

Create a New
Purchase Order

Click theCreate PO button to display thePurchase Orders
(Process Purchase Orders) screen.

Amend an Existing
Purchase Order

1. Select the desired existing purchase order from the drop-
down field.

2. Click theAdd to Existing PO button to display thePurchase
Orders (Process Purchase Orders) screen.

7. Continue working with the purchase order as appropriate.
Note: Refer to Update a Pending PurchaseOrder (see page 355) for more information.

8. Click the tab'sClose button to close the screen.
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Update a Pending Purchase Order
1. Navigate to thePurchase Orders (pending) screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectPurchasing > Pending Purchase Orders from themainmenu to display the
Purchase Orders (Process Purchase Orders) screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedures as needed tomanage pending purchase orders:

Edit a Pending
Purchase Order

1. Click a purchase order’sEdit button to display theEdit
Purchase Order window.

2. Edit PurchaseOrder information in the window as needed.

Vendor Select the vendor from the drop-down.
Ship To Store Select the store from the drop-down.
PO Terms Enter terms as needed.
Cancellation
Date

Enter the cancellation date (mm/dd/yyyy)
or Select a Date (see page 24) with the
calendar button.

Ship Date Note the autofilled ship date. If needed,
enter a new ship date (mm/dd/yyyy) or
Select a Date (see page 24) with the
calendar button.

Ship Via Enter the shippingmethod.
Shipping
Account

Enter the shipping account number.

3. Click the Finished button to close theEdit Purchase Order
window.
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Add a Product 1. Click a purchase order’sEdit button to display theEdit
Purchase Order window.

2. Click theAdd Product button to display theProduct Search
screen.

3. Select a Single Product (see page 27) to add it to the
purchase order. (Repeat steps as needed to add additional
products to the purchase order.)

4. Click the Finished button to close theEdit Purchase Order
window.

Edit a Product 1. Click a purchase order’sEdit button to display theEdit
Purchase Order window.

2. Complete the following procedures as needed:
l Edit a product’s quantity in itsQuantity field.
l Edit a product’s cost in itsCost field.

3. Click the Finished button to close theEdit Purchase Order
window.

Remove a Product 1. Click a purchase order’sEdit button to display theEdit
Purchase Order window.

2. Click a product’sDelete button to remove it from the purchase
order.

3. Click the Finished button to close theEdit Purchase Order
window.

Delete a Purchase
Order

Click a purchase order’sDelete button to remove it from the
Purchase Orders (Process Purchase Orders) screen.
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Process a Purchase
Order

1. Click a purchase order’sProcess button to display the
Purchase Order Previewwindow.

2. Edit PurchaseOrder Preview information in the window as
needed.

Ship To Store Select the appropriate store from the
drop-down field.

PO Terms Enter terms as needed.
Cancellation
Date

Enter the cancellation date (mm/dd/yyyy)
or Select a Date (see page 24) with the
calendar button.

Ship Date Enter the ship date (mm/dd/yyyy) or
Select a Date (see page 24) with the
calendar button.

Ship Via Enter the shippingmethod.
Shipping
Account

Enter the shipping account number.

Email Address Select the desired vendor email address
from the drop-down field.

Exclude
Ordered
Quantity

Check the checkbox to prevent the system
from considering the ordered item(s)
when performingMin/Max calculations for
Auto Order numbers or suggested
quantities for purchase orders.

Bill To Name Enter/edit the store name as needed.
Bill To Address
1

Enter/edit the first line of the street
address as needed.

Bill To Address
2

Enter/edit the second line of the street
address as needed.

Bill To City Enter/edit the city as needed.
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Bill To State Enter/edit the two-letter abbreviation for
the state as needed.

Bill To Zip Enter/edit the ZIP code as needed.
Bill To Country Enter/edit the country as needed.

3. Click theRefresh Preview button to update the preview at
the bottom of the window.

4. Review, print, and/or export the purchase order as needed.
5. Complete one of the following procedures as appropriate to

process the purchase order for receiving:
6. l To email a PDF of the completed purchase order to the

selectedEmail Address, click theSubmit button.
l To print a hardcopy of the purchase order,

1. Click thePrint Report button to display aPrint
window.

2. Click thePrint button to print the document and
close the window.

3. Click theMark as Sent button.
l To export an electronic version of the purchase order,

1. Select a format from the drop-down field.
2. Click theExport button to display aSave As

window.
3. Save and Print a Document (see page 48) to

create electronic and hardcopy versions of the
purchase order.

4. Click theMark as Sent button.
3. Click the tab'sClose button to close the screen.
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View and Update Special Orders
1. Navigate to theSpecial Orders Report screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectPurchasing > Special Orders Report from themainmenu to display theSpecial
Orders Report screen.

3. Complete the following procedure to display a selection of special orders on theSpecial Orders
Report screen:

1. Enter starting and ending dates in theDate Range fields to display special orders from
that time frame.

2. If needed, check theShow Outstanding Orders Only checkbox to display only special
orders that have not been fulfilled.

3. Click theSubmit button.
4. If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedures as needed tomanage special orders:

Edit a Special
Order’s Notes

1. Click a special order'sEdit Notes button to display theEdit
the special order notewindow.

2. Edit the text in the field.
3. Click theOK button to close the window.

View a Special
Order’s Component
Record

1. Click the special order’sExpand (+) button to display its
component record.

2. Click the special order’sContract (–) button to close its
component record.
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View a Special
Order’s Details

1. Click a special order'sView button to display theSpecial
Order Requestwindow.

2. Click theClose button to close the window.

Add a Product 1. Click a special order'sView button to display theSpecial
Order Requestwindow.

2. Complete one of these procedures to add a product to the
special order:

l Scan a UPC in theScan or Enter UPC field.
l Enter a UPC in theScan or Enter UPC field and press
theEnter key

l Click theProduct Search button to display the
Product Search screen.
Note: Refer to Select One or More Products (see page
28) for more information.

l Click theAdd New Product button to display a blank
Product Editwindow.
Note: Refer to Manage Product Information (see page
149) for more information.

3. Complete the appropriate procedure to assign the product to
a purchase order.
Note: Refer toCreate a New Purchase Order for a
Special Order Product and/orAmend an Existing
Purchase Order for a Special Order Product for more
information.
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Remove a Product 1. Click a special order'sView button to display theSpecial
Order Requestwindow.

2. Click a product'sRemove button.
Note: TheSpecial Order Requestwindow continues to
display the product until the window is closed and reopened.

3. Click theClose button to close the window.

Create a New
Purchase Order for a
Special Order
Product

1. Click a special order'sView button to display theSpecial
Order Requestwindow.

2. If a product has not been assigned a vendor, select a vendor
from the product'sVendor drop-down field.

3. Click theCreate New PO button to automatically add the
generated purchase order(s) to the appropriatePurchase
Order drop-down field(s).

4. Click theClose button to close the window.
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Amend an Existing
Purchase Order for a
Special Order
Product

1. Click a special order'sView button to display theSpecial
Order Requestwindow.

2. Select a purchase order from the product'sPurchase Order
drop-down field.
Note: If thePurchase Order drop-down field does not
contain any purchase orders, the product may require a new
purchase order. Refer toCreate a New Purchase Order for
a Special Order Product for more information.

3. Press theEnter key to automatically add the vendor
associated with the selected purchase order to the product's
Vendor drop-down field.

4. Click theClose button to close the window.

Print a Special Order 1. Click a special order'sView button to display theSpecial
Order Requestwindow.

2. Click thePrint SO button to display the special order
document.

3. Review the document andmake changes as needed.
4. Save and Print a Document (see page 48) to create electronic

and hardcopy records of the special order.
5. Click theClose button to close the window.

3. Click the tab'sClose button to close the screen.
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Receiving Administration
This section contains procedures to receive products, create invoices, return items to vendors, view records of
received items, andmanage case quantities.

Case Quantity Values
A CaseQuantity Value allows a product to be received and sold by the case (or other package containing
multiples of the product) while retaining inventory costs and numbers (QOH) at the single unit level.

l Manage CaseQuantities (see page 383)

Receiving Inventory
Inventory itemsmay be received by purchase order or packing slip. Bothmethods allow for adjustments to an
incoming item's ordered quantity, received quantity, cost, retail price, gross profit percentage, and vendor
product details. The receiving process directly impacts inventory levels and provides an opportunity to print
product labels.

l Receive Inventory Items (see page 364)
l Import PurchaseOrder Data (see page 371)
l Complete the Vendor Product Detail Window (see page 373)
l Complete the Label PrintingWindow (see page 375)

Invoicing
Invoices are created through the receiving process.When an invoice is being processed, adjustmentsmay be
made to an invoice item's invoiced quantity, cost, retail price, and gross profit percentage. The invoicing
process directly impacts calculated costs and accounting values.

l Manage Invoices (see page 378)

Vendor Returns
Vendor Returnsmay be documented for accounting purposeswith a ReturnMerchandise Authorization
(RMA).

l Manage Vendor Returns (see page 389)

Receiving History
TheReceiving History records provide an overview of all receiving records, invoices, and individual items
received during a selected time frame.

l View and Use the Receiving History Record (see page 385)
l View the Receiving History By ItemRecord (see page 388)
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Receive Inventory Items
1. Navigate to theReceiving screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReceiving > Receiving from themainmenu to display theReceiving screen.

2. Complete any of the following procedures as desired to determine which purchase orders are
displayed on the screen:

l Filter by Vendor:
Click a vendor name in theSelect Vendor list to display only purchase orders for that vendor.
(Click theAll vendor name to display purchase orders for all vendors.)
Note: If needed, enter all or part of a vendor’s name in the field to show onlymatching vendors in
theSelect Vendor list.

l Filter by Date:
Uncheck theAll Dates checkbox, enter dates in the From and To fields, and click theRefresh
button to display only purchase orders from that date range.

l Filter by Significant Number:
Select an option (PO#, Scan UPC, Scan MFG #, Scan Item #,Scan Vendor Part #) from the
drop-down, enter all or part of the desired identifier in the text field, and click theSearch POs
button to display only purchase orders that contain the entered text.

l Sort and Filter Onscreen Data (see page 40).
3. Complete the following procedures as needed tomanage received products:

Receive Items with a
Purchase Order

1. Click a purchase order'sDetails button to display the
Receiving Details screen.

2. Continue with the procedure below.
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Receive Items with a
Packing Slip

1. Click the appropriate vendor name in theSelect Vendor list
to activate theReceive By Packing Slip button.

2. Click theReceive By Packing Slip button to display the
Receiving Details screen.
Note: From this point forward, the receiving record for the
packing slip will be considered a purchase order.

3. Continue with the procedure below.

Import Purchase
Order Data

Refer to Import PurchaseOrder Data (see page 371) for more
information.

Print a Receiving
Details Report

1. Click a purchase order'sDetails button to display the
Receiving Details screen.

2. Receive items as desired.
3. Click thePrint Receiving button to display theReceiving

Details Reportwindow.

4. Adjust display as desired.
5. Click thePrint report button to display thePrintwindow.
6. Modify print options (e.g., select a different printer, adjust

settings, etc.) as needed.
7. Click thePrint button to print the document.
8. Click theClose button on theReceiving Details Report

window to close it.
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Delete a Purchase
Order

1. Click a purchase order’sDelete button to display a deletion
confirmation window.

2. Click theYes button to remove the purchase order from the
screen.

3. Click the tab'sClose button to close the screen.

4. Complete the following procedures as appropriate to identify the product(s) being received:
lll Click a firearm'sReceive Firearm button.
ll Click a serialized nonfirearm'sReceive Serialized Nonfirearm button.
l Enter a product's UPC (or other identification number):

1. Select a product identification option (Scan UPC, Scan MFG #, Scan Item #, or Scan
Vendor Part #) from the drop-down field.

2. Scan or enter the appropriate identifier (UPC, etc.) in the blank field and press theEnter
key.
Note: If the identifier is not already in the database, the system displays an identifier not
foundmessage window featuring either a set of Yes andNo buttons or a singleOK
button. Complete one of the following as appropriate:

l Click aYes button to display a new Product Editwindow for the entered identifier.
(Refer to Manage Product Information (see page 149) for information on using this
window.)

l Click aNo button to close the window and use theProduct Search function to
locate the desired item.

l Click anOK button to close the window and use theProduct Search function to
locate the desired item.

l Select product(s) through theProduct Search function:
1. Click theProduct Search button to display theProduct Searchwindow.
2. Select the product(s) to be received.

Note: Multiple standard (non-serialized) productsmay be selected from the window.
Although this screen allows for the selection of multiple serialized (firearm or nonfirearm)
products, the systemwill display a description window for only one of them. For this
reason, RTGsuggests selecting only one serialized product at a time through this feature.
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Refer to Select a Single Product (see page 27) and Select One or More Products (see
page 28) as appropriate.

5. If the system displays aVendor Product Detailwindow, Complete the Vendor Product Detail
Window (see page 373) as appropriate.

6. The system displays information based on the type of product identified:

If a firearm was identified... The system displays the Firearm Descriptionwindow.
1. Describe a Firearm (see page 37).

Note: To receivemultiples of the same firearm in a single
step, enter a serial number in theSerial Number(s) field and
press theEnter key to create a line for the next serial number.

2. The product list displays the selected firearm and increases
the value in itsQty Received field by the quantity of entered
serial numbers.

3. Click the Firearm tab to display each unique firearm/serial
number combination.

4. If needed, edit the date in theAcquisition Date field to reflect
the proper date of receiving for the Bound Book(s).

If a serialized nonfirearm
product was identified...

The system displays theSerialized Nonfirearm Description
window.

1. Describe a Serialized Nonfirearm Item (see page 39).
Note: To receivemultiples of the same item in a single step,
enter a serial number in theSerial Number(s) field and press
theEnter key to create a line for the next serial number.

2. The product list displays the selected serialized product and
increases the value in itsQty Received field by the quantity of
entered serial numbers.

3. Click theSerialized Nonfirearms tab to display each unique
product/serial number combination.
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If a standard (non-
serialized) product was
identified...

The system displays the selected product in the product list and
increases the value in itsQty Received field by one. (Refer toEdit a
Product's Quantity for information onmanually editing this field.)

7. Complete the following procedures as needed to update received products:

Edit a Product's Quantity 1. Locate the product in the product list.
2. Edit the number in the product'sQty Received field.
3. Continue with the procedure below.

Edit a Product's
Information

1. Click a product'sEdit button to display itsProduct Edit
window.

2. Edit product information as needed.
Note: Refer to Manage Product Information (see page 149)
for more information onmodifying information in this window.

3. Click theSubmit button to close theProduct Editwindow.
4. Continue with the procedure below.

Edit a Firearm's Serial
Number or Description

1. Locate the firearm on the Firearms tab.
2. Click the firearm 'sEdit button to display itsFirearm

Descriptionwindow.
3. Edit the serial number in theSerial Number(s) field as

needed.
Note: Refer to Describe a Firearm (see page 37) for
information on changing values in other fields.

4. Click theSubmit button to close the Firearm Description
window.

5. Continue with the procedure below.
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Edit a Serialized
Nonfirearm Product's
Serial Number

1. Locate the serialized nonfirearm product on theSerialized
Nonfirearms tab.

2. Click the product'sEdit button to display itsSerialized
Nonfirearm Descriptionwindow.

3. Edit the serial number in theSerial Number(s) field as
needed.

4. Click theSubmit button to close theSerialized Nonfirearm
Descriptionwindow.

5. Continue with the procedure below.

8. Enter/edit Received Values as needed for each item.
Note: A user must be granted theProductCost permission to view/use some of these fields.

Note: If an item is a firearm or a serialized non-firearm product, some of these fieldsmay not be edited
directly.

Qty Ordered Enter the quantity of the item ordered.
Qty Received Enter the quantity of the item received.
Unit Cost Enter the actual unit cost for the item.
Retail Price Enter the retail price for the item to automatically

calculate and display theGP % value.
Note: GP% = (Retail Price -Unit Cost) /Retail
Price

GP % Enter the gross profit percentage for the item to
automatically calculate and display theRetail Price
value.
Note: Retail Price = Unit Cost / (1-GP%)

Ext. Cost The system automatically calculates this amount bymultiplying theQty
Received by theUnit Cost.

9. Enter/edit PurchaseOrder information in the window as needed.
Note: Required fields and settings are displayed with red borders.

Invoice # Enter the invoice number.
Note: If an invoice number is not available, enter a placeholder number
(e.g., employee initials and the received date/time) and revise it at a
later date.

PO Date Enter the purchase order date (mm/dd/yyyy) or Select a Date (see
page 24) with the calendar button.
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Due Date Enter the date payment is due to the vendor (mm/dd/yyyy) or Select a
Date (see page 24) with the calendar button.

PO # Enter the purchase order number.
Standard Terms Select the appropriate terms option from the drop-down field.
Terms Enter additional or non-standard terms.
Vendor Order # Enter the vendor's order number.
Memo Enter notes as needed.
Shipping Enter shipping charges (e.g., freight, fuel surcharge, fees, etc.)

included on the invoice.
Discount Enter the discount amount for the entire invoice. (Do not include

discounts for individual items as these are entered in each item's
Discount % or Amount cell.)

Amount Due Enter the total amount due for the invoice. To calculate this amount,
add the sum of allExt. Cost fields to the amount in theShipping field
and subtract the amount in theDiscount field.

10. Click theSubmit button to display the Label Printingwindow.

11. Complete the Label PrintingWindow (see page 375) to print labels and/or a receiving details report as
needed.

12. The system sends the purchase order to theReceiving History screen and generates a
corresponding invoice on the Invoicing screen.

13. Click the tab'sClose button to close the screen.
Note:When appropriate, complete theManage Invoices (see page 378) procedure to process the invoice for
the purchase order.
If needed, complete the View and Use the Receiving History Record (see page 385) procedure to review the
purchase order.
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Import Purchase Order Data
Complete the following procedure to import purchase order data into theReceiving screen by creating,
populating, and importing a formatted Excel file.

1. Navigate to theReceiving screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectReceiving > Receiving from themainmenu to display theReceiving screen.

2. Click the appropriate vendor name in theSelect Vendor list to activate the Template and Import PO
buttons.

3. Click the Template button to export the template format to an Excel file.

4. Populate the Excel file with purchase order information.
Note: The file must adhere to the validation requirements indicated in row 1 and below:

l All UPC’smust be in the system.
l All quantitiesmust be positive integers.
l A POnumber may be entered once (in cell A3) for the entire purchase order. If a POnumber is
not entered, the systemwill generate one.

Note: If the file contains a PO number that is already in use, the systemwill allow the file to be
imported. If an imported file is a copy of an existing PO, be sure to delete the duplicate PO(s) from the
system.

5. Save the Excel file.
6. Navigate to theReceiving screen and click the appropriate vendor name in theSelect Vendor list to

activate the Template and Import PO buttons.
7. Click the Import PO button to display the Load Excel Importwindow.
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8. Browse to the desired location.
9. Double-click the saved Excel file to select it and start the import process.
10. If the system detects any errors, it displays the Import Complete with Errorswindow.

Complete any of the following as needed:
l Click thePrint/Save button to display the errors in a formatted template file that may bemanually
printed and/or saved. Click another button as appropriate to close this window.

l Click theContinue button to continue with the import for the uploaded items.
l Click theCancel button to cancel the import.

11. When the import is complete, the system displays theUpload Completewindow.

12. Click theClose button to close the window.
13. Complete the following procedure to view the imported purchase order:

1. Click the tab'sClose button to close the screen.
2. Navigate to theReceiving screen.
3. Click the imported purchase order'sDetails button to display itsReceiving Details screen.
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Complete the Vendor Product Detail Window
Complete the following procedure to complete theVendor Product Detailwindow that appears during the
receiving process.

1. Navigate to theVendor Product Detailwindow.
1. Receive Inventory Items (see page 364).
2. When an item that does not have a vendor part number is identified during the receiving process,

the system displays theVendor Product Detailwindow.
Note: To control the behavior of theVendor Product Detailwindow for all products, refer to Manage
the Vendor Product Detail Windows (see page 81).

2. Complete one of the following procedures as appropriate to close the window:

Create a Vendor Part
Number for this product

1. Enter/edit the information in the fields:

Vendor The vendor option is preselected and cannot
be changed.

Vendor Part # Enter the vendor’s part number for the
product.

Catalog Cost Enter the product’s cost from the vendor’s
catalog.

Vendor
Priority

Select the vendor’s relative rank (1-5) among
possible vendors of this product from the
drop-down.

Sell Pack Enter theminimumnumber (generally 1) of
the product that can be purchased.

2. Click theSubmit button to create a vendor part number for
the product.
Note: The systemwill no longer display theVendor Product
Detailwindow when this product is identified on a purchase
order for the associated vendor during the receiving process.
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Skip the creation of a
Vendor Part Number for
this product

Click theCancel button to close the window.
Note: The systemwill continue to display theVendor Product
Detailwindow when this product is identified during the receiving
process.

Disable the Vendor
Product Detail window
for this product

1. Check theDo not show the Vendor Product Detail
screen for this UPC checkbox.

2. Click theSubmit button to close the window.
Note: The systemwill no longer display theVendor Product
Detailwindow when this product is identified during the
receiving process. Refer to Manage the Vendor Product
Detail Windows (see page 81) for information on undoing this
procedure.

3. Continue receiving the product.
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Complete the Label Printing Window
Complete the following procedure to complete the Label Printingwindow that appears during various
processes.

1. Navigate to the Label Printingwindow.
Complete any of the following procedures to display the Label Printingwindow:

l Receive Inventory Items (see page 364):
Enter data on theReceiving Details screen and click theSubmit button.

l Manage Invoices (see page 378):
Enter data on the Invoice Details screen and click theSubmit button.

l View and Use the Receiving History Record (see page 385):
Click aDetails button to display a corresponding details history screen and click an item'sPrint
button.

Note: A user must be granted theProductCost permission to view/use some of the fields on this
window.

2. Complete the following procedures as appropriate:

Print label(s) for the
selected product(s)

1. Complete any of these procedures to select the product(s) for
which labels will be printed:

l Check a product’s checkbox to select it.
l Uncheck a product's checkbox to deselect it.
l Check theQty to Print column header checkbox to
select all products.

l Uncheck theQty to Print column header checkbox to
deselect all products.

2. If desired, edit the number in a selected product'sQty to
Print field.

3. If desired, edit the amount in a selected product'sUnit Cost
field.
Note: This field can only bemodified when printing from a
receiving record.

4. If desired, edit the number in a selected product'sRetail
Price field.

5. Click theSubmit button to print labels for selected products
and close the Label Printingwindow.
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Print a Receiving Details
Report

1. If available, click thePrint Receiving button to display the
Receiving Details Reportwindow.

2. Adjust display as desired.
3. Click thePrint report button to display thePrintwindow.
4. Modify print options (e.g., select a different printer, adjust

settings, etc.) as needed.
5. Click thePrint button to print the document.
6. Click theClose button on theReceiving Details Report

window to close it.
7. Complete either of the following to close the Label Printing

window:
l Print product labels as needed.
l Click theCancel button.
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Print an Invoice Report 1. If available, click thePrint Invoice button to display the
Invoice Reportwindow.

2. Adjust display as desired.
3. Click thePrint report button to display thePrintwindow.
4. Modify print options (e.g., select a different printer, adjust

settings, etc.) as needed.
5. Click thePrint button to print the document.
6. Click theClose button on the Invoice Reportwindow to

close it.
7. Complete either of the following to close the Label Printing

window:
l Print product labels as needed.
l Click theCancel button.
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Manage Invoices
1. Navigate to the Invoicing screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReceiving > Invoicing from themainmenu to display the Invoicing screen.

2. Complete any of the following procedures as desired to determine which invoices are displayed on the
screen:

l Filter by Vendor:
Click a vendor name in theSelect Vendor list to display only invoices for that vendor. (Click the
All vendor name to display invoices for all vendors.)
Note: If needed, enter all or part of a vendor’s name in the field to show onlymatching vendors in
theSelect Vendor list.

l Filter by Date:
Uncheck theAll Dates checkbox, enter dates in the From and To fields, and click theRefresh
button to display only invoices from that date range.

l Filter by PO Number:
Enter all or part of a POnumber in theSearch POs field and click theSearch POs button to
display only purchase orders that contain the entered text.

l Sort and Filter Onscreen Data (see page 40).
3. Complete the following procedures as needed tomanage invoices:

Complete an Invoice 1. Click an invoice'sDetails button to display the Invoicing
Details screen.

2. Continue with the procedure below.
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Merge Invoices 1. Click the appropriate vendor name in theSelect Vendor list
to activate theMerge column.

2. Check an invoice'sMerge column checkbox to include it in the
merge.
Note: At least two invoicesmust be checked to perform a
merge.

3. Click theMerge button (theMergecolumn header) to display
the parent invoice selection window.

4. Click an invoice to select it as the parent invoice.
Note: The parent invoice's identifying information will display
on the Invoicing Details screen.

5. Click theSelect Parent button to combine the selected
invoices into a single entry on the Invoicing screen.

User Guide Receiving Administration - 379



Print an Invoice
Report

1. Click an invoice'sDetails button to display the Invoicing
Details screen.

2. Enter/edit data as needed.
3. Click thePrint Invoice button to display the Invoice Report

window.

4. Adjust display as desired.
5. Click thePrint report button to display thePrintwindow.
6. Modify print options (e.g., select a different printer, adjust

settings, etc.) as needed.
7. Click thePrint button to print the document.
8. Click theClose button on the Invoice Reportwindow to

close it.

Delete an Invoice 1. Click an invoice'sDelete button to display a deletion
confirmation window.

2. Click theYes button to remove the invoice from the screen.
Note: A deleted invoice cannot be retrieved.

3. Click the tab'sClose button to close the screen.
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4. Enter/edit Invoice Values as needed for each item.
Note: A user must be granted theProductCost permission to view/use some of these fields.

Qty Invoiced Enter the quantity of the item being invoiced.
Unit Cost Enter the actual unit cost for the item.
Retail Price Enter the retail price for the item to automatically

calculate and display theGP % value.
Note: GP% = (Retail Price -Unit Cost) /Retail
Price

GP % Enter the gross profit percentage for the item to
automatically calculate and display theRetail Price
value.
Note: Retail Price = Unit Cost / (1-GP%)

Ext. Cost The system automatically calculates this amount bymultiplying theQty
Invoiced by theUnit Cost.

5. Enter Invoice information in the window.
Note: Required fields and settings are displayed with red borders.

Invoice # Enter the invoice number.
Note: If an invoice number is not available, enter a placeholder number
(e.g., employee initials and the received date/time) and revise it at a later
date.

Received Date Enter the invoice date (mm/dd/yyyy) or Select a Date (see page 24) with the
calendar button.

Due Date Enter the date payment is due to the vendor (mm/dd/yyyy) or Select a Date
(see page 24) with the calendar button.

Standard Terms Select the appropriate terms option from the drop-down field.
Terms Enter additional or non-standard terms.
Memo Enter notes as needed.
Shipping Enter shipping charges (e.g., freight, fuel surcharge, fees, etc.) included on

the invoice.
Discount Enter the discount amount for the entire invoice. (Do not include discounts

for individual items as these are entered in each item'sDiscount % or
Amount cell.)
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Amount Due Enter the total amount due for the invoice. To calculate this amount, add the
sum of allExt. Cost fields to the amount in theShipping field and subtract
the amount in theDiscount field.

6. When all fields have been completed, click theSubmit button to display the Label Printingwindow.
Note: If the value in theAmount Due field does not equal the calculated value (sum of allExt. Cost
fields + Shipping charges -Discount), the system displays a Totals do not match error message
window.

Click theNo button to close the window andmake corrections as needed.

7. Complete the Label PrintingWindow (see page 375) to print labels and/or an invoice report as needed.
8. The system sends the invoice to theReceiving History screen.
9. Click the tab'sClose button to close the screen.

Note: If needed, complete the View and Use the Receiving History Record (see page 385) procedure to
review the invoice.
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Manage Case Quantities
1. Navigate to theCase Quantity screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReceiving > Case Quantity from themainmenu to display theCase Quantity screen.

2. Complete the following procedures as needed tomanage case quantities:

Set Up a Case
Quantity

1. Click theSearch button beside theSelling Unit UPC field to
display theProduct Searchwindow.

2. Select a Single Product (see page 27) to identify the selling
unit UPC (typically a single item).

3. Click theSearch button beside theCase UPC field to display
theProduct Searchwindow.

4. Select a Single Product (see page 27) to identify the case
UPC (typically a case or multi-pack item).
Note: If the case UPC does not exist in the database, refer to
Manage Product Information (see page 149) for information
on adding the case UPC to the product database. Be sure to
uncheck the Is Stock Item checkbox and set the price
according to the contents of the case UPC.

5. Enter the number of units per case in theUnits/Case field.
6. Click theSubmit button to add the case quantity to the

screen.
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Edit a Case Quantity 1. Click a case quantity'sEdit button to display theEdit Case
Quantitywindow.

2. Edit the number of units per case in theUnits/Case field.
3. Click theSubmit button to display the case quantity's edited

Unit Count on the screen.

Delete a Case
Quantity

1. Click a case quantity'sDelete button to display a deletion
confirmation window.

2. Click theYes button to remove the case quantity from the
screen.

3. Click the tab'sClose button to close the screen.
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View and Use the Receiving History Record
1. Navigate to theReceiving History screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReceiving > Receiving History from themainmenu to display theReceiving History
screen.

2. Complete any of the following procedures as desired to determine which items are displayed on the
screen:

l Filter by Date:
Enter starting and ending dates in theDate Range fields and click theRefresh button to display
only items from that date range.

l Filter by Type:
Select an option (All,Receiving, Invoice) from theHistory Type drop-down to display only
items of the selected type.

l Sort and Filter Onscreen Data (see page 40).
3. Complete the following procedures as desired:
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Review a Purchase
Order

1. Click a purchase order'sDetails button to display its
Receiving Details History screen.

2. If desired, click an item'sPrint Labels button to display the
Label Printingwindow and Complete the Label Printing
Window (see page 375) to print labels and/or a receiving
details report as needed.

2. Click theBack button to close theReceiving Details History
screen.

Print a Receiving
Details Report

1. Click a purchase order'sPrint button to display itsReceiving
Details Reportwindow.

2. Adjust display as desired.
3. Click thePrint report button to display thePrintwindow.
4. Modify print options (e.g., select a different printer, adjust

settings, etc.) as needed.
5. Click thePrint button to print the document.
6. Click theClose button on theReceiving Details Report

window to close it.
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Review an Invoice 1. Click an invoice'sDetails button to display its Invoice Details
History screen.

2. If desired, click an item'sPrint Labels button to display the
Label Printingwindow and Complete the Label Printing
Window (see page 375) to print labels and/or an invoice report
as needed.

3. Click theBack button to close the Invoice Details History
screen.

Print an Invoice
Report

1. Click an invoice'sPrint button to display its Invoice Report
window.

2. Adjust display as desired.
3. Click thePrint report button to display thePrintwindow.
4. Modify print options (e.g., select a different printer, adjust

settings, etc.) as needed.
5. Click thePrint button to print the document.
6. Click theClose button on the Invoice Reportwindow to

close it.
4. Click the tab'sClose button to close the screen.
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View the Receiving History By Item Record
1. Navigate to theReceiving History By Item screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReceiving > Receiving History By Item from themainmenu to display theReceiving
History By Item screen.

2. Enter starting and ending dates in theDate Range fields and click theSubmit button to display items
from that date range.

3. Select starting and ending date/time combinations from theReceived Time Range drop-downs to
items from that date/time range.

4. Sort and Filter Onscreen Data (see page 40) as needed.
5. Click the tab'sClose button to close the screen.
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Manage Vendor Returns
1. Navigate to theEdit Vendor Returns screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReceiving > Vendor Returns from themainmenu to display theEdit Vendor Returns
screen.

2. Click a vendor name in theSelect Vendor list to display the vendor's returns on the screen.
Note: If needed, enter all or part of a vendor’s name in the field to show onlymatching vendors in the
Select Vendor list.

3. Complete the following procedure to display returns from a particular time frame:
1. Select a predefined time frame option (e.g., "All Vendor Returns dated Last Quarter") from the

drop-down at the top of the page to automatically fill the From and To fields.
Note: To create a custom time frame, select the "All Vendor Returns dated in Custom period"
option from the drop-down field and enter starting and ending dates in the From and To fields.

2. Click theShows Returns button to display all invoices dated during the time frame.

4. If needed, Sort and Filter Onscreen Data (see page 40).
5. Complete the following procedures as appropriate tomanage vendor returns:

Create a Vendor
Return

1. Click theNew Vendor Return button to display the return
definition section.

2. Continue with the procedure below.

Edit a Vendor
Return

1. Click a return's checkbox in the far left column to display its
return definition section.

2. Continue with the procedure below.
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Delete a Vendor
Return

1. Click a return’sDelete button to display a deletion
confirmation window.

2. Click theYes button to remove the return from the screen.
3. Click the tab'sClose button to close the screen.

6. Enter/edit the RMA (returnmerchandise authorization) number in theRMA Number field.
7. Enter/edit the date of the return in theDate Returned field.
8. Compete the following procedure for each item to be returned:

1. Click theAdd Item button to create an open entry in the return detail table.
2. If appropriate, select the associated purchase order from thePurchase Order drop-down.
3. Select the item's UPC from theUPC drop-down (or scan/enter the desired UPC in the field).
4. If the item is a firearm or serialized non-firearm item, complete one of the following procedures as

appropriate:
l Enter a Firearm's Log Number:

1. Click theSelect button in the Firearm (Log #) Or Non-Firearm Serial Number
field to display the Firearm Inventorywindow.

2. Check the firearm'sSelect checkbox (or enter its log number inScan Log # here
field and press theEnter key) to select the firearm.

3. Click theSubmit button to place the firearm's log number in the Firearm (Log #)
Or Non-Firearm Serial Number field.

l Enter a Serialized Non-Firearm Item's Serial Number:
1. Click theSelect button in the Firearm (Log #) Or Non-Firearm Serial Number

field to display theSelect Product Serial Number window..
2. Select the appropriate serial number from the drop-down field.
3. Click theSelect button to place the item's serial number in the Firearm (Log #) Or

Non-Firearm Serial Number field.
5. Edit the amount in theQty Returned field as needed.
6. Select the vendor's remedy for the situation from theVendor Action drop-down.

Note: If "Issue credit" is selected for one item in a return, it must be selected for all items in the
return.

7. Select the shipping paid option from theShipping Paid drop-down.
8. Enter the reason the item is being returned in theReason field.

9. Click theSubmit button to add/update the vendor return on the list.
10. Click the tab'sClose button to close the screen.
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Accounting Administration
The AccountingModule links accounting information in the AXIS RMS with a third party accounting program
(i.e., QuickBooks).

l The AccountingModule workswith all currently-supported versions of QuickBooks, but not with the
web-based version.

l All computers on which the AccountingModule will be usedmust have AXIS RMS, a supported version
of QuickBooks, and theQuickBooks SDK installed.

l Administrator rights are needed to perform the following procedures.

Accounting Procedures
l Install the QuickBooks SDK File (see page 392)
Complete this procedure one time (for each computer).

l Configure the AccountingModule (see page 393)
Complete this procedure one time for a single store.

l Set Up Accounting Links and Features (see page 394)
Complete this procedure one time to establish a link between components andmatch AXIS RMS
elements to correspondingQuickBook elements. Repeat as needed in the future to add or update
matches.

l Post Accounts Payable Invoices to the Accounting Software (see page 402)
Complete this procedure daily or on an as-needed basis to post accounting data to QuickBooks
software.

l Post Accounting Entries to the Accounting Software (see page 404)
Complete this procedure daily or on an as-needed basis to post accounting data to QuickBooks
software.

l Post Inventory Adjustments to the Accounting Software (see page 407)
Complete this procedure to post one or more inventory adjustment entries to the QuickBooks
application.
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Install the QuickBooks SDK File
Complete the following procedure to install the QuickBooks SDK file.

1. ContactRTG Support Line atRTGSupport@AcuSport.com or 1-800-547-7120 and request a link
to the location of theQuickBooks SDK File.

2. Download theQuickBooks SDK File from the provided link/location.
3. Double-click the file to display theSecurity Warningwindow.

4. Click theRun button to display the InstallShield Wizardwindow and begin installation.

5. When the installation is complete, click the Finish button to display theGetting started with the
QuickBooks SDK graphic in a new window.

6. Review the graphic as needed.
7. Click the window’sClose button to close it.
8. Proceed to Configure the AccountingModule (see page 393).
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Configure the Accounting Module
Complete the following procedure to configure the AccountingModule to work with QuickBooks.

1. Navigate to the store'sStore Information for screen.
1. If it is open, close theData Center (IMS) application.
2. Make sure all other users are logged out of the QuickBooks application.
3. Log in to the QuickBooks application with Administrator rights.
4. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

5. SelectSetup > Store Info from themainmenu to display theStore Look-upwindow.
Note: If needed, enter all or part of a store’s name in theStore Name field to restrict the stores
shown in the list.

6. Double-click a store’s name to display itsStore Information for screen.

2. Select the “QuickBooks” option from theAccounting Package Type drop-down field.
3. Click theSubmit Changes button to display a “Record saved” confirmationmessage below the

button.
4. Close theData Center application.
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Set Up Accounting Links and Features
Complete the following procedure to establish links between the AccountingModule and associated
QuickBooks accounts and locations.

1. Navigate to theAccounting Setup screen.
1. If it is open, close theData Center (IMS) application.
2. Make sure all other users are logged out of the QuickBooks application.
3. Log in to the QuickBooks application with Administrator rights.
4. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

5. SelectAccounting > Set Up Accounting from themainmenu to display theAccounting
Setup screen and an error message.
Note: If thismessage appears during initial setup, it may be ignored. If it appears during a
subsequent procedure, check theQuickBooks program tomake sure it is open and there are no
other users.

6. Click theClose button to close the window.

2. Click the greenRefresh button to display theApplication with No Certificatewindow.
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3. Click the button in front of theYes, always; allow access even if QuickBooks is not running
option to select it.

4. Click theContinue button to display theConfirm to Proceedwindow.

5. Click theYes button to display theAccess Confirmationwindow.

6. Click theDone button to close the window and display a confirmation window on theAccounting
Setup screen.

7. Click theYes button to populate theAccounting Path field on theAccounting Setup screen.
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8. For each account type (Work Order Deposits, Layaway,Cash Deposits, etc.) in the Liability
Accounts,Asset Accounts, and Invoice Accounts sections, select the correspondingQuickBooks
account from the associated drop-down field.
Note: If no accounts are available in the drop-down, no valid accounts could be located in the
QuickBooks program.

9. Complete the following procedures to establish links between themodule and associatedQuickBooks
accounts:
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Link Inventory
Accounts to
Departments

1. Click the Inventory Accounts button to display the
Inventory Accountswindow.

2. Complete these procedures as needed to linkQuickBooks
Inventory accounts to Departments:

l Link an account to a Department:
1. Locate the Department’s drop-down field in the

GL Account column.
2. Select the correspondingQuickBooks account

(or the blank option to clear the field).
l Link an account to multiple departments:

1. Check the checkboxes in front of all desired
Departments to select them (or click theSelect
All button to select all Departments).

2. Select the correspondingQuickBooks account
(or the blank option) from theSet to selected
account drop-down field.

3. Click theSet button.
l Link an account to unassigned inventory (for items not
currently assigned to a department):

1. Locate theUnassigned Inventory drop-down
field.

2. Select the correspondingQuickBooks account
(or the blank option to clear the field).
Note:When an unassigned item is assigned to a
Department, it will automatically track to the
account linked to that Department.

3. Click theSubmit button to save changes and display a
confirmation window.

4. Click theOK button to close the window.

User Guide Accounting Administration - 397



Link Cost of Goods
Sold (COGS)
Accounts to
Departments

1. Click theCogs Accounts button to display theCOGS
Accountswindow.

2. Complete these procedures as needed to linkQuickBooks
Cost of Goods Sold accounts to Departments:

l Link an account to a Department:
1. Locate the Department’s drop-down field in the

GL Account column.
2. Select the correspondingQuickBooks account

(or the blank option to clear the field).
l Link an account to multiple departments:

1. Check the checkboxes in front of all desired
Departments to select them (or click theSelect
All button to select all Departments).

2. Select the correspondingQuickBooks account
(or the blank option) from theSet to selected
account drop-down field.

3. Click theSet button.
l Link an account to unassigned cost of goods sold (for
items not currently assigned to a department):

1. Locate theUnassigned Cost of Goods Sold
drop-down field.

2. Select the correspondingQuickBooks account
(or the blank option to clear the field).
Note:When an unassigned item is assigned to a
Department, it will automatically track to the
account linked to that Department.

3. Click theSubmit button to save changes and display a
confirmation window.

4. Click theOK button to close the window.
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Link Sales Accounts
to Departments

1. Click theSales Accounts button to display theSales
Accountswindow.

2. Complete these procedures as needed to linkQuickBooks
Sales accounts to Departments:

l Link an account to a Department:
1. Locate the Department’s drop-down field in the

GL Account column.
2. Select the correspondingQuickBooks account

(or the blank option to clear the field).
l Link an account to multiple departments:

1. Check the checkboxes in front of all desired
Departments to select them (or click theSelect
All button to select all Departments).

2. Select the correspondingQuickBooks account
(or the blank option) from theSet to selected
account drop-down field.

3. Click theSet button.
l Link an account to unassigned sales (for items not
currently assigned to a department):

1. Locate theUnassigned Sales drop-down field.
2. Select the correspondingQuickBooks account

(or the blank option to clear the field).
Note:When an unassigned item is assigned to a
Department, it will automatically track to the
account linked to that Department.

3. Click theSubmit button to save changes and display a
confirmation window.

4. Click theOK button to close the window.
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Link Vendor
Accounts to
Vendors

1. Click theVendor List button to display theVendor
Accountswindow.

2. Complete this procedure for each Vendor in theAXIS
Vendor column:

1. Locate the Vendor’s drop-down field in theQB Vendor
column.

2. Select the correspondingQuickBooks vendor (or the
blank option to clear the field).
Note: If no vendors are available in the drop-down, no
valid vendors could be located in the QuickBooks
program.

3. Click theSubmit button to save changes and display a
confirmation window.

4. Click theOK button to close the window.
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Link Tax Accounts
to Tax Types

1. Click theSales Tax Accounts button to display the Tax
Accountswindow.

2. Complete this procedure for each Tax Type in the Tax Type
column:

1. Locate the Tax Type’s drop-down field in theQB Tax
Account column.

2. Select the correspondingQuickBooks tax account (or
the blank option to clear the field).

3. Locate the Tax Type’s drop-down field in the Tax
Vendor column.

4. Select the correspondingQuickBooks tax vendor (or
the blank option to clear the field).

3. Click theSubmit button to save changes and display a
confirmation window.

4. Click theOK button to close the window.

Link a QB Account
to the Paid Out
Account

Select the appropriate QuickBooks account from thePaid Out
account’s drop-down field.

Link a QB Account
to the Adjustment
Account

Select the appropriate QuickBooks account from theAdjustment
Account drop-down field.

10. Click theSubmit button to save changes and display an exit confirmation window.

11. Click theYes button to save changes and close theAccounting Setup screen.
Note: If a Department, Vendor, or Tax Type is added to the AXIS RMS following this initial setup,
repeat the relevant portions of this procedure as needed to account for the new additions and any other
changes.
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Post Accounts Payable Invoices to the Accounting
Software
Complete the following procedure to post one or more accounts payable invoices to the QuickBooks
application.
Note: If an error message like the one shown below appears while completing this procedure, one or more of
a selected invoice’s data fields have not beenmapped to correspondingQuickBooks accounts.

Complete the following procedure to correct this issue before proceeding:
1. Note the unmapped element(s).
2. Click theContinue button to close the error message window.
3. Complete the appropriate portions of the Set Up Accounting Links and Features (see page 394) procedure
tomap the unmapped element(s) to the correspondingQuickBooks account(s).

1. Navigate to theAP Postings screen.
1. If it is open, close theData Center (IMS) application.
2. Make sure all other users are logged out of the QuickBooks application.
3. Log in to the QuickBooks application with Administrator rights.
4. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

5. SelectAccounting > Post AP from themainmenu to display theAP Postings screen.
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2. Complete any combination of the following to determine which invoiceswill display on the screen:
l Enter the desired starting and ending dates in theDate Range fields.
l Enter a search term in theSearch field.
l Select a vendor from theVendor drop-down field.
l Select a type (status) from the Type drop-down field.

3. Click theSubmit button to display all invoicesmatching the selection criteria.
4. Complete the following procedures as appropriate:

Preview and Print an
Invoice

1. Click the invoice’sView button to display the invoice preview
window.

2. If desired, click thePrint button to display thePrintwindow.
3. Modify print options (e.g., select a different printer, adjust

settings, etc.) as needed.
4. Click thePrint button to print the invoice.
5. Click theClose button to close the invoice preview window.

Post a Single
Invoice to
QuickBooks
Software

1. Locate the desired invoice.
2. Click the invoice’sPost button in the Type column to post the

invoice. This step changes the name of the button fromPost
toPosted xx/xx/xxxx (with xx/xx/xxxx being the date of the
posting).
Note: Do not click the button in the Type column if it is named
anything other thanPost.

Post Multiple
Invoices to
QuickBooks
Software

1. Check the checkboxes in front of all desired invoices to select
them (or click theSelect All button to select all invoices).
Note: Do not select an invoice if the button in itsType column
cell is named anything other thanPost.

2. Click thePost Selected button to post the invoices. This step
changes the name of each invoice’sType column cell button
fromPost toPosted xx/xx/xxxx (with xx/xx/xxxx being the
date of the posting).

5. Click the tab'sClose button to close the screen.
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Post Accounting Entries to the Accounting Software
Complete the following procedure to post one or more general ledger entries to the QuickBooks application.
Note: If an error message like the one shown below appears while completing this procedure, one or more
associated items have not beenmapped to correspondingQuickBooks accounts.

Complete the following procedure to correct this issue before proceeding:
1. Note the unmapped element(s).
2. Click theContinue button to close the error message window.
3. Complete the appropriate portions of the Set Up Accounting Links and Features (see page 394) procedure
tomap the unmapped element(s) to the correspondingQuickBooks account(s).

1. Navigate to theGL Postings screen.
1. If it is open, close theData Center (IMS) application.
2. Make sure all other users are logged out of the QuickBooks application.
3. Log in to the QuickBooks application with Administrator rights.
4. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

5. SelectAccounting > Post Accounting Entries from themainmenu to display theGL
Postings screen.

2. Complete any combination of the following to determine which entries will display on the screen:
l Enter the desired starting and ending dates in theDate Range fields.
l Select a type (status) from the Type drop-down field.
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3. Click theSubmit button to display all entriesmatching the selection criteria.
4. Complete the following procedures as appropriate:

Preview and Print an
Invoice

1. Click the entry’sView button to display the entry preview
window.

2. If desired, click thePrint button to display thePrintwindow.

3. Modify print options (e.g., select a different printer, adjust
settings, etc.) as needed.

4. Click thePrint button to print the entry.
5. Click theClose button to close the entry preview window.

Post a Single Entry
to QuickBooks
Software

1. Locate the desired entry.
2. Click the entry’sPost button in the Type column to post the

entry. This step changes the name of the button fromPost to
Posted xx/xx/xxxx (with xx/xx/xxxx being the date of the
posting).
Note: Do not click the button in the Type column if it is named
anything other thanPost.
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Post Multiple Entries
to QuickBooks
Software

1. Check the checkboxes in front of all desired entries to select
them (or click theSelect All button to select all entries).
Note: Do not select an entry if the button in itsType column
cell is named anything other thanPost.

2. Click thePost Selected button to post the entries. This step
changes the name of each entry’sType column cell button
fromPost toPosted xx/xx/xxxx (with xx/xx/xxxx being the
date of the posting).

5. Click the tab'sClose button to close the screen.
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Post Inventory Adjustments to the Accounting
Software
Complete the following procedure to post one or more inventory adjustment entries to the QuickBooks
application.

1. Navigate to theAdjustment Postings screen.
1. If it is open, close theData Center (IMS) application.
2. Make sure all other users are logged out of the QuickBooks application.
3. Log in to the QuickBooks application with Administrator rights.
4. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

5. SelectAccounting > Post Adjustment from themainmenu to display theAdjustment
Postings screen.

2. Complete any combination of the following to determine which entries will display on the screen:
l Enter the desired starting and ending dates in theDate Range fields.
l Select an adjustment type from theAdjustment Type drop-down field.
l Select a type (status) from the Type drop-down field.

3. Click theSubmit button to display all entriesmatching the selection criteria.
4. Complete the following procedures as appropriate:
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Preview and Print an
Adjustment Record

1. Click the entry’sPreview button to display the entry preview
window.

2. If desired, click thePrint button to display thePrintwindow.
3. Modify print options (e.g., select a different printer, adjust

settings, etc.) as needed.
4. Click thePrint button to print the entry.
5. Click theClose button to close the entry preview window.

Post a Single Entry
to QuickBooks
Software

1. Locate the desired entry.
2. Click the entry’sPost button in the Type column to post the

entry. This step changes the name of the button fromPost to
Posted xx/xx/xxxx (with xx/xx/xxxx being the date of the
posting).
Note: Do not click the button in the Type column if it is named
anything other thanPost.

Post Multiple Entries
to QuickBooks
Software

1. Check the checkboxes in front of all desired entries to select
them (or click theSelect All button to select all entries).
Note: Do not select an entry if the button in itsType column
cell is named anything other thanPost.

2. Click thePost Selected button to post the entries. This step
changes the name of each entry’sType column cell button
fromPost toPosted xx/xx/xxxx (with xx/xx/xxxx being the
date of the posting).

5. Click the tab'sClose button to close the screen.
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POS (Point Of Sale) Management
POS Setup

l Manage POS Options (see page 93)

POS Management
l Assign a Drawer to an Employee (see page 410)
l Record a Cash Drop (see page 411)
l Reconcile a Returned Drawer (see page 413)
l Run aCash Report (see page 412)
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Assign a Drawer to an Employee
1. Navigate to theAssign Drawer screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectPOS Management > Assign Drawer from themainmenu to display theAssign
Drawer screen.

2. Select the employee from theEmployee drop-down field.
3. Enter the amount of cash in the drawer in theDrawer Amount Issued field.
4. Select the point of sale position from thePOS Position drop-down field.
5. Click theSubmit and Print button to send the document to a printer.
6. Click the tab'sClose button to close the screen.
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Record a Cash Drop
1. Navigate to theCash Drop screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectPOS Management > Cash Drop from themainmenu to display theCash Drop screen.

2. Scan or enter the barcode value from the cash drop receipt in theDrawer Number field.
3. Enter the amount of cash received in theAmount Received field.
4. Click theSubmit button to close the screen.
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Run a Cash Report
1. Navigate to thePoint of Sale Cash Report screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectPOS Management > Cash Report from themainmenu to display thePoint of Sale
Cash Report screen.

2. If needed, Sort and Filter Onscreen Data (see page 40).
3. Click the tab'sClose button to close the screen.
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Reconcile a Returned Drawer
1. Navigate to theDrawer Reconciliation screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectPOS Management > Return Drawer from themainmenu to display theDrawer
Reconciliation screen.

2. Scan or enter the barcode value from the drawer assignment sheet in theCash Drawer # field.
3. Enter the counted number of each type of bill in theCurrency Count fields.
4. Enter the counted number of each type of coin in theCoin Count fields.
5. Enter the combined total amount of checks in theChecks Total field.
6. Click theSubmit button to addCash andChecks amounts to theAmount Counted in Drawer

column.
7. Click theReconcile button to addCash Short andChecks Over amounts to theOver/Short column.
8. Click theSubmit and Print button to send the document to a printer.
9. Click the tab'sClose button to close the screen.
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Work Order Administration
This section contains procedures to create, edit, update (with detail or product components), print, and
complete standard (non-serialized) and gunsmithing (serialized) work orders.

Standard Work Orders
StandardWorkOrders are used to document customwork that does not involve firearms and will not require
creation or modification of acquisition and disposition records.

l Create aWorkOrder (non-firearm) (see page 416)
l Update anOpenWorkOrder (non-firearm) (see page 417)
l View and Print DeliveredWorkOrders (non-firearm) (see page 419)

Gunsmithing Work Orders
GunsmithingWorkOrders are used to document customwork involving firearms and will create/modify
acquisition and disposition records.

l Create aGunsmithingWorkOrder (see page 420)
l Update anOpenGunsmithingWorkOrder (see page 421)
l View and Print DeliveredGunsmithingWorkOrders (see page 425)

User Guide WorkOrder Administration - 415



Create a Work Order (non-firearm)
1. Navigate to theNewWork Order screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectWork Orders > New Work Order from themainmenu to display theNewWork Order
screen.

2. Enter the due date (mm/dd/yyyy) or Select a Date (see page 24) with the calendar button in theSet
Due Date field.

3. Click theSelect Customer button to display theCustomer Look-upwindow.
4. Select or Add a FirearmCustomer (see page 29) to add the customer to the screen.
5. Enter descriptive text in theWork Description field.
6. Check theSend Email On Work Completion checkbox.

Note: If the selected customer does not have an email address on file, an information window appears.
Click theContinue button to close the window .

7. Click theSubmit button to display a confirmation window .
8. Click theClose button to close the screen.
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Update an Open Work Order (non-firearm)
1. Navigate to theOpen Work Orders screen.

Note: If a work order'sDue Date is today, tomorrow, or any day in the past, the system displays it in
red.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectWork Orders > Open Work Orders from themainmenu to display theOpen Work
Orders screen.

2. If needed, Sort and Filter Onscreen Data (see page 40).
3. Complete the following procedures as appropriate to update work orders:

Edit a Work Order's
Description

1. Click a work order’sEdit button to display itsEdit the work
order descriptionwindow.

2. Edit the text in the field.
3. Click theOK button to display the edited description on the

Open Work Orders screen.

Print an Open Work
Order

1. Click a work order’sPrint button to button to display aSave
Aswindow.

2. Save and Print a Document (see page 48) to create electronic
and hardcopy versions of the work order.

Add a Detail to a
Work Order

1. Click a work order’sDetail button to display itsWork Order
Detailwindow.

2. Enter descriptive text in theDescription field.
3. Enter the cost in theCost field.
4. Click theSubmit button.

Add a Product to a
Work Order

1. Click a work order’sProduct button to display theProduct
Searchwindow.

2. Select a Single Product (see page 27) to add it to the work
order.

3. Repeat steps as needed to add additional products to the
work order.
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Edit a Detail or
Product in a Work
Order

1. Click the work order’sExpand (+) button to display its
component record.

2. Click a detail/product’sEdit button to display itsWork Order
Detail window.

3. Edit the text in theDescription field.
4. Edit the cost in theCost field.
5. Click theSubmit button to display the edited information on

the component record.
6. Click the work order’sContract (–) button to close its

component record.

Remove a Detail or
Product from a Work
Order

1. Click the work order’sExpand (+) button to display its
component record.

2. Click a detail/product’sDelete button to display a deletion
confirmation window.

3. Click theYes button to remove the detail/product from the
component record.

4. Click the work order’sContract (–) button to close its
component record.

Complete a Detail or
Product in a Work
Order

1. Click the work order’sExpand (+) button to display its
component record.

2. Check a detail/product’sCompleted checkbox to display a
completion confirmation window.

3. Click theYes button to display a checkmark in the
detail/product’sCompleted checkbox.

4. Click the work order’sContract (–) button to close its
component record.

Complete an Open
Work Order

Note: If a work order includes details and/or products in its
component record, each of thesemust be individuallymarked
"Completed" before the entire work order can be completed. Refer
toComplete a Detail or Product in a Work Order for more
information.

1. Click a work order’sCompleted checkbox to display a
completion confirmation window.

2. Click theYes button to display a checkmark in the work
order’sCompleted checkbox.
Note: This procedure allows the work order to be received
and paid for in theRegister application.

Delete a Work Order 1. Click a work order’sDelete button to display a deletion
confirmation window.

2. Click theYes button to remove the work order from theOpen
Work Orders screen.

4. Click the tab'sClose button to close the screen.
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View and Print Delivered Work Orders (non-firearm)
1. Navigate to theDelivered Work Orders screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectWork Orders > Delivered Work Orders from themainmenu to display theDelivered
Work Orders screen.

3. Enter starting and ending dates in theDate Range fields and press theEnter key to display
results from that time frame.

2. If needed, Sort and Filter Onscreen Data (see page 40).
3. Complete the following procedures as appropriate to update work orders:

View a Work Order's
Detail/Product
Record

1. Click the work order’sExpand (+) button to display its
component record.

2. Click the work order’sContract (–) button to close its
component record.

Print a Delivered
Work Order

1. Click a work order’sPrint button to button to display aSave
Aswindow.

2. Save and Print a Document (see page 48) to create electronic
and hardcopy versions of the work order.

4. Click the tab'sClose button to close the screen.
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Create a Gunsmithing Work Order
1. Navigate to theNew Gunsmithing Work Order screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectGunsmithing > New Gunsmithing Work Order from themainmenu to display the
New Gunsmithing Work Order screen.

2. Enter the due date (mm/dd/yyyy) or Select a Date (see page 24) with the calendar button in theSet
Due Date field.

3. Click theSelect Customer button to display theCustomer Look-upwindow.
4. Select or Add a FirearmCustomer (see page 29) to add the customer to the screen.
5. Click theAdd Gun button to display the Firearm Descriptionwindow.
6. Describe a Firearm (see page 37) to add it to the screen. (Repeat steps as needed to add additional

firearms to the screen.)
7. Enter descriptive text in theWork Description field.
8. Check theSend Email On Work Completion checkbox.

Note: If the selected customer does not have an email address on file, an information screen appears.
Click theContinue button to close the screen.

9. Click theSubmit button to display a confirmation window.
Note: This procedure updates the Gunsmith Bound Bookwith the acquisition of the identified firearm
(s).

10. Click theClose button to close the screen.
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Update an Open Gunsmithing Work Order
1. Navigate to theOpen Work Orders (gunsmithing) screen.

Note: If a work order'sDue Date is today, tomorrow, or any day in the past, the system displays it in
red.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectGunsmithing > Open Work Orders from themainmenu to display theOpen Work
Orders screen.

2. If needed, Sort and Filter Onscreen Data (see page 40).
3. Complete the following procedures as appropriate to update gunsmithing work orders:

Edit a Work Order's
Description

1. Click a work order’sEdit button to display itsEdit the work
order descriptionwindow.

2. Edit the text in the field.
3. Click theOK button to display the edited description on the

Open Work Orders screen.

Print an Open Work
Order

1. Click a work order’sPrint button to button to display aSave
Aswindow.

2. Save and Print a Document (see page 48) to create electronic
and hardcopy versions of the work order.
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Send a Work Order
Firearm for External
Repair

1. Check a work order'sExt. Repair checkbox to display a
vendor selection notice window.

2. Click theOK button to display theVendor Look-upwindow.
3. Select a FirearmVendor (see page 32) to display a check

mark in the work order'sExt. Repair checkbox.
Note: This procedure records the disposition of the firearm to
the selected vendor in the Gunsmith Bound Book. Refer to
Manage a Bound Book (see page 224) to view this disposition
and locate its Log #.

4. Record the disposition of the firearm as a detail in the work
order's component record. Refer toAdd a Detail to a Work
Order for more information.
Note: Include all pertinent information in the detail
Description. For example, " Firearmwas shipped to
<vendor> for repair on <date>; Gunsmith Bound Book Log
<number>."

Receive a Work
Order Firearm from
External Repair

1. Uncheck a work order'sExt. Repair checkbox to display a
firearm confirmation window.

2. Click theYes button to display theVendor Information
window.

3. Click theSubmit button to close the window and remove the
checkmark from the work order'sExt. Repair checkbox.
Note: This procedure records the acquisition the firearm from
the vendor in the Gunsmith Bound Book. Refer to Manage a
Bound Book (see page 224) to view this acquisition and locate
its Log #.

4. Record the acquisition of the firearm as a detail in the work
order's component record. Refer toAdd a Detail to a Work
Order for more information.
Note: Include all pertinent information in the detail
Description. For example, " Firearmwas received from
<vendor> on <date>; Gunsmith Bound Book Log <number>."

Add a Detail to a
Work Order

1. Click a work order’sDetail button to display itsWork Order
Detailwindow.

2. Enter descriptive text in theDescription field.
3. Enter the cost in theCost field.
4. Click theSubmit button.
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Add a Product to a
Work Order

1. Click a work order’sProduct button to display theProduct
Searchwindow.

2. Select a Single Product (see page 27) to add it to the work
order.
Note: Serialized productsmay not be added to the work
order.

3. Repeat steps as needed to add additional products to the
work order.

Edit a Detail or
Product in a Work
Order

1. Click the work order’sExpand (+) button to display its
component record.

2. Click a detail/product’sEdit button to display itsWork Order
Detail window.

3. Edit the text in theDescription field.
4. Edit the cost in theCost field.
5. Click theSubmit button to display the edited information on

the component record.
6. Click the work order’sContract (–) button to close its

component record.

Remove a Detail or
Product from a Work
Order

1. Click the work order’sExpand (+) button to display its
component record.

2. Click a detail/product’sDelete button to display a deletion
confirmation window.

3. Click theYes button to remove the detail/product from the
component record.

4. Click the work order’sContract (–) button to close its
component record.

Complete a Detail or
Product in a Work
Order

1. Click the work order’sExpand (+) button to display its
component record.

2. Check a detail/product’sCompleted checkbox to display a
completion confirmation window.

3. Click theYes button to display a checkmark in the
detail/product’sCompleted checkbox.

4. Click the work order’sContract (–) button to close its
component record.
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Complete an Open
Work Order

Note: If a work order includes details and/or products in its
component record, each of thesemust be individuallymarked
"Completed" before the entire work order can be completed. Refer
toComplete a Detail or Product in a Work Order for more
information.

1. Click a work order’sCompleted checkbox to display a
completion confirmation window.

2. Click theYes button to display a checkmark in the work
order’sCompleted checkbox.
Note: This procedure allows the work order to be received
and paid for in theRegister application.

Delete a Work Order 1. Click a work order’sDelete button to display a deletion
confirmation window.

2. Click theYes button to remove the work order from theOpen
Work Orders screen.

4. Click the tab'sClose button to close the screen.
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View and Print Delivered Gunsmithing Work Orders
1. Navigate to theDelivered Work Orders (gunsmithing) screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectGunsmithing > Delivered Work Orders from themainmenu to display theDelivered
Work Orders screen.

3. Enter starting and ending dates in theDate Range fields and press theEnter key to display
results from that time frame.

2. If needed, Sort and Filter Onscreen Data (see page 40).
3. Complete the following procedures as appropriate to update work orders:

View a Work Order's
Detail/Product
Record

1. Click the work order’sExpand (+) button to display its
component record.

2. Click the work order’sContract (–) button to close its
component record.

Print a Delivered
Work Order

1. Click a work order’sPrint button to button to display aSave
Aswindow.

2. Save and Print a Document (see page 48) to create electronic
and hardcopy versions of the work order.

4. Click the tab'sClose button to close the screen.
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Report Administration
This section contains procedures to generate and view a variety of reports and lists to assist in daily, monthly,
annual, performance, and Bound Book reporting.

l View the 12Month SalesReport (see page 429)
l View the 80/20 SalesReport (see page 430)
l View the ATF UsedGunReport (see page 431)
l View the Daily Info Report (see page 432)
The Daily Info Report lists sales from a specific date and includes tax totals and amounts of media taken
in at each register by Cash, Check, Visa, Master Card, American Express, Discover, Gift Cards, AR
Accounts and other cards.

l View the Daily Register Report (see page 434)
The Daily Register Report displays total sales and tax from each register.

l View the Daily Sales Report (see page 435)
The Daily Sales Report shows the transaction count, total sales, total taxes, and average transaction
amount for any given date or range of dates. 

l View theGeneral Ledger Report (see page 436)
l Manage theGift Card List (see page 437)
TheGift Card List displays the existing balances of all outstanding gift cards aswell as individual
purchases and uses.

l View Historic Product Levels (see page 440)
l View the Inventory TurnsReport (see page 441)
l View the ItemsOut of StockReport (see page 442)
The ItemsOut of StockReport provides a list of items that were out of stock for a day or more during a
selected 31-day time period.

l View the ItemsSold Report (see page 433)
l View the ItemVariance Report (see page 444)
l View the LayawayReport (see page 446)
The LayawayReport displays payment details for all customer layaways.

l View the LayawayBy ItemReport (see page 445)
The LayawayBy ItemReport displays every item on layawaywith the customer's name for verifying
layaway inventory.

l View the Audit Log (see page 447)
l View theQuantity on Hand Report (see page 448)
TheQuantity on Hand Report displays the QOH for a specified date range.

l View the Receiving Reconciliation Report (see page 449)
l View the Sales by Sales Associate Report (see page 450)

User Guide Report Administration - 427



The Sales By Sales Associate Report provides a record of every sales associate (logged in user) who
completed or received credit for the sale of an item, every sale for which the associate received credit,
and theGross Profit for each sale expressed in dollars (GP $) and percentage (GP %).

l View the Sales ItemReport (see page 452)
The Sales ItemReport lists all items sold and payments received within a specified date range. 

l View the Sales TaxReport (see page 453)
The Sales TaxReport shows sales (including taxable sales, nontaxable sales, sales tax refunds, and
nontaxable sales refunds) and taxes collected for every defined tax type for a specified date range.

l View the ValueOnHandReport (see page 454)
The ValueOnHandReport provides a record of the quantity, total costs, and total value for every item
in inventory.

l View the Vendor Reorder Report (see page 455)
The Vendor Reorder Report provides a list of items that have fallen below their minimum inventory
levels and should probably be reordered.

l View the Voided TransactionsReport (see page 456)
l View theWaiting Period Report (see page 457)
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View the 12 Month Sales Report
1. Navigate to the 12 Month Sales Report screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReports > 12 Month Sales Report from themainmenu to display the 12 Month Sales
Report screen.

2. Complete the following procedures as needed tomodify the list displayed on the screen:
l Check the Include Products With No Sales checkbox to display all products.
l Use the scroll bar(s).
l Sort and Filter Onscreen Data (see page 40).

3. Click the tab'sClose button to close the screen.
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View the 80/20 Sales Report
1. Navigate to theSales Analysis (80/20) Report screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReports > 80/20 Sales Report from themainmenu to display theSales Analysis
(80/20) Report screen.

2. Enter starting and ending dates in theDate Range fields.
3. Click the desiredRank By selection button:

l Sales Dollars: Select to rank items by salesmeasured in dollars.
l Profit Dollars: Select to rank items by profit measured in dollars.
l Qty Sold: Select to rank items by number of items sold.

4. If desired, modify the percentages in the Top Percentage andBottom Percentage fields.
Note:When a value is entered in one of these fields, the system automatically populates the other field
so they total 100 percent.

5. If needed, check the Include Zero Valued Items checkbox to include all items in calculations.
6. Click theRefresh button to display results for selected options.
7. Complete the following procedures as needed tomodify the list displayed on the screen:

l Use the scroll bar(s).
l Sort and Filter Onscreen Data (see page 40).

8. Click the tab'sClose button to close the screen.
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View the ATF Used Gun Report
1. Navigate to theReport List screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReports > Other Reports from themainmenu to display theReport List screen.

2. Click theExecute Report (green arrow) button for theATF Used Gun report to display the report in
theReport Viewer window.

3. Complete the following procedure to set parameters for the report:
1. Click theParameters button to display parameter controls.
2. Enter/select report criteria in the fields as needed.
3. Click theSubmit button.
4. Click theParameters button to close parameter controls.

4. Use the scroll bar(s) and or page controls as needed to view the entire report.
5. Complete the following procedures as appropriate:

Print the Report 1. Click thePrint button to display thePrintwindow.
2. Modify print options (e.g., select a different printer, adjust

settings, etc.) as needed.
3. Click thePrint button to print the document.

Save the Report as
an Electronic File

1. Click theExport button to display a drop-downmenu of
options.

2. Click the desired option (Excel, PDF, orWord) to display the
Save Aswindow.

3. Browse to the desired location.
4. If needed, edit the document name in the File name field.
5. Click theSave button to save the document.

6. Click theClose button to close theReport Viewer window.
7. Click the tab'sClose button to close the screen.
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View the Daily Info Report
1. Navigate to theDaily Info Report screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReports > Daily Info Report from themainmenu to display theDaily Info Report
screen.

3. Enter the desired date in theDate field and click theSubmit button to display the report for the
entered date.

2. Click the tab'sClose button to close the screen.
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View the Items Sold Report
Complete the following procedure to generate and view a record of items that were sold during a selected
time period.

1. Navigate to the Items Sold Report screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectReports > Items Sold Report from themainmenu to display the Items Sold Report
screen.

2. Enter starting and ending dates in theDate Range fields.
3. Click theSubmit button to display results from the selected time frame.
4. Sort and Filter Onscreen Data (see page 40) as needed.
5. Click the tab'sClose button to close the screen.
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View the Daily Register Report
1. Navigate to theDaily Register Report screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReports > Daily Register Report from themainmenu to display theDaily Register
Report screen.

3. Enter starting and ending dates in theDate Range fields and click theSubmit button to display
data from the entered date(s).

2. Complete the following procedures as needed tomodify the list displayed on the screen:
l Use the scroll bar(s).
l Sort and Filter Onscreen Data (see page 40).

3. Complete the following procedure to view details for a specific date:
1. Click a date'sView button to view itsRegister Payment Detailwindow.
2. Use the scroll bar as needed to view the entire report.
3. If needed, Sort and Filter Onscreen Data (see page 40).
4. Click theOK button to close the window.

4. Click the tab'sClose button to close the screen.
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View the Daily Sales Report
1. Navigate to theDaily Sales Report screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReports > Daily Sales Report from themainmenu to display theDaily Sales Report
screen.

3. Enter starting and ending dates in theDate Range fields and click theSubmit button to display
data from the entered date(s).

2. Complete the following procedures as needed tomodify the list displayed on the screen:
l Use the scroll bar(s).
l Sort and Filter Onscreen Data (see page 40).

3. Complete the following procedure to view details for a specific date:
1. Click a date to view itsDaily Sales Detailwindow.
2. If needed, Sort and Filter Onscreen Data (see page 40).
3. Click theOK button to close the window.

4. Click the tab'sClose button to close the screen.
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View the General Ledger Report
1. Navigate to theReport List screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReports > Other Reports from themainmenu to display theReport List screen.

2. Click theExecute Report (green arrow) button for theGL Posting report to display the report in the
Report Viewer window.

3. Complete the following procedure to set parameters for the report:
1. Click theParameters button to display parameter controls.
2. Enter/select report criteria in the fields as needed.
3. Click theSubmit button.
4. Click theParameters button to close parameter controls.

4. Use the scroll bar(s) and or page controls as needed to view the entire report.
5. Complete the following procedures as appropriate:

Print the Report 1. Click thePrint button to display thePrintwindow.
2. Modify print options (e.g., select a different printer, adjust

settings, etc.) as needed.
3. Click thePrint button to print the document.

Save the Report as
an Electronic File

1. Click theExport button to display a drop-downmenu of
options.

2. Click the desired option (Excel, PDF, orWord) to display the
Save Aswindow.

3. Browse to the desired location.
4. If needed, edit the document name in the File name field.
5. Click theSave button to save the document.

6. Click theClose button to close theReport Viewer window.
7. Click the tab'sClose button to close the screen.
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Manage the Gift Card List
1. Navigate to theGift Card List screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReports > Gift Card List from themainmenu to display theGift Card List screen.
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Complete the following procedures as needed tomanage gift card data:
Note: A "purchase" occurs whenever money is added to a gift card, whether during the initial sale of
the card or at a later time. A "use" occurs whenever money is removed from the card.

View All Gift Card
Purchases and Uses

1. Click thePurchases and Uses selection button to display the
purchases and uses report.
Note: If needed, Sort and Filter Onscreen Data (see page
40).

2. Click theCurrent Balance selection button to display the
standard gift card balance report.

View a Specific
Card's Purchases

1. Click a gift card'sPurchases button to view itsGift Card
Purchaseswindow.
Note: If needed, Sort and Filter Onscreen Data (see page
40).

2. Click theClose button to close the window.

View a Specific Gift
Card's Uses

1. Click a gift card'sUses button to view itsGift Card Uses
window.
Note: If needed, Sort and Filter Onscreen Data (see page
40).

2. Click theClose button to close the window.

User Guide Report Administration - 437



Import Gift Card
Data

1. Right-click on the list to display amenu of options.

2. Click theExport Template option to export the template
format to an Excel file.

3. Populate the Excel file with gift card information.
Note: The file must adhere to the validation requirements
indicated in row 1 and below:

l No entrymay have the same value forGift Card
Number as any other entry in this file or already in the
system.

l Current Balancemust be a positive integer.
4. Save the Excel file.

5. Click the Import button on theGift Card List screen to
display the Load Excel Importwindow.

6. Browse to the desired location.
7. Double-click the saved Excel file to select it and start the

import process.
8. If the system detects any errors, it displays the Import

Complete with Errorswindow.
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Complete any of the following as needed:
l Click thePrint/Save button to display the errors in a
formatted template file that may bemanually printed
and/or saved. Click another button as appropriate to
close this window.

l Click theContinue button to continue with the import
for the uploaded items.

l Click theCancel button to cancel the import.
9. When the import is complete, the system displays theUpload

Completewindow.

3. Click the tab'sClose button to close the screen.
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View Historic Product Levels
Note: A Product Level Snapshot provides aQuantity on Hand record for a specific date. The system is
scheduled to generate a Product Level Snapshot at the end of every calendar month (either after the close of
business on the last day of themonth or at the start of the first day of the new month). This snapshot offers
inventory valuation and quantities for month-end andmay be used as a starting point for generating other
reports.

1. Navigate to theHistoric Product Levels screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectReports > Product Level Snapshots from themainmenu to display theHistoric
Product Levels screen.

3. Select the desired date from theSelect Date drop-down field.

2. If needed, Sort and Filter Onscreen Data (see page 40).
3. Click the tab'sClose button to close the screen.
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View the Inventory Turns Report
Note: The system requires aminimumof 6months of sales data to produce an Inventory Turns report.

1. Navigate to the Inventory Turns screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectReports > Inventory Turns from themainmenu to display the Inventory Turns
screen.

3. Enter starting and ending dates in theDate Range fields and click theSubmit button to display
data from the entered date(s).
Note: If needed, Sort and Filter Onscreen Data (see page 40).

2. Click the tab'sClose button to close the screen.
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View the Items Out of Stock Report
Complete the following procedure to generate and view a record of items that were out of stock for a day or
more during a selected 31-day time period.

1. Navigate to the Items Out of Stock Report screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectReports > Inventory Reports > Items Out of Stock Report from themainmenu to
display the Items Out of Stock Report screen.

2. Enter starting and ending dates in theDate Range fields.
Note: The rangemust not exceed 31 days.

3. Click theSubmit button to display results from the selected time frame.
Note: If an item is out of stock for less than an entire day (frommidnight to midnight), it will not display in
the results.

4. Sort and Filter Reporting Screen Data (see page 44) as needed.
5. Click theReport tab to display the report.

Note: The report reflects the filters and controls selected on theRaw Data tab.

6. If desired, complete the following procedure to print the report:
1. Click thePrint report button to display thePrintwindow.
2. Modify print options (e.g., select a different printer, adjust settings, etc.) as needed.
3. Click thePrint button to print the document.
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7. Click the tab'sClose button to close the screen.
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View the Item Variance Report
1. Navigate to theReport List screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReports > Other Reports from themainmenu to display theReport List screen.

2. Click theExecute Report (green arrow) button for the Item Variance report to display the report in
theReport Viewer window.

3. Complete the following procedure to set parameters for the report:
1. Click theParameters button to display parameter controls.
2. Enter/select report criteria in the fields as needed.
3. Click theSubmit button.
4. Click theParameters button to close parameter controls.

4. Use the scroll bar(s) and or page controls as needed to view the entire report.
5. Complete the following procedures as appropriate:

Print the Report 1. Click thePrint button to display thePrintwindow.
2. Modify print options (e.g., select a different printer, adjust

settings, etc.) as needed.
3. Click thePrint button to print the document.

Save the Report as
an Electronic File

1. Click theExport button to display a drop-downmenu of
options.

2. Click the desired option (Excel, PDF, orWord) to display the
Save Aswindow.

3. Browse to the desired location.
4. If needed, edit the document name in the File name field.
5. Click theSave button to save the document.

6. Click theClose button to close theReport Viewer window.
7. Click the tab'sClose button to close the screen.
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View the Layaway By Item Report
1. Navigate to the Layaway By Item Report screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReports > Layaway By Item Report from themainmenu to display the Layaway By
Item Report screen.

3. Enter starting and ending dates in theDate Range fields and click theSubmit button to display
data from the entered date(s).

2. If needed, Sort and Filter Onscreen Data (see page 40).
3. Click the tab'sClose button to close the screen.
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View the Layaway Report
1. Navigate to the Layaway Report screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReports > Layaway Report from themainmenu to display the Layaway Report
screen.

3. Enter starting and ending dates in theDate Range fields and click theSubmit button to display
data from the entered date(s).

2. Complete the following procedures as needed tomodify the list displayed on the screen:
l Check the Include Zero Balances checkbox and click theSubmit button to display all
layaways.

l Use the scroll bar(s).
l Sort and Filter Onscreen Data (see page 40).

3. Complete the following procedure to view details for a specific layaway:
1. Click the layaway’sExpand (+) button to display its component record.
2. If needed, Sort and Filter Onscreen Data (see page 40).
3. Click the layaway’sContract (–) button to close its component record.

4. Click the tab'sClose button to close the screen.
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View the Audit Log
Complete the following procedure to generate and view a record of the following occurrences:

l Login attempts, successful logins, and logouts
l Changesmade to SecurityManagement settings
l Changesmade to Last Cost andAvg Cost fields through theProduct Maintenance screen
l Views of and changesmade to theCredit Card Setup screen
l Views of theAudit Log screen

Note: A user must be granted theAuditLogView permission to view/use this feature.

1. Navigate to theAudit Log screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectReports > Audit Log from themainmenu to display theAudit Log screen.

2. Complete any of the following procedures as desired to determine which records are displayed on the
screen:

l Filter by Date:
Enter starting and ending dates in theDate Range fields and click theSubmit button to display
results from that time frame.

l Sort and Filter Onscreen Data (see page 40).
3. Click the tab'sClose button to close the screen.
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View the Quantity on Hand Report
1. Navigate to theQuantity on Hand Report screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReports > Quantity on Hand Report from themainmenu to display theQuantity on
Hand Report screen.

3. Enter the desired date in theDate field and click theSubmit button to display the report for the
entered date.

2. Complete the following procedures as needed tomodify the list displayed on the screen:
l Use the scroll bar(s).
l Sort and Filter Onscreen Data (see page 40).

3. Click the tab'sClose button to close the screen.
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View the Receiving Reconciliation Report
1. Navigate to theReport List screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReports > Other Reports from themainmenu to display theReport List screen.

2. Click theExecute Report (green arrow) button for theReceiving Reconciliation report to display
the report in theReport Viewer window.

3. Complete the following procedure to set parameters for the report:
1. Click theParameters button to display parameter controls.
2. Enter/select report criteria in the fields as needed.
3. Click theSubmit button.
4. Click theParameters button to close parameter controls.

4. Use the scroll bar(s) and or page controls as needed to view the entire report.
5. Complete the following procedures as appropriate:

Print the Report 1. Click thePrint button to display thePrintwindow.
2. Modify print options (e.g., select a different printer, adjust

settings, etc.) as needed.
3. Click thePrint button to print the document.

Save the Report as
an Electronic File

1. Click theExport button to display a drop-downmenu of
options.

2. Click the desired option (Excel, PDF, orWord) to display the
Save Aswindow.

3. Browse to the desired location.
4. If needed, edit the document name in the File name field.
5. Click theSave button to save the document.

6. Click theClose button to close theReport Viewer window.
7. Click the tab'sClose button to close the screen.
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View the Sales by Sales Associate Report
Complete the following procedure to generate and view a record of every sales associate (logged in user)
who completed or received credit for the sale of an item, every sale for which the associate received credit,
and theGross Profit for each sale expressed in dollars (GP $) and percentage (GP %).

1. Navigate to theReport List screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectReports > Other Reports from themainmenu to display theReport List screen.

2. Click theExecute Report (green arrow) button for theSales by Sales Associate Report option to
display the report in theReport Viewer window.

3. Complete the following procedure to set parameters for the report:
1. Click theParameters button to display parameter controls.
2. Enter/select report criteria in the fields as needed.
3. Click theSubmit button.
4. Click theParameters button to close parameter controls.

4. Use the scroll bar(s) and or page controls as needed to view the entire report.
5. Complete the following procedures as appropriate:
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Print the Report 1. Click thePrint button to display thePrintwindow.
2. Modify print options (e.g., select a different printer, adjust

settings, etc.) as needed.
3. Click thePrint button to print the document.

Save the Report as
an Electronic File

1. Click theExport button to display a drop-downmenu of
options.

2. Click the desired option (Excel, PDF, orWord) to display the
Save Aswindow.

3. Browse to the desired location.
4. If needed, edit the document name in the File name field.
5. Click theSave button to save the document.

6. Click theClose button to close theReport Viewer window.
7. Click the tab'sClose button to close the screen.
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View the Sales Item Report
1. Navigate to theSales Item Report screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReports > Sales Item Report from themainmenu to display theSales Item Report
screen.

3. Enter starting and ending dates in theDate Range fields and click theSubmit button to display
data from the entered date(s).

2. Complete the following procedures as needed tomodify the list displayed on the screen:
l Use the scroll bar(s).
l Sort and Filter Onscreen Data (see page 40).

3. Click the tab'sClose button to close the screen.
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View the Sales Tax Report
1. Navigate to theSales Tax Report screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReports > Sales Tax Report from themainmenu to display theSales Tax Report
screen.

3. Enter starting and ending dates in theDate Range fields and click theSubmit button to display
data from the entered date(s).

2. If needed, Sort and Filter Onscreen Data (see page 40).
3. Click the tab'sClose button to close the screen.
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View the Value On Hand Report
Complete the following procedure to generate and view a record of the quantity, total costs, and total value for
every item in inventory.

1. Navigate to theValue On Hand Report screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectReports > Inventory Reports > Value On Hand Report from themainmenu to
display theValue On Hand Report screen.

2. Sort and Filter Reporting Screen Data (see page 44) as needed.
3. Click theReport tab to display the report.

Note: The report reflects the filters and controls selected on theRaw Data tab.

4. If desired, complete the following procedure to print the report:
1. Click thePrint report button to display thePrintwindow.
2. Modify print options (e.g., select a different printer, adjust settings, etc.) as needed.
3. Click thePrint button to print the document.

5. Click the tab'sClose button to close the screen.
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View the Vendor Reorder Report
Complete the following procedure to generate and view a record of items that have fallen below their
minimum inventory level.

1. Navigate to theVendor Reorder screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectReports > Vendor Reorder Report from themainmenu to display theVendor
Reorder screen.

2. Select a vendor from theVendor drop-down to display a list of the vendor's itemswith inventory values
below their minimum levels. (Select theSelect All option to view items from all vendors.)
Note: An itemwith a QOH that is lower than itsminimum level will not display if either of the following is
true:

l The item is not associated with the selected vendor(s).
l The item's on-order quantity is sufficient to bring its inventory value up to or above itsmaximum
value.

3. Sort and Filter Reporting Screen Data (see page 44) as needed.
4. Click the tab'sClose button to close the screen.
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View the Voided Transactions Report
1. Navigate to theVoided Transactions screen.

1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu
screen.

2. SelectReports > Voided Transactions from themainmenu to display theVoided
Transactions screen.

3. Enter starting and ending dates in theDate Range fields and click theSubmit button to display
data from the entered date(s).

2. Complete the following procedures as needed tomodify the list displayed on the screen:
l Use the scroll bar(s).
l Sort and Filter Onscreen Data (see page 40).

3. Complete the following procedure to view details for a specific transaction:
1. Click a transaction'sView button to view itsVoided Transaction Detailwindow.
2. If needed, Sort and Filter Onscreen Data (see page 40).
3. Click theOK button to close the window.

4. Click the tab'sClose button to close the screen.
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View the Waiting Period Report
Complete the following procedure to generate and view a list of every customer who is in a waiting period to
receive a firearm, the firearm to be transferred, and the date/time when the waiting period ends.

1. Navigate to theReport List screen.
1. Log In to the Data Center Application (see page 16) to display theData Center Main Menu

screen.

2. SelectReports > Other Reports to display theReport List screen.

2. Click theExecute Report (green arrow) button for theWaiting Period Report option to display the
report in theReport Viewer window.
Note: If the waiting period has ended, itsEnd Day andEnd Time columnswill be highlighted in red

3. Complete the following procedure to set parameters for the report:
1. Click theParameters button to display parameter controls.
2. Enter/select report criteria in the fields as needed.
3. Click theSubmit button.
4. Click theParameters button to close parameter controls.

4. Use the scroll bar(s) and or page controls as needed to view the entire report.
5. Complete the following procedures as appropriate:

Print the Report 1. Click thePrint button to display thePrintwindow.
2. Modify print options (e.g., select a different printer, adjust

settings, etc.) as needed.
3. Click thePrint button to print the document.
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Save the Report as
an Electronic File

1. Click theExport button to display a drop-downmenu of
options.

2. Click the desired option (Excel, PDF, orWord) to display the
Save Aswindow.

3. Browse to the desired location.
4. If needed, edit the document name in the File name field.
5. Click theSave button to save the document.

6. Click theClose button to close theReport Viewer window.
7. Click the tab'sClose button to close the screen.
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